Curve Fitting Toolbox™ 2
User’s Guide

MATLAB

‘\The MathWorks™

Accelorating the poce of engineering and science



LN N

How to Contact The MathWorks

www . mathworks.com Web

comp.soft-sys.matlab Newsgroup

www . mathworks.com/contact_TS.html Technical Support
suggest@mathworks.com Product enhancement suggestions
bugs@mathworks.com Bug reports

doc@mathworks.com Documentation error reports
service@mathworks.com Order status, license renewals, passcodes
info@mathworks.com Sales, pricing, and general information

508-647-7000 (Phone)
508-647-7001 (Fax)

The MathWorks, Inc.
3 Apple Hill Drive
Natick, MA 01760-2098

For contact information about worldwide offices, see the MathWorks Web site.
Curve Fitting Toolbox™ User’s Guide
© COPYRIGHT 2001-2009 by The MathWorks, Inc.

The software described in this document is furnished under a license agreement. The software may be used
or copied only under the terms of the license agreement. No part of this manual may be photocopied or
reproduced in any form without prior written consent from The MathWorks, Inc.

FEDERAL ACQUISITION: This provision applies to all acquisitions of the Program and Documentation
by, for, or through the federal government of the United States. By accepting delivery of the Program

or Documentation, the government hereby agrees that this software or documentation qualifies as
commercial computer software or commercial computer software documentation as such terms are used

or defined in FAR 12.212, DFARS Part 227.72, and DFARS 252.227-7014. Accordingly, the terms and
conditions of this Agreement and only those rights specified in this Agreement, shall pertain to and govern
the use, modification, reproduction, release, performance, display, and disclosure of the Program and
Documentation by the federal government (or other entity acquiring for or through the federal government)
and shall supersede any conflicting contractual terms or conditions. If this License fails to meet the
government’s needs or is inconsistent in any respect with federal procurement law, the government agrees
to return the Program and Documentation, unused, to The MathWorks, Inc.

Trademarks

MATLAB and Simulink are registered trademarks of The MathWorks, Inc. See
www . mathworks.com/trademarks for a list of additional trademarks. Other product or brand
names may be trademarks or registered trademarks of their respective holders.

Patents

The MathWorks products are protected by one or more U.S. patents. Please see
www.mathworks.com/patents for more information.


http://www.mathworks.com/trademarks
http://www.mathworks.com/patents

Revision History

July 2001

July 2002

June 2004
October 2004
March 2005
June 2005
September 2005
March 2006
September 2006
November 2006
March 2007
September 2007
March 2008
October 2008
March 2009
September 2009

First printing
Second printing
Online only
Online only
Online only
Third printing
Online only
Online only
Online only
Fourth printing
Online only
Online only
Online only
Online only
Online only
Online only

New for Version 1 (Release 12.1)

Revised for Version 1.1 (Release 13)
Revised for Version 1.1.1 (Release 14)
Revised for Version 1.1.2 (Release 14SP1)
Revised for Version 1.1.3 (Release 14SP2)
Minor revision

Revised for Version 1.1.4 (Release 14SP3)
Revised for Version 1.1.5 (Release 2006a)
Revised for Version 1.1.6 (Release 2006b)
Minor revision

Revised for Version 1.1.7 (Release 2007a)
Revised for Version 1.2 (Release 2007b)
Revised for Version 1.2.1 (Release 2008a)
Revised for Version 1.2.2 (Release 2008b)
Revised for Version 2.0 (Release 2009a)
Revised for Version 2.1 (Release 2009b)






Getting Started

Product Overview ...............cciiiiiiiiuennnnn.. 1-2
Major Features ............ ... .. 1-2
Interactive and Programmatic Environments ........... 1-2

Curve Fitting ......... ... ... ... .. 14
Interactive Curve Fitting .............. ... ... . ... 14
Programmatic Curve Fitting ........................ 14

Surface Fitting ............ ... ... ... . i, 1-5
Interactive Surface Fitting .......................... 1-5
Programmatic Surface Fitting ....................... 1-5

Interactive Curve Fitting

2|

Interactive Curve Fitting Example .................. 2-2
Opening Curve Fitting Tool ......................... 2-2
ImportingData ........... ... ... ... ... 2-3
Interactive Curve Fitting Procedure .................. 2-4
Analyzingthe Fit .......... ... ... ... . . . . . . ... 2-15
Saving Your Work .......... .. ... ... 2-18

PreprocessingData ................................ 2-21
ImportingData ........... ... ... ... . ... 2-21
ViewingData .............. .. .. 2-25
Smoothing Data .............. .. it iiiiiiinn... 2-28
Excluding and Sectioning Data ...................... 2-36
Missing Values and Outliers ........................ 2-46

FittingData .......... ... ... . .. . .. 2-47




vi

The Fitting Process . ..., 2-47
Parametric Fitting .............. ... .. ... ... ... 2-49
Nonparametric Fitting .................. ... ... ..... 2-94

3

Fittinga Surface ................. ... .. 3-2
Introducing the Surface Fitting Tool .................. 3-2
Howto Fita Surface ............... ... i, 3-3
Opening the Surface Fitting Tool ..................... 3-4
Selecting Data ............ i, 3-4
Refining Your Fit . ... ... . i, 3-6
Removing Outliers ............c0 .. 3-6
Selecting ValidationData ........................... 3-7
Exploring and Customizing Plots ..................... 3-8

Interactive Surface Fitting Examples ................ 3-10
Franke Data Interactive Surface Fitting Example ....... 3-10

Biopharmaceutical Interactive Surface Fitting Example .. 3-20

Selecting Fit Settings .............................. 3-28
Introduction ......... ... ... i i 3-28
Selecting Fit Category ......... ..., 3-28
Using Center and Scale Setting ...................... 3-29
Using Interpolant Fit Category ...................... 3-29
Using Polynomial Fit Category ...................... 3-30
Using Lowess Fit Category ...............ccuunn.. 3-32
Using Custom Equation Fit Category ................. 3-33

Fitting Multiple Surfaces .......................... 3-35
Introduction ......... ... . i 3-35
Fitting Additional Surfaces ......................... 3-35
Duplicating a Surface Fit ........................... 3-35
Deleting a Surface Fit ............. ... ... ... ......... 3-36

Comparing Surface Fits ............................ 3-37
Introduction .......... ... i i 3-37
Displaying Multiple Fits Simultaneously .............. 3-37

Contents



Displaying Surface, Residual, and Contour Plots ........
Using the Statistics in the Table of Fits ...............

Generating M-Files and Exporting Fits to the
Workspace ............ciiiii
Introducing Programmatic Surface Fitting .............
Generating M-Files from the Surface Fitting Tool .......
Exporting a Fit to the Workspace ....................

Working with Sessions .............................
L0 =) T 1=
SaAVING SESSI0NS .+ vttt vttt ittt e
Reloading Sessions ..........ccoiiiiiiiiiiinnn.
Removing Sessions ...........c.coiiiiiiiiiiiiinnn.

Programmatic Curve and Surface Fitting

4

Introducing Programmatic Curve Fitting ............
Using Curve Fitting Objects and Methods .............
Interactive Code Generation ........................

Curve Fitting Objects and Methods .................
L0 =) T 1=
Curve Fitting Objects . ...t
Curve Fitting Methods ........... ... ... ... ... ...
Workflow for Object-Oriented Fitting .................
Examples .......... . .

Generating M-files From Curve Fitting Tool .........
L0 =) T 1=
The Generated M-file ............. ... ...
Running the Generated M-file .......................
Components of the Generated M-File .................
Modifyingthe Code ........... ... .. ...

Programmatic Surface Fitting ......................
Surface Fitting Objects and Methods ..................

vii



viii

Contents

Automotive Fuel Efficiency Programmatic Surface Fitting

Example ........ .. . . 4-42
Biopharmaceutical Drug Interaction Programmatic Surface
Fitting Example ....... ... ... i, 4-53

5

Data Transformations .............................. 5-2
Filtering and Smoothing ........................... 5-4
Moving Average Filtering ........................... 5-4
Savitzky-Golay Filtering ..............cccuuiiio.. .. 5-6
Local Regression Smoothing ......................... 5-7
Smoothing Splines ..., 5-13
Least-Squares Fitting .............................. 5-16
Introduction ......... ... .. 5-16
Error Distributions .......... ..., 5-17
Linear Least Squares ................ciiiinnn.. 5-18
Weighted Least Squares ...............cciiiiiiinn... 5-21
Robust Least Squares .............. .. ... 5-23
Nonlinear Least Squares ................c.ciuua.. 5-25
Residual Analysis ................ . .. 5-28
Introduction ......... .. ... 5-28
Computing Residuals ......... ... ... .. 5-29
Goodness-of-Fit Statistics ............cuui... 5-31
Confidence and Prediction Bounds ................... 5-34
Example: Residual Analysis .............ccvv... 5-39
Interpolants .......... ... ... . ... i, 5-45



Function Reference

6

Data Preprocessing ...................cciiiiuunnnn. 6-2
Data Fitting .......... .. ... . . 6-2
Fit Type Methods ................. ... ... ... ........ 6-2
Curve Fit Methods ........... .. ... .. ... ... ... .... 6-3
Surface Fit Methods ............ ... ... ... ... ..... 6-5
Fit Postprocessing .................0 ittt 6-6
Informationand Help .................. ... ........ 6-7

Functions — Alphabetical List

7

Bibliography

Al

Index

ix



X Contents



Getting Started

® “Product Overview” on page 1-2
e “Curve Fitting” on page 1-4
e “Surface Fitting” on page 1-5



1 Getting Started

Product Overview
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In this section...

“Major Features” on page 1-2

“Interactive and Programmatic Environments” on page 1-2

Maijor Features

Curve Fitting Toolbox™ software is a collection of graphical user interfaces
(GUIs) and M-file functions for curve and surface fitting that operate in
the MATLAB® technical computing environment. The toolbox supplements
MATLAB features with:

Data preprocessing capabilities, such as sectioning, excluding data, and
smoothing

Data fitting using parametric and nonparametric models:

= The toolbox includes a library of parametric models, with polynomials,
exponentials, rationals, sums of Gaussians, Fourier polynomials, and
many others.

= You can also define custom models to precisely reflect the goals of your
data analysis.

= Nonparametric models are available through a variety of smoothers
and interpolants.

Fitting methods for linear least squares, nonlinear least squares, weighted
least squares, constrained least squares, and robust fitting are available

Data and fit statistics to assist you in analyzing your models

Postprocessing capabilities that allow you to interpolate, extrapolate,
differentiate, and integrate the fit

The ability to save your work in various formats, including workspace
variables, binary files, and automatically generated MATLAB code

Interactive and Programmatic Environments

Curve Fitting Toolbox software allows you to work in two different
environments:




Product Overview

® An interactive environment, with Surface Fitting Tool and Curve Fitting
Tool graphical user interfaces

® A programmatic environment that allows you to write object-oriented
MATLAB code using curve and surface fitting methods

To open Curve Fitting Tool, type
cftool

To open Surface Fitting Tool, type

sftool

To list the Curve Fitting Toolbox functions for use in MATLAB programming,
type

help curvefit

The code for any function can be opened in the MATLAB Editor by typing
edit function_name

Brief, command line help for any function is available by typing
help function_name

Complete documentation for any function is available by typing

doc function_name

You can change the way any toolbox function works by copying and renaming
its M-file, examining your copy in the editor, and then modifying it.

You can also extend the toolbox by adding your own M-files, or by using your

code in combination with functions from other toolboxes, such as Statistics
Toolbox™ or Optimization Toolbox™ software.
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Getting Started

Curve Fitting

Interactive Curve Fitting
To interactively fit curves, see the following sections:

1 “Interactive Curve Fitting Example” on page 2-2
2 “Preprocessing Data” on page 2-21
3 “Fitting Data” on page 2-47

Programmatic Curve Fitting

To programmatically fit curves, see these sections in Programmatic Curve
and Surface Fitting:

1 “Introducing Programmatic Curve Fitting” on page 4-2
2 “Curve Fitting Objects and Methods” on page 4-9

3 “Generating M-files From Curve Fitting Tool” on page 4-30



Surface Fitting

Surface Fitting

Interactive Surface Fitting
To interactively fit surfaces, see Chapter 3, “Interactive Surface Fitting” for
information on the following topics:

1 Fitting a surface (includes instructions for an “Franke Data Interactive
Surface Fitting Example” on page 3-10)

2 Selecting fit settings
3 Fitting multiple surfaces
4 Comparing surface fits

5 Generating M-Files and exporting fits to the workspace

Programmatic Surface Fitting
To programmatically fit surfaces, see the following topics:

1 “Introducing Programmatic Surface Fitting” on page 3-43

2 “Surface Fitting Objects and Methods” on page 4-41
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Interactive Curve Fitting

¢ “Interactive Curve Fitting Example” on page 2-2
® “Preprocessing Data” on page 2-21

e “Fitting Data” on page 2-47
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Interactive Curve Fitting Example

In this section...

“Opening Curve Fitting Tool” on page 2-2
“Importing Data” on page 2-3
“Interactive Curve Fitting Procedure” on page 2-4

“Analyzing the Fit” on page 2-15

“Saving Your Work” on page 2-18

Opening Curve Fitting Tool
The Curve Fitting Tool is a graphical user interface (GUI) that allows you to

® Visually explore one or more data sets and fits as scatter plots.

® Graphically evaluate the goodness of fit using residuals and prediction
bounds.

® Access additional interfaces for

= Importing, viewing, and smoothing data

Fitting data, and comparing fits and data sets

Marking data points to be excluded from a fit

Selecting which fits and data sets are displayed in the tool

Interpolating, extrapolating, differentiating, or integrating fits

You open Curve Fitting Tool with the cftool command.

cftool



Interactive Curve Fitting Example

.} Curve Fitting Tool / =] 3]

File View Tools Window Help

N =T

@ IF you have thres dimensional data, try the Surface Fitting Tool x

Data | Fitting | Exclude Plotting Analysis

05 Select "Data” to begin curve fitting —

Importing Data

Before you can import data into Curve Fitting Tool, the data variables must
exist in the MATLAB workspace. For this example, the data is stored in the
MATLARB file census.mat.

load census

The workspace now contains two new variables, cdate and pop:

® cdate is a column vector containing the years 1790 to 1990 in 10-year
increments.

® pop is a column vector with the US population figures that correspond

to the years in cdate.

You can import data into Curve Fitting Tool with the Data GUI. You open
this GUI by clicking the Data button on Curve Fitting Tool. As shown below,
the Data GUI consists of two panes: Data sets and Smooth. The Data Sets
pane allows you to

2-3
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® Import predictor (X) data, response (Y) data, and weights. If you do not
import weights, then they are assumed to be 1 for all data points.

® Specify the name of the data set.

® Preview the data.

To load cdate and pop into Curve Fitting Tool, select the appropriate variable
names from the X Data and Y Data lists. The data is then displayed in the

Preview window. Click the Create data set button to complete the data
import process.

<) Data ) [s] 3]
Data Sets | Smggthl
Import workspace vectars:  Preview
*
Seled the data KData  |cdate | .
variable names. ¥ Data: pop - .
Weights: {nanej - +
*
Data set name: |p0p vg. cdate P
(lick Create dotaset Sroato date cat L
. reate data se
to import the data. 4| .
*
*
Data sets: ot
+*
PP
B Eenarme | elete |
Close | Help |

The Smooth pane is described in “Preprocessing Data” on page 2-21.

Interactive Curve Fitting Procedure

You fit data with the Fitting GUIL You open this GUI by clicking the Fitting
button on Curve Fitting Tool. The Fitting GUI consists of two parts: the Fit
Editor and the Table of Fits. The Fit Editor allows you to

2-4



Interactive Curve Fitting Example

Specify the fit name, the current data set, and the exclusion rule.

e Explore various fits to the current data set using a library or custom
equation, a smoothing spline, or an interpolant.

Override the default fit options such as the coefficient starting values.

Compare fit results including the fitted coefficients and goodness of fit
statistics.

The Table of Fits allows you to

¢ Keep track of all the fits and their data sets for the current session.
® Display a summary of the fit results.

e Save or delete the fit results.

The Data Fitting Procedure

For this example, begin by fitting the census data with a second degree
polynomial. Then continue fitting the data using polynomial equations up to
sixth degree, and a single-term exponential equation.

The data fitting procedure follows these general steps:

1 From the Fit Editor, click New Fit.

Note that this action always defaults to a linear polynomial fit type. You
use New Fit at the beginning of your curve fitting session, and when you
are exploring different fit types for a given data set.

2 Because the initial fit uses a second degree polynomial, select quadratic
polynomial from the Polynomial list. Name the fit poly2.

3 Click the Apply button or select the Immediate apply check box. The
library model, fitted coefficients, and goodness of fit statistics are displayed
in the Results area.

4 Fit the additional library equations.

2-5
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For fits of a given type (for example, polynomials), you should use Copy
Fit instead of New Fit because copying a fit retains the current fit type
state thereby requiring fewer steps than creating a new fit each time.

The Fitting GUI is shown below with the results of fitting the census data
with a quadratic polynomial.

Fitting

Fit Edfitor
hew fit Copy W

Ftname:  |poh?
Data set: |pq:»scdar _:J Exchsionnie: | (nore) -
Typeofit | Potyroma =] Center and scale ¥ data

fcube pobynomial
dtin degres polynamis
St degree pobynamial _:J

W= Hn Aocwac reb menmial

Fit OpBone. .. I Immadate sppty  Cancel I Ay I
Resuits

Linear model PolyZ:

E{x) = pl*x~2 + p2*x + p3

Coefficients (with 5% confidence bounds):

Pl = 0.006541 (D.0DE1Z4, O.0DSHSE)

Pz = -23.51 (-25.0%, -Z1.93)

p3 = Z.113e+0D4 (1.964e+0D4, Z.262e+004)

Goodnesz of fit:

3SE: 150

R-squace: 0.%%87

Adjusted R-square: 0.¥%E&E
FMSE: Z.G72

Table of Fits
@ | Ftname | Datsset | Eguatonname | 556 Rsquare |
@ palyz ve. cdate Poly2 155.023299.../0.9967 1 2%...

Delete it | Save to workspace.. | Table options.., |

_Gase | _ep |
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The data, fit, and residuals are shown below. You display the residuals as
a line plot by selecting the menu item View > Residuals > Line plot from
Curve Fitting Tool.

2} Curve Fitting Tool =] E3
File “iew Toolz ‘Window Help
S ®aq|EE

Data... I Fitting... Exclude... Platting.. Anabysis...

Data and Fits

= +  popws. cdate

200 poly2
160
100+

&0 -

L I L ! L L L ! L L
1800 1820 1240 1860 1880 1900 1920 1840 1860 1980

Residuals

—+— poly2

These residuals indicate that
a better fit may be possible.

L ! L L L L
1800 1820 1240 1260 1830 1900 1920 140 1860 1930

I =T

The residuals indicate that a better fit may be possible. Therefore, you
should continue fitting the census data following the procedure outlined in
the beginning of this section.

The residuals from a good fit should look random with no apparent pattern. A
pattern, such as a tendency for consecutive residuals to have the same sign,

can be an indication that a better model exists.

When you fit higher degree polynomials, the Results area displays this
warning:

Equation is badly conditioned. Remove repeated data points

2-7
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2-8

or try centering and scaling.

The warning arises because the fitting procedure uses the cdate values as
the basis for a matrix with very large values. The spread of the cdate values
results in scaling problems. To address this problem, you can normalize the
cdate data. Normalization is a process of scaling the predictor data to improve
the accuracy of the subsequent numeric computations. A way to normalize
cdate is to center it at zero mean and scale it to unit standard deviation.

(cdate - mean(cdate))./std(cdate)

To normalize data with Curve Fitting Tool, select the Center and scale X
data check box.

Note Because the predictor data changes after normalizing, the values of the
fitted coefficients also change when compared to the original data. However,
the functional form of the data and the resulting goodness of fit statistics do
not change. Additionally, the data is displayed in Curve Fitting Tool using
the original scale.

Determining the Best Fit

To determine the best fit, you should examine both the graphical and
numerical fit results.

Examining the Graphical Fit Results. Your initial approach in determining
the best fit should be a graphical examination of the fits and residuals. The
graphical fit results shown below indicate that

¢ The fits and residuals for the polynomial equations are all similar, making
it difficult to choose the best one.

® The fit and residuals for the single-term exponential equation indicate it is
a poor fit overall. Therefore, it is a poor choice for extrapolation.
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). Curve Fitting Tool M[=]E3

File “iew Tools  Window  Help

g e B

Diata... | Fittirg... | Exclude... | Plottitg... | Analysis... |

Data and Fits
T T T T T T T T T

280 - /

150 - —

100 - —

I I I
1800 1820 1840 1860 1820 1900 1820 1840 1960 1980

Residuals

L I I L I I
1800 1820 1840 18460 1820 15900 1820 1540 1960 1580

20 1 1 1 |

Use the Plotting GUI to remove exp1 from the scatter plot display.

) ploting I [=

Flaot data sets Plat fits

Data set Fit Data set
vl | pop vs. cdate vl | poly2 pop ws. cdate
v | paly3 pap ws. coate
[v! | polyd pop ws. cdate
vl | polys pop ws. cdate

I'f pole oop v, coate Remove this fit from
eip pop ¥s. coate

the scatter plot.

[ Clear associated fits when clearing data sets!

Close I Help |
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Because the goal of fitting the census data is to extrapolate the best fit to
predict future population values, you should explore the behavior of the fits
up to the year 2050. You can change the axes limits of Curve Fitting Tool by
selecting the menu item Tools > Axis Limit Control.

Alter the X Upper Limit to 2050, and increase the Y Upper Limit to 400. The
census data and fits are shown below for an upper abscissa limit of 2050. The
behavior of the sixth degree polynomial fit beyond the data range makes it a

poor choice for extrapolation.

) Curve Fitting Tool

File View Tools Window Help

g =[5

@8 & OB

Data... | Fitting.. | Exclude... Plotting...

Analysis...

Y Upper Limit =
£ Data and Fits

00 200 — : ; ;

300+

200 -

100

Y Laweer Limit

Fy
1.2187 0 L L L
= 1800 1850 1900 1950

*f Upper Limit

|T§| 10

Residuals

5 L

ol

1 i’-m 1800 1850 1900 1950
1788 ﬁ

¥ Lower Limit

2050

-
I 2050 j

H Upper Limit

As you can see, you should exercise caution when extrapolating with
polynomial fits because they can diverge wildly outside the data range.
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Examining the Numerical Fit Results. Because you can no longer
eliminate fits by examining them graphically, you should examine the
numerical fit results. There are two types of numerical fit results displayed
in the Fitting GUI: goodness of fit statistics and confidence intervals on the
fitted coefficients. The goodness of fit statistics help you determine how well
the curve fits the data. The confidence intervals on the coefficients determine
their accuracy.

Some goodness of fit statistics are displayed in the Results area of the Fit
Editor for a single fit. All goodness of fit statistics are displayed in the Table
of Fits for all fits, which allows for easy comparison.

In this example, the sum of squares due to error (SSE) and the adjusted
R-square statistics are used to help determine the best fit. The SSE statistic
is the least-squares error of the fit, with a value closer to zero indicating a
better fit. The adjusted R-square statistic is generally the best indicator of the
fit quality when you add additional coefficients to your model.

You can modify the information displayed in the Table of Fits with the Table
Options GUI. You open this GUI by clicking the Table options button on
the Fitting GUI. As shown below, select the adjusted R-square statistic and
clear the R-square statistic.

2-11
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) Table Options x|

Check to view column in Table of Fits:

W [@ Status I~ DFE

W Fit name W AdjR-sq
W Data set ™ RMSE

W Equation name [ # Coeff
v S5E ™ Type of fit

™ R-square

Close Help

The numerical fit results are shown below. You can click the Table of Fits
column headings to sort by statistics results.

The SSE for exp1 indicates it is a poor fit, which was already determined by
examining the fit and residuals. The lowest SSE value is associated with
poly6. However, the behavior of this fit beyond the data range makes it a
poor choice for extrapolation. The next best SSE value is associated with the
fifth degree polynomial fit, poly5, suggesting it may be the best fit. However,
the SSE and adjusted R-square values for the remaining polynomial fits are
all very close to each other. Which one should you choose?
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Tverk |_omye |

FErame:  pohs

Cata set:

||:rq:~vs. cdate

=] Ewchsion nue:

Typeofit |Poymoma

=

= |0 %

{none)

~ Cenier and scale ¥ data

4th degree polynomial J
St degres pobmomid
th degree pobynomial :l
PR cptons.» F mmeae soly e | i |
Resuits
Linear model Poly5: —

F{x) = pl*x~5 + p2=x~4 + p3*x"3 + pd*x~2 + p5*x + pé

where ¥ iz notmalized by mean 1ES0 and =td &£2.05
Cozfficients (with 93% confidence bounds):

pl = D.5877 ({=-Z.3053, 3.48)

Pz = 0D.7047 ({-1.6B4, 3.0%4)

p3 = -0.5%1%3 {-10.1%, B.358)

pd = 23.47 (17.42, 25.52)

P2 = T4.27  {gB.37, Bl.oT)

pé = 62.23 (59.51., 64.93) Ll
Table of Fits
B | Frrame | Damser | Equstionname | S5E | msquee |
@ polye » S, Cdake Fotyi 106.927557999... 09599 13462047. ..
@ ol 5. cdate fPoty4 |145.968924373... 0. 9589196642 L... |
H poiy3 {pop vs. cdate Paoty3 [143.768724181... 09287871212,
@ paty? pop vs, cdate o2 [155.0292991 76, [0.958 71256577

Crslerte fit | Save to workspace... | Tabie options... |

_Gose | _beb |

To resolve this issue, examine the confidence bounds for the remaining fits. By
default, 95% confidence bounds are calculated. You can change this level by
selecting the menu item View > Confidence Level from Curve Fitting Tool.

The p1, p2, and p3 coefficients for the fifth degree polynomial suggest that it
overfits the census data. However, the confidence bounds for the quadratic
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2 Interactive Curve Fitting

fit, poly2, indicate that the fitted coefficients are known fairly accurately.
Therefore, after examining both the graphical and numerical fit results, it
appears that you should use poly2 to extrapolate the census data.

Note The fitted coefficients associated with the constant, linear, and
quadratic terms are nearly identical for each polynomial equation. However,
as the polynomial degree increases, the coefficient bounds associated with the
higher degree terms increase, which suggests overfitting.

Saving the Fit Results

By clicking the Save to workspace button, you can save the selected fit and
the associated fit results to the MATLAB workspace. The fit is saved as a
MATLAB object and the associated fit results are saved as structures. This
example saves all the fit results for the best fit, poly2.

+). Save Fit to MATLAB Workspace x|

[v Save fit to MATLAB ohject named: I;medmudeh
v Save goodness of fit to MATLAB struct named: Igandness1
Iv Save fit output to MATLAB struct named: Inutpuﬂ

QK I Cancel |

fittedmodell is saved as a Curve Fitting Toolbox cfit object.

whos fittedmodel1

Name Size Bytes Class
fittedmodel1 1x1 6178 cfit object

Grand total is 386 elements using 6178 bytes

The cfit object display includes the model, the fitted coefficients, and the
confidence bounds for the fitted coefficients.

fittedmodel1
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fittedmodell =
Linear model Poly2:
fittedmodell (x) = p1*x°2 + p2*x + p3
Coefficients (with 95% confidence bounds):

pl1 =  0.006541 (0.006124, 0.006958)
p2 = -23.51 (-25.09, -21.93)
p3 = 2.113e+004 (1.964e+004, 2.262e+004)

The goodness1 structure contains goodness of fit results

goodness1

goodness1 =
sse: 159.0293
rsquare: 0.9987
dfe: 18
adjrsquare: 0.9986
rmse: 2.9724

The outputi structure contains additional information associated with the fit.

outputi

outputtl =
numobs: 21
numparam: 3
residuals: [21x1 double]
Jacobian: [21x3 double]
exitflag: 1
algorithm: 'QR factorization and solve'

Analyzing the Fit

You can evaluate (interpolate or extrapolate), differentiate, or integrate a fit
over a specified data range with the Analysis GUI. You open this GUI by
clicking the Analysis button on Curve Fitting Tool.

For this example, you will extrapolate the quadratic polynomial fit to predict

the US population from the year 2000 to the year 2050 in 10 year increments,
and then plot both the analysis results and the data. To do this:
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Enter the appropriate MATLAB vector in the Analyze at Xi field.
Select the Evaluate fit at Xi check box.

Select the Plot results and Plot data set check boxes.
Click the Apply button.

The numerical extrapolation results are shown below.

<) Analysis i =10l x|

Swtify the fit and | Fitto analyze: |polv2 (pop vs. ... 'l Hi T

- Eannananen (2000 274622
. Analyze at¥i=[2000:10:2050

dﬂh fo CIHCIIYIE L 2010 301.824
. ) 2020 330.334
SBIEC”I’IISCI’IECI( II)X — [¥ Evaluate fit at i 2030 60,152
to extrapolate. Prediction bounds: 2040 391.279
& Mone 2050 423.714

" Forfunction
© For new observation

Level | 95 %

[ 15t derivative at Xi
[ 2nd derivative at xi

[ Integrate to Xi
& Start from ming<i

© Start fram I
Plot both the analysis { [ Plot resuits

results and the data. [ Flot data set: pop vs. cdate

Save to workspace... | Apply | Close |

The extrapolated values and the census data set are displayed together in
a new figure window.
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-} Curve Fitting Analysis i =] 5]

File Edit ‘iew Insert Tools ‘window Help

[Dema rxars, 222

Analysis of fit "poly2" for dataset "pop vs. cdate”
450 T T T T

—— paly2

200 - % popve. cdate

350 - B

300 - B

280 + s i

Fit

200 - * .
150 - % i
100 * g

50t i .

b
%
§ % * 1

D 1 1 Il
1780 1800 1840 1900 1950 2000 2080

Saving the Analysis Results

By clicking the Save to workspace button, you can save the extrapolated
values as a structure to the MATLAB workspace.

+) Save Analysis Results to Workspace x|

Save analysis results to MATLAB struct named:Enalysisresultm
ke I Cancel |

The resulting structure is shown below.

analysisresultsi
analysisresultst =

xi: [6x1 double]
yfit: [6x1 double]
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Saving Your Work

Curve Fitting Toolbox software provides you with several options for saving
your work. You can save one or more fits and the associated fit results as
variables to the MATLAB workspace. You can then use this saved information
for documentation purposes, or to extend your data exploration and analysis.
In addition to saving your work to MATLAB workspace variables, you can

® “Save the Session” on page 2-18

® “Generate an M-File” on page 2-19

Before performing any of these tasks, you may want to remove unwanted data
sets and fits from Curve Fitting Tool display. An easy way to do this is with

the Plotting GUI. The Plotting GUI shown below is configured to display only
the census data and the best fit, poly2.

<) Plotting o [=[ 9]
Flot data sets Plat fits
Data set Fit Data set

¥|pop vs. cdate [¥|poly2 popvs. cdate

||: paly3 pop vs. cdate Clear the remaining fits
polyd popvs. cdate . .

Floons e cdate associated with the census
[ |palye pop vs. cdate data except the best fit.
mETY pop vs. cdate

[ Clear associated fits when cleating data sets.

o |

Save the Session

The curve fitting session is defined as the current collection of fits for all
data sets. You may want to save your session so that you can continue data
exploration and analysis at a later time using Curve Fitting Tool without
losing any current work.

Save the current curve fitting session by selecting the menu item File > Save
Session from Curve Fitting Tool. The Save Session dialog is shown below.
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Save Session HE
Save jh: I i3 CFSessionFiles ﬂ gl
DecayRate. cfit
poly1fit.cfit
poly2it cfit
poly i, it
reaction]. cfit
reachion?. cfit
File marme: Icensus \ﬂl
Save as type: |"_cfit j Cancel |

The session is stored in binary form in a cfit file, and contains this
information:

e All data sets and associated fits

® The state of the Fitting GUI, including Table of Fits entries and exclusion
rules

e The state of the Plotting GUI

To avoid saving unwanted data sets, you should delete them from Curve
Fitting Tool. You delete data sets using the Data Sets pane of the Data GUI. If
there are fits associated with the unwanted data sets, they are deleted as well.

You can load a saved session by selecting the menu item File > Load
Session from Curve Fitting Tool. When the session is loaded, the saved state
of Curve Fitting Tool display is reproduced, and may display the data, fits,
residuals, and so on. If you open the Fitting GUI, then the loaded fits are
displayed in the Table of Fits. Select a fit from this table to continue your
curve fitting session.

Generate an M-File

You may want to generate an M-file that captures your work, so that you can
continue your analysis outside of Curve Fitting Tool. The M-file can be used
without modification, or it can be edited as needed.
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To generate an M-file from a session in Curve Fitting Tool, select the menu
item File > Generate M-file.

The M-file captures the following information from Curve Fitting Tool:

e Names of variables, fits, and residuals

¢ Fit options, such as whether the data should be normalized, initial values
for the coefficients, and the fitting method

e Curve fitting objects and methods used to create the fit

You can recreate your Curve Fitting Tool session by calling the M-file from
the command line with your original data as input arguments. You can also
call the M-file with new data, and automate the process of fitting multiple
data sets.

For more information on working with a generated M-file, see “Generating
M-files From Curve Fitting Tool” on page 4-30.
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Preprocessing Data

In this section...

“Importing Data” on page 2-21

“Viewing Data” on page 2-25

“Smoothing Data” on page 2-28

“Excluding and Sectioning Data” on page 2-36

“Missing Values and Outliers” on page 2-46

Importing Data

¢ “Introduction” on page 2-21

e “Creating a Data Set” on page 2-22

¢ “Working with Data Sets” on page 2-23
¢ “Example: Importing Data” on page 2-23

Introduction

You import data sets into Curve Fitting Tool with the Data Sets pane of the
Data GUI. Using this pane, you can

® Select workspace variables that compose a data set
¢ Display a list of all imported data sets

® View, delete, or rename one or more data sets

The Data Sets pane is shown below followed by a description of its features.
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[~ Importworkspace vectors: Preview
Select® and Y vectors of equal length,
H Data: (hone) ¥ or a single ¥ vectar.
Y Data: nang hd
(onstruct and (none}
Weights: (hone) hd

name the data set. ™|

=0l x|

[Data Sefs | smoon|

Data setname: I

Data gets

Data sets list —]

Cloge | Help |

Creating a Data Set

* Import workspace vectors — All selected variables must be the same

length. You can import only vectors, not matrices or scalars. Infs and NaNs
are ignored because you cannot fit data containing these values, and only
the real part of a complex number is used. To perform any curve-fitting
task, you must select at least one vector of data:

= X data — Select the predictor data.
= Y data — Select the response data.

= Weights — Select the weights associated with the response data. If
weights are not imported, they are assumed to be 1 for all data points.

Preview — The selected workspace vectors are displayed graphically in
the preview window. Weights are not displayed.

Data set name — The name of the imported data set. The toolbox
automatically creates a unique name for each imported data set. You can
change the name by editing this field. Click the Create data set button to
complete the data import process.
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Working with Data Sets

®* Data sets — Lists all data sets added to Curve Fitting Tool. The data sets
can be created from workspace variables, or from smoothing an existing
imported data set. When you select a data set, you can perform these
actions:

= Click View to open the View Data Set GUI. Using this GUI, you can view
a single data set both graphically and numerically. Additionally, you can
display data points to be excluded in a fit by selecting an exclusion rule.

= Click Rename to change the name of a single data set.

= Click Delete to delete one or more data sets. To select multiple data sets,
you can use the Ctrl key and the mouse to select data sets one by one, or
you can use the Shift key and the mouse to select a range of data sets.

Example: Importing Data

This example imports the ENSO data set into the Curve Fitting Tool using
the Data Sets pane of the Data GUI. The first step is to load the data from
the file enso.mat into the MATLAB workspace.

load enso
The workspace contains two new variables, pressure and month:
® pressure is the monthly averaged atmospheric pressure differences

between Easter Island and Darwin, Australia. This difference drives the
trade winds in the southern hemisphere.

® month is the relative time in months.

Alternatively, you can import data by specifying the variable names as
arguments to the cftool function.

cftool(month,pressure)
In this case, the Data GUI is not opened.
The data import process is described below:

1 Select workspace variables.
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The predictor and response data are displayed graphically in the Preview
window. Weights and data points containing Infs or NaNs are not displayed.

2 Specify the data set name.

You should specify a meaningful name when you import multiple data sets.
If you do not specify a name, the default name, which is constructed from
the selected variable names, is used.

3 Click the Create data set button.

The Data sets list box displays all the data sets added to the toolbox. Note
that you can construct data sets from workspace variables, or by smoothing
an existing data set.

If your data contains Infs or complex values, a warning message like this
appears.

Impott Data |

! ! lgnoring Infs in data and using only the real component of complex data

After you click the Create data set window.

The Data Sets pane shown below displays the imported ENSO data in the
Preview button, the data set enso is added to the Data sets list box. You
can then view, rename, or delete enso by selecting it in the list box and
clicking the appropriate button.
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IO x|
Data Sets | Smggthl
Importwarkspace vectars: [ Presiesy
Select the workspace ¥ Data: [month |
. +*
variable names. ¥ Data: [pressure <] * e P
" * . g
Weights: (nonej - Y . *e e .
AR 2 SN ?
W e
. I'Ed }’o -y ";:’ a4 - 4 "
Speufyi afa set name. Diata set name: |enso MM AR R A4
LU o w
Click Crente dotu set to Create data set | et Lee
. *
import the data. ot oy
+*
Data sets: 4 * *
RSy s
census
e Eenarme | Uelete |
Close | Help |

Viewing Data

® “Viewing Data Graphically” on page 2-25
* “Viewing Data Numerically” on page 2-27

Viewing Data Graphically

After you import a data set, it is automatically displayed as a scatter plot in
Curve Fitting Tool. The response data is plotted on the vertical axis and the
predictor data is plotted on the horizontal axis.

The scatter plot is a powerful tool because it allows you to view the entire data
set at once, and it can easily display a wide range of relationships between the
two variables. You should examine the data carefully to determine whether
preprocessing is required, or to deduce a reasonable fitting approach. For
example, it’s typically very easy to identify outliers in a scatter plot, and to
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determine whether you should fit the data with a straight line, a periodic
function, a sum of Gaussians, and so on.

Enhancing the Graphical Display. Curve Fitting Toolbox software provides
several tools for enhancing the graphical display of a data set. These tools are
available through the Tools menu, the GUI toolbar, and right-click menus.

You can zoom in or out, turn on or off the grid, and so on using the Tools
menu and the GUI toolbar shown below.

Custom Equation & ® G M [
¥ | egend
ricd

Loorm In Todls GUI Toolbar

Zoorm Ot Henu
Pan
Axiz Limit Cortral

Default Axis Limits

You can change the color, line width, line style, and marker type of the
displayed data points using the right-click menu shown below. You activate
this menu by placing your mouse over a data point and right-clicking. Note
that a similar menu is available for fitted curves.

Color. ..

Line ‘width . .
lnestde » | Right-click menu
Marker *
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The ENSO data is shown below after the display has been enhanced using
several of these tools.

) Uiarvez Fallirsy T ooul

Fie Yiew Toos YWidoe Help
8 aan B EE
W Lipner Limit
= o 2 T T T :
: : : [ enseH Display the legend for
i : ; the ENSO data set.
20} i .
\ | @m;ﬁﬂ%‘;[ y Display data fips using
t6f---—fs ' { | . 4 ilvl MATLAB's click functionality.
| i T,
'w'f!.v\ ﬂm i f’“lﬁﬂ|' 'Q\ ILJ l(J! i rJ }{\&#— Change the color, marker
= L[ J I ‘/ S ﬂ ] ¢ ! a7 “ _J type and line style for the data.
: | {. [1 ; [ | ,J
J ’ \ Display the grid.
k- . . L o
=y
|+§ corowomom|mow e %ﬁ— Change the axis limits.
X Lower Limt X Upper Limit

Viewing Data Numerically

You can view the numerical values of a data set, as well as data points to
be excluded from subsequent fits, with the View Data Set GUI. You open
this GUI by selecting a name in the Data sets list box of the Data GUI and
clicking the View button.
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The View Data Set GUI for the ENSO data set is shown below, followed by
a description of its features.

<) ¥iew Data Set _|o] x|
Data set: enso Tl 3 v YWeights
¥ manth 1 1 128 -
X pressure 2 2 11.3
Weights: (none) 3 3 10.6
S 4 4 11.2
* + E a a 104
+ M .+t
4 * e Iy 4] 4] 78
S P *,s’ ST 7 77
+ *
oo el L b e 8 17
-
o T 5 3 12.9
ot at e W
L AP 10 10 143
* - *
AP % % 11 11 104
+ .t 12 12 137
* 13 13 174
% 14 14 14
Exclusion rules: 15 15 15.3
16 16 84
|(n0ne) ;I 17 17 =T ;I
Close |

e Data set — Lists the names of the viewed data set and the associated
variables. The data is displayed graphically below this list.

The index, predictor data (X), response data (Y), and weights (if imported)
are displayed numerically in the table. If the data contains Infs or NaNs,

those values are labeled “ignored.” If the data contains complex numbers,
only the real part is displayed.

e Exclusion rules — Lists all the exclusion rules that are compatible with
the viewed data set. When you select an exclusion rule, the data points
marked for exclusion are grayed in the table, and are identified with an
“x” in the graphical display. To exclude the data points while fitting, you

must create the exclusion rule in the Exclude GUI and select the exclusion

rule in the Fitting GUL

An exclusion rule is compatible with the viewed data set if their lengths are
the same, or if it is created by sectioning only.

Smoothing Data

® “Introduction” on page 2-29

e “Creating a Smoothed Data Set” on page 2-31
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® “Smoothing Method” on page 2-31
* “Working with Smoothed Data Sets” on page 2-32
¢ “Example: Smoothing Data” on page 2-32

Introduction

If your data is noisy, you might need to apply a smoothing algorithm to expose
its features, and to provide a reasonable starting approach for parametric
fitting. The two basic assumptions that underlie smoothing are

® The relationship between the response data and the predictor data is
smooth.

® The smoothing process results in a smoothed value that is a better estimate
of the original value because the noise has been reduced.

The smoothing process attempts to estimate the average of the distribution
of each response value. The estimation is based on a specified number of
neighboring response values.

You can think of smoothing as a local fit because a new response value is
created for each original response value. Therefore, smoothing is similar

to some of the nonparametric fit types supported by the toolbox, such as
smoothing spline and cubic interpolation. However, this type of fitting is not
the same as parametric fitting, which results in a global parameterization
of the data.

Note You should not fit data with a parametric model after smoothing,
because the act of smoothing invalidates the assumption that the errors are
normally distributed. Instead, you should consider smoothing to be a data
exploration technique.

There are two common types of smoothing methods: filtering (averaging) and
local regression. Each smoothing method requires a span. The span defines
a window of neighboring points to include in the smoothing calculation for
each data point. This window moves across the data set as the smoothed
response value is calculated for each predictor value. A large span increases
the smoothness but decreases the resolution of the smoothed data set, while
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a small span decreases the smoothness but increases the resolution of the
smoothed data set. The optimal span value depends on your data set and the
smoothing method, and usually requires some experimentation to find.

Curve Fitting Toolbox software supports these smoothing methods:

* Moving average filtering — Lowpass filter that takes the average of
neighboring data points.

® Lowess and loess — Locally weighted scatter plot smooth. These methods
use linear least-squares fitting, and a first-degree polynomial (lowess) or a
second-degree polynomial (loess). Robust lowess and loess methods that
are resistant to outliers are also available.

® Savitzky-Golay filtering — A generalized moving average where you derive
the filter coefficients by performing an unweighted linear least-squares fit
using a polynomial of the specified degree.

Note that you can also smooth data using a smoothing spline. Refer to
“Nonparametric Fitting” on page 2-94 for more information.

You smooth data with the Smooth pane of the Data GUI. The pane is shown
below followed by a description of its features.
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Diata Sets  Smoath |

Original data set; enso hd
Data sets =
Smoothed data et |enso {=moath)

. [ Method: Moving Average -

Smoothing method _ =
nd Span: ]

and paramefers BagiEs:

. Create smoothed data set |

[~ Smoothed data sets:

enso {smoath)

Data sets list

= Eenarme | [Deleta | Savetnwarkspace. .. |

Close | Help |

Creating a Smoothed Data Set

® Original data set — Select the data set you want to smooth.

* Smoothed data set — Specify the name of the smoothed data set. Note
that the process of smoothing the original data set always produces a new
data set containing smoothed response values.

Smoothing Method

® Method — Select the smoothing method. Each response value is replaced
with a smoothed value that is calculated by the specified smoothing method.
= Moving average — Filter the data by calculating an average.

= Lowess — Locally weighted scatter plot smooth using linear
least-squares fitting and a first-degree polynomial.
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= Loess — Locally weighted scatter plot smooth using linear least-squares
fitting and a second-degree polynomial.

= Savitzky-Golay — Filter the data with an unweighted linear
least-squares fit using a polynomial of the specified degree.

= Robust Lowess — Lowess method that is resistant to outliers.
= Robust Loess — Loess method that is resistant to outliers.
® Span — The number of data points used to compute each smoothed value.

For the moving average and Savitzky-Golay methods, the span must be
odd. For all locally weighted smoothing methods, if the span is less than 1,
it is interpreted as the percentage of the total number of data points.

* Degree — The degree of the polynomial used in the Savitzky-Golay
method. The degree must be smaller than the span.

Working with Smoothed Data Sets

®* Smoothed data sets — Lists all the smoothed data sets. You add a
smoothed data set to the list by clicking the Create smoothed data set
button. When you select a data set from the list, you can perform these
actions:

= Click View to open the View Data Set GUI. Using this GUI, you can view
a single data set both graphically and numerically. Additionally, you can
display data points to be excluded in a fit by selecting an exclusion rule.

= Click Rename to change the name of a single data set.

= Click Delete to delete one or more data sets. To select multiple data sets,
you can use the Ctrl key and the mouse to select data sets one by one, or
you can use the Shift key and the mouse to select a range of data sets.

= Click Save to workspace to save a single data set to a structure.

Example: Smoothing Data

This example smooths the ENSO data set using the moving average, lowess,
loess, and Savitzky-Golay methods with the default span. As shown below,
the data appears noisy. Smoothing might help you visualize patterns in the
data, and provide insight toward a reasonable approach for parametric fitting.
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Curve Fitting Tool

Because the data appears
noisy, smoothing might help
uncover its structure.
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The Smooth pane shown below displays all the new data sets generated by
smoothing the original ENSO data set. Whenever you smooth a data set,

a new data set of smoothed values is created. The smoothed data sets are
automatically displayed in Curve Fitting Tool. You can also display a single
data set graphically and numerically by clicking the View button.

A new data set composed of smoothed

) Data S |
oo ntn i |
rignastaset | o |
——————Sromed ds set frza rmom,
Mthoct Sty oty = |

values is created from the original data set.

All smoothed data sets are listed here.

Click the View button to display

the selected data set.
<) View Data Set oy [=] 3|
Data set enso (A) Indeix ) v Weights
X marth 1 1 H28 a|
Original ¥ pressure 2 2 16
Weights: (none) s 3 1138
4 4 103
Methock: Woving Average 5 g Ben
Span S 3 6 28
Deee 7 7 1014
; 3 3 1082
s ik 9 115
S, o 10 27
s +
ey . X BN 11 1378
B Y S R R N IF] 1z 4
FRCATY N SL N 13 a2
ST & 4 14 13.72
A ‘T
wd LT s 15 1242
+ - 6 16 28
¥ M 7 i 252
. he 18 718
ad ha 19 694
Exclusion rules: 20 Pl 732
21 2 a7s &l
Close

T The View Data Set GUI disrlluys the

selected data set graphically and numerically.
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Use the Plotting GUI to display only the data sets of interest. As shown
below, the periodic structure of the ENSO data set becomes apparent when
it is smoothed using a moving average filter with the default span. Not
surprisingly, the uncovered structure is periodic, which suggests that a
reasonable parametric model should include trigonometric functions.

-} Plntting

[=[o[x]
Fict dats ety Pt 1its.
Daln et | | Fi [ owsem
. r WA) MAY
D!s,:luy only the data set created — 15 | et o=
with the moving average method. [ lerso Dowess)
™ e (Lomss)
I leran 50y
I Ciear nusscisben fia when cienring dnin sets
Fie View Tools Window Help Clage Help
g ea® En

The smoothing process uncovers obvious
periodic structure in the data.

o 20 40 & B0 0 120 140 160

Saving the Results. By clicking the Save to workspace button, you can
save a smoothed data set as a structure to the MATLAB workspace. This
example saves the moving average results contained in the enso (ma) data set.

«) Save Smoothed Data to Workspace x|

Save smoothed data to MATLAB struct named:lsmontheddata1
oK | Cancel |
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The saved structure contains the original predictor data x and the smoothed
data vy.

smootheddata1

smootheddatal =
X: [168x1 double]
y: [168x1 double]

Excluding and Sectioning Data

¢ “Introduction” on page 2-36

¢ “Exclusion Rules” on page 2-37

¢ “Excluding Individual Data Points” on page 2-38

¢ “Excluding Data Sections in the Domain or Range” on page 2-38
® “Marking Outliers” on page 2-38

e “Sectioning” on page 2-41

e “Example: Excluding and Sectioning Data” on page 2-43

Introduction

If there is justification, you might want to exclude part of a data set from a
fit. Typically, you exclude data so that subsequent fits are not adversely
affected. For example, if you are fitting a parametric model to measured
data that has been corrupted by a faulty sensor, the resulting fit coefficients
will be inaccurate.

Curve Fitting Toolbox software provides two methods to exclude data:

o Marking Outliers — Outliers are defined as individual data points that
you exclude because they are inconsistent with the statistical nature of
the bulk of the data.

® Sectioning — Sectioning excludes a window of response or predictor data.
For example, if many data points in a data set are corrupted by large
systematic errors, you might want to section them out of the fit.
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For each of these methods, you must create an exclusion rule, which captures

the range, domain, or index of the data points to be excluded.

To exclude data while fitting, you use the Fitting GUI to associate the
appropriate exclusion rule with the data set to be fit. Refer to “Example:
Robust Fitting” on page 2-88 for more information about fitting a data set

using an exclusion rule.

You mark data to be excluded from a fit with the Exclude GUI, which
you open from Curve Fitting Tool. The GUI is shown below followed by

a description of its features.

<} Exnclude 4 _|- _ID ﬂ
Exclusion rule. ——  Exclusion rule name: |ex03 Existing exlusion rules:
— Exclude Point: excl
exc2
Select data set Ienso VI Exclude graphically |
Exdudeindividuul Check to exclude paint:
. ] Index X ¥
data points.
po 1 1 12.49 -
|2 2 11.3
|3 3 10.6 =
[~ -Exclude Section
Exclude t!uiu seclions | | &ugex = =] | @
by domain or range.
i Exclude Y [== - | Excludey [»= =] | Comy | pr— |
| Create exclusion rule I Eenarme | [elete |
Close | Help |

Exclusion Rules

¢ Exclusion rule name — Specify the name of the exclusion rule that

identifies the data points to be excluded from subsequent fits.

¢ Existing exclusion rules — Lists the names of all exclusion rules created
during the current session. When you select an existing exclusion rule, you

can perform these actions:

= Click Copy to copy the exclusion rule. The exclusions associated with
the original exclusion rule are recreated in the GUI. You can modify
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these exclusions and then click Create exclusion rule to save them to
the copied rule.

= Click Rename to change the name of the exclusion rule.

= Click Delete to delete the exclusion rule. To select multiple exclusion
rules, you can use the Ctrl key and the mouse to select exclusion rules
one by one, or you can use the Shift key and the mouse to select a range
of exclusion rules.

= Click View to display the exclusion rule graphically. If a data set is
associated with the exclusion rule, the data is also displayed.

Excluding Individual Data Points

e Select data set — Select the data set from which data points will be
marked as excluded. You must select a data set to exclude individual
data points.

¢ Exclude graphically — Open a GUI that allows you to exclude individual
data points graphically.

Individually excluded data points are marked by an “x” in the GUI, and are
automatically identified in the Check to exclude point table.

® Check to exclude point — Select individual data points to exclude. You
can sort this table by clicking on any of the column headings.

Excluding Data Sections in the Domain or Range

® Section — Specify data to be excluded. You do not need to select a data set
to create an exclusion rule by sectioning.

= Exclude X — Specify beginning and ending intervals in the predictor
data to be excluded.

= Exclude Y — Specify beginning and ending intervals in the response
data to be excluded.

Marking Outliers

Outliers are defined as individual data points that you exclude from a fit
because they are inconsistent with the statistical nature of the bulk of the
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data, and will adversely affect the fit results. Outliers are often readily
1dentified by a scatter plot of response data versus predictor data.

Marking outliers with Curve Fitting Tool follows these rules:

® You must specify a data set before creating an exclusion rule.

In general, you should use the exclusion rule only with the specific data set
it was based on. However, the toolbox does not prevent you from using the
exclusion rule with another data set provided the size is the same.

¢ Using the Exclude GUI, you can exclude outliers either graphically or
numerically.

As described in “Parametric Fitting” on page 2-49, one of the basic
assumptions underlying curve fitting is that the data is statistical in nature
and is described by a particular distribution, which is often assumed to be
Gaussian. The statistical nature of the data implies that it contains random
variations along with a deterministic component.

data = deterministic component + random component

However, your data set might contain one or more data points that

are non-statistical in nature, or are described by a different statistical
distribution. These data points might be easy to identify, or they might be
buried in the data and difficult to identify.

A non-statistical process can involve the measurement of a physical variable
such as temperature or voltage in which the random variation is negligible
compared to the systematic errors. For example, if your sensor calibration
is inaccurate, the data measured with that sensor will be systematically
inaccurate. In some cases, you might be able to quantify this non-statistical
data component and correct the data accordingly. However, if the scatter plot
reveals that a handful of response values are far removed from neighboring
response values, these data points are considered outliers and should be
excluded from the fit. Outliers are usually difficult to explain away. For
example, it might be that your sensor experienced a power surge or someone
wrote down the wrong number in a log book.

If you decide there is justification, you should mark outliers to be excluded
from subsequent fits—particularly parametric fits. Removing these data
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points can have a dramatic effect on the fit results because the fitting process
minimizes the square of the residuals. If you do not exclude outliers, the
resulting fit will be poor for a large portion of your data. Conversely, if you
do exclude the outliers and choose the appropriate model, the fit results
should be reasonable.

Because outliers can have a significant effect on a fit, they are considered
influential data. However, not all influential data points are outliers. For
example, your data set can contain valid data points that are far removed
from the rest of the data. The data is valid because it is well described by
the model used in the fit. The data is influential because its exclusion will
dramatically affect the fit results.

Two types of influential data points are shown below for generated data. Also
shown are cubic polynomial fits and a robust fit that is resistant to outliers.

Influential Data Points

150
100
- These outliers odversely
* uffect the fit.
50 1 1 1 1 1 1 1 1 1 1
0 1 2 3 4 5 i} 7 ] 9 10
ia)
150 T T T T T T T T
« data
cubic fit
100 7
These dutn points ure
tonsistent with the model.

50 1 1 1 | | | | | | |

0 1 2 3 4 5 [ 7 8 9 10

(b)
150 T T T T T T T T
= data
robust cubic fit

100 q
50 1 1 1 1 1 1 1 1 1 1

0 1 2 3 4 5 & 7 a 9 10
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Plot (a) shows that the two influential data points are outliers and adversely
affect the fit. Plot (b) shows that the two influential data points are
consistent with the model and do not adversely affect the fit. Plot (¢) shows
that a robust fitting procedure is an acceptable alternative to marking
outliers for exclusion.

Sectioning

Sectioning involves specifying response or predictor data to exclude. You
might want to section a data set because different parts of the data set are
described by different models or are corrupted by noise, large systematic
errors, and so on.

Sectioning data with Curve Fitting Tool follows these rules:
¢ If you are only sectioning data and not excluding individual data points,

then you can create an exclusion rule without specifying a data set name.

® You can associate an exclusion rule with any data set provided that the
exclusion rule overlaps with the data. This is useful if you have multiple
data sets from which you want to exclude data points using the same rule.

e Use the Exclude GUI to create the exclusion rule.

® You can exclude vertical strips at the edges of the data, horizontal strips
at the edges of the data, or a border around the data. Refer to “Example:
Excluding and Sectioning Data” on page 2-43 for an example.

® To exclude multiple sections of data, you can use the excludedata function
from the MATLAB command line.
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Two examples of sectioning by domain are shown below for generated data.

Sectioning Data

18 T T : T L—— T T T T
This section fit with o 16 : e
lineor polynomical .| .
i B T TS T e,
14f o B 1
I o] : [ae
Thissection fit with 0 12 _’,_5’__,_—‘*(%7\3 X 4
] ; - .
tubic polynomicol -__10— 5 e Yol |
o Data : k"u(f&
gf | = = =Linear fit| : -} u.“:,—
Cubic fit |
6 T T 1 1 1 1 1 1 1
0 2 4 6 8 10 12 14 16 18 20
Dato corrupted by noise
18 T T T T pl T T T “ T
16 - & .
%%‘;ﬁo’:’w_"ﬂﬂ- o
P - = LA _.\.,',_'(—)
14 : ey 27
_GOW : T
121 : Sy 0o b
e} [
10F o] B
< Data _ 0P e
Bl |= = =Linearfit| ° : =
Cubicfit| :
6 T T N 1 1 1 1 1 1 1
0 2 4 6 8 10 12 14 16 18 20

The upper shows the data set sectioned by fit type. The section to the left of 4
is fit with a linear polynomial, as shown by the bold, dashed line. The section
to the right of 4 is fit with a cubic polynomial, as shown by the bold, solid line.

The lower plot shows the data set sectioned by fit type and by valid data.
Here, the right-most section is not part of any fit because the data is corrupted
by noise.

Note For illustrative purposes, the preceding figures have been enhanced
to show portions of the curves with bold markers. Curve Fitting Toolbox
software does not use bold markers in plots.
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Example: Excluding and Sectioning Data
This example modifies the ENSO data set to illustrate excluding and

sectioning data. First, copy the ENSO response data to a new variable and
add two outliers that are far removed from the bulk of the data.

yy = pressure;
yy(ceil(length(month)*rand(1))) = mean(pressure)*2.
yy(ceil(length(month)*rand(1))) mean(pressure) *3.

53
0;

Import the variables month and yy as the new data set enso1, and open the
Exclude GUIL

Assume that the first and last eight months of the data set are unreliable, and
should be excluded from subsequent fits. The simplest way to exclude these
data points is to section the predictor data. To do this, specify the data you
want to exclude in the Exclude Sections field of the Exclude GUI.

Exclude ¥ |<: 'I IB Exclude ¥ |=: 'I |1B1
Exclude ¥ |=: YI I Exclude |=: vl I

Exclude Sections

There are two ways to exclude individual data points: using the Check to
exclude point table or graphically. For this example, the simplest way to
exclude the outliers is graphically. To do this, select the data set name and
click the Exclude graphically button, which opens the Select Points for
Exclusion Rule GUIL

Select the data set.

Exclude Points

Open the GUI to exclude
data points graphically.

Select data set: Ienso Ll Exclude graphically

Check to exclude point:

Indes ¥ ¥

1 1 1248 RN
Oz 2 1.3

mE k] 10.6 =l

To mark data points for exclusion in the GUI, place the mouse cursor over
the data point and left-click. The excluded data point is marked with a red

2-43



2 Interactive Curve Fitting

2-44

X. To include an excluded data point, right-click the data point or select the
Includes Them radio button and left-click. Included data points are marked
with a blue circle. To select multiple data points, click the left mouse button
and drag the selection rubber band so that the rubber band box encompasses
the desired data points. Note that the GUI identifies sectioned data with gray
strips. You cannot graphically include sectioned data.

As shown below, the first and last eight months of data are excluded from
the data set by sectioning, and the two outliers are excluded graphically.
Note that the graphically excluded data points are identified in the Check to
exclude point table. If you decide to include an excluded data point using
the table, the graph is automatically updated.

-} Select Points for Excluded Set (=]

The x's indicate data

. ' ' ' © Included

points excluded manually. = M
Outside domain/range
s

The vertical gray strips 25

indicate data points \

sectioned by domain. A Y. [ =

o o o @% ®: month
15 ] ]

O? @C@é? g @é%% o@ Og Selecting Points:
@ CS% o) (@ ' Excludes Them
10 C@é &

" Includes Them

°,2 %8

g ° 000 O, 3 % Evclude Al |
=]

0 @ Include Al |

Close |

If there are fits associated with the data, you can exclude data points based on
the residuals of the fit by selecting the residual data in the Y list.
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The Exclude GUI for this example is shown below.

<} Exclude

Exclusion rule name: |enso_exc1 Existing exlusion rules:
~Exclude Point: secl
secl
Select data set: Ienso VI Exclude graphically |
Checkto exclude paint:
Index bt Y
[1|159 149 138 4 Individual data points
11150 160 87 | marked for exclusion.
161 161 a6 -
-Exclude Section Data points outside the
Exclude X [= =] B Exclude % [-= =] [Ta1 specified domain are
ma rlted for EXCIUSiOﬂ.
Exclude v |<: vl | Exclude ¥ |== )
I =l I Cofy | BN |
| Create exclusion rule I Renarme | Delete |

Close | Help |

To save the exclusion rule, click the Create exclusion rule button. To
exclude the data from a fit, you must select the exclusion rule from the Fitting
GUI. Because the exclusion rule created in this example uses individually

excluded data points, you can use it only with data sets that are the same
size as the ENSO data set.

Viewing the Exclusion Rule. To view the exclusion rule, select an existing
exclusion rule name and click the View button.
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The View Exclusion Rule GUI shown below displays the modified ENSO data
set and the excluded data points, which are grayed in the table.

=10
Exclusion rule: ensol_excl Index W Yo |weights
. 1 1 128 N
Data set: ensol
2 2 11.3 J
3 3 10.6 .
N} ' i 113 The excluded data points
5 g 108 are grayed in the table.
1 3 6 75
7 7 77
8 8 1.7
+ + 3 4y
Y Y. 4, g g 12.9
+ + -
?f"?g.c?,{; 2 5 ‘«t‘ 10 0 143
"‘"’.’:*f‘ .ﬁ -~ 1 11 10.9
RS U 12 12 137
* . 13 13 17.1
14 14 14
15 15 16.3
8=X=161 16 16 8.5
17 17 AT

Missing Values and Outliers

Although Curve Fitting Toolbox software ignores Infs and NaNs when fitting
data, and you can exclude outliers during the fitting process, you might
still want to remove this data from your data set. To do so, you modify the
associated data set variables from the MATLAB command line.

For example, when using toolbox functions such as fit from the command
line, you must supply predictor and response vectors that contain finite
numbers. To remove Infs, you can use the isinf function.

ind = find(isinf(xx));
xx(ind) = [];
yy(ind) [1;

To remove NaNs, you can use the isnan function. For examples that remove
NaNs and outliers from a data set, refer to “Missing Data” in the MATLAB
documentation.
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Fitting Data

In this section...

“The Fitting Process” on page 2-47
“Parametric Fitting” on page 2-49
“Nonparametric Fitting” on page 2-94

The Fitting Process

You fit data using the Fitting GUI. To open the Fitting GUI, click the Fitting
button from Curve Fitting Tool.

The Fitting GUI is shown below for the census data described in Chapter 1,

“Getting Started”, followed by the general steps you use when fitting any
data set.
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2 ol =
Fit Edditor
hew fit I Copy ft |
FErame:  pohs
Cata set: Ipapvs. cdate :_I Exclusionnue: | {nome)

Typeofit |Poymoma =] F Center and scale x datm

|
=
4th degree polynomial J
degree pohmamial
th degree pobynomial :l
Fit options, . el Anphy
Resuits

Linear model Poly5: —
F{x) = pl*x~5 + p2=x~4 + p3*x"3 + pd*x~2 + p5*x + pé

where ¥ iz notmalized by mean 1ES0 and =td &£2.05
Cozfficients (with 93% confidence bounds):

pl = 0D.5877 ({=-Z.305, 3.48)

Pz = D.7047 ({-1.6B4, 3.D%4)

pl = -D0.%153 {-1D.1%, B.358)

pd = 23,47 (17.42, 26_52)

pa = 74,97 J(GB.37, Bl.3T)

pE = 62.23 (3%.51, 64.%3) :I
Table of Fits
B | Ftreme | Camset | Equstenname | 5E | resguee |
@ pole vs, cdate  PohE 106, 377557399, |0.999 | 3462847
@ poky4 vs.cdate  [Polyd [145 568924273,.. 0.9989 1956421... |
& poly3 popvs. cdate Pty [142.768724181... p.3sa78751215..,
@ poky2 pop vs, cdake Poby2 |155.0292991 76, 0.9507 1256577,

Delete it | Save toworkepace,. | Tabe cptors,. |

_Gose | b |

1 Select a data set and fit name.

¢ Select the name of the current fit. When you click New fit or Copy fit,
a default fit name is automatically created in the Fit name field. You
can specify a new fit name by editing this field.
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e Select the name of the current data set from the Data set list. All
imported and smoothed data sets are listed.

2 Select an exclusion rule.

If you want to exclude data from a fit, select an exclusion rule from the
Exclusion rule list. The list contains only exclusion rules that are
compatible with the current data set. An exclusion rule is compatible with
the current data set if their lengths are identical, or if it is created by
sectioning only.

3 Select a fit type and fit options, fit the data, and evaluate the goodness of fit.

® The fit type can be a library or custom parametric model, a smoothing
spline, or an interpolant.

e Select fit options such as the fitting algorithm, and coefficient starting
points and constraints. Depending on your data and model, accepting
the default fit options often produces an excellent fit.

¢ Fit the data by clicking the Apply button or by selecting the Immediate
apply check box.

e Examine the fitted curve, residuals, goodness of fit statistics, confidence
bounds, and prediction bounds for the current fit.

4 Compare fits.

¢ Compare the current fit and data set to previous fits and data sets by
examining the goodness of fit statistics.

¢ Use the Table Options GUI to modify which goodness of fit statistics are
displayed in the Table of Fits. You can sort the table by clicking on
any column heading.

5 Save the fit results.

If the fit is good, save the results as a structure to the MATLAB workspace.
Otherwise, modify the fit options or select another model.

Parametric Fitting

¢ “Introduction” on page 2-50
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e “Library Models” on page 2-51

e “Custom Models” on page 2-56

® “Specifying Fit Options” on page 2-78

e “Example: Rational Fit” on page 2-82

e “Example: Robust Fitting” on page 2-88

Introduction

Parametric fitting involves finding coefficients (parameters) for one or more
models that you fit to data. The data is assumed to be statistical in nature
and is divided into two components: a deterministic component and a random
component.

data = deterministic component + random component

The deterministic component is given by a parametric model and the random
component is often described as error associated with the data.

data = model + error

The model is a function of the independent (predictor) variable and one or
more coefficients. The error represents random variations in the data that
follow a specific probability distribution (usually Gaussian). The variations
can come from many different sources, but are always present at some level
when you are dealing with measured data. Systematic variations can also
exist, but they can lead to a fitted model that does not represent the data well.

The model coefficients often have physical significance. For example,
suppose you have collected data that corresponds to a single decay mode of a
radioactive nuclide, and you want to estimate the half-life (', ,) of the decay.
The law of radioactive decay states that the activity of a radioactive substance
decays exponentially in time. Therefore, the model to use in the fit is given by

—ht
Y = ¥pe

where y, is the number of nuclei at time ¢ = 0, and A is the decay constant.
The data can be described by
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Both y, and A are coefficients that are estimated by the fit. Because
= 1n(2)/}, the fitted value of the decay constant yields the fitted half-life.

—At
data = ype ~ +error

However, because the data contains some error, the deterministic component
of the equation cannot be determined exactly from the data. Therefore, the

coefficients and half-life calculation will have some uncertainty associated

with them. If the uncertainty is acceptable, then you are done fitting the data.

If the uncertainty is not acceptable, then you might have to take steps to
reduce it either by collecting more data or by reducing measurement error
and collecting new data and repeating the model fit.

In other situations where there is no theory to dictate a model, you might also

modify the model by adding or removing terms, or substitute an entirely

different model.

Library Models

Curve Fitting Toolbox parametric library models are described below.

“Exponentials” on page 2-51
“Fourier Series” on page 2-52
“Gaussian” on page 2-52
“Polynomials” on page 2-53
“Power Series” on page 2-54
“Rationals” on page 2-54
“Sum of Sines” on page 2-55

“Weibull Distribution” on page 2-55

Exponentials. The toolbox provides a one-term and a two-term exponential
model.
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Exponentials are often used when the rate of change of a quantity is
proportional to the initial amount of the quantity. If the coefficient associated
with e is negative, y represents exponential decay. If the coefficient is positive,
y represents exponential growth.

For example, a single radioactive decay mode of a nuclide is described by a
one-term exponential. a is interpreted as the initial number of nuclei, b is the
decay constant, x is time, and y is the number of remaining nuclei after a
specific amount of time passes. If two decay modes exist, then you must use
the two-term exponential model. For each additional decay mode, you add
another exponential term to the model.

Examples of exponential growth include contagious diseases for which a cure
1s unavailable, and biological populations whose growth is uninhibited by
predation, environmental factors, and so on.

Fourier Series. The Fourier series is a sum of sine and cosine functions
that is used to describe a periodic signal. It is represented in either the
trigonometric form or the exponential form. The toolbox provides the
trigonometric Fourier series form shown below,

n
y =ag+ z a;cos(nwx) + b, sin(nwx)
i=1
where a, models a constant (intercept) term in the data and is associated with

the i = 0 cosine term, w is the fundamental frequency of the signal, n is the
number of terms (harmonics) in the series, and 1 =n < 8.

For more information about the Fourier series, refer to “Fourier Transforms”
in the MATLAB documentation.

Gaussian. The Gaussian model is used for fitting peaks, and is given by
the equation
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where a 1s the amplitude, b is the centroid (location), ¢ is related to the peak
width, n is the number of peaks to fit, and 1 =n < 8.

Gaussian peaks are encountered in many areas of science and engineering.
For example, line emission spectra and chemical concentration assays can be
described by Gaussian peaks.

Polynomials. Polynomial models are given by
n+1 1
n + —1
y= ) px
i=1

where n + 1 is the order of the polynomial, n is the degree of the polynomial,
and 1 =7 =< 9. The order gives the number of coefficients to be fit, and the
degree gives the highest power of the predictor variable.

In this guide, polynomials are described in terms of their degree. For example,
a third-degree (cubic) polynomial is given by

3 2
V = P1X + PgX +PaX+ py

Polynomials are often used when a simple empirical model is required. The
model can be used for interpolation or extrapolation, or it can be used to
characterize data using a global fit. For example, the temperature-to-voltage
conversion for a Type J thermocouple in the 0° to 760° temperature range is
described by a seventh-degree polynomial.

Note If you do not require a global parametric fit and want to maximize the
flexibility of the fit, piecewise polynomials might provide the best approach.
Refer to “Nonparametric Fitting” on page 2-94 for more information.

The main advantages of polynomial fits include reasonable flexibility for
data that is not too complicated, and they are linear, which means the fitting
process is simple. The main disadvantage is that high-degree fits can become
unstable. Additionally, polynomials of any degree can provide a good fit
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within the data range, but can diverge wildly outside that range. Therefore,
you should exercise caution when extrapolating with polynomials. Refer

to “Determining the Best Fit” on page 2-8 for examples of good and poor
polynomial fits to census data.

Note that when you fit with high-degree polynomials, the fitting procedure
uses the predictor values as the basis for a matrix with very large values,
which can result in scaling problems. To deal with this, you should normalize
the data by centering it at zero mean and scaling it to unit standard deviation.
You normalize data by selecting the Center and scale X data check box on
the Fitting GUL.

Power Series. The toolbox provides a one-term and a two-term power
series model.

b
Yy =ax

N a+bx

Power series models are used to describe a variety of data. For example, the
rate at which reactants are consumed in a chemical reaction is generally

proportional to the concentration of the reactant raised to some power.

Rationals. Rational models are defined as ratios of polynomials and are

given by
n+1l
n+l1-i
2 P
W o 1=1
Y= m _
xm_i_ Zqixm—n
i=1

where n is the degree of the numerator polynomial and 0 < 12 < 5, while m
is the degree of the denominator polynomial and 1 < m < . Note that the
coefficient associated with x” is always 1. This makes the numerator and
denominator unique when the polynomial degrees are the same.
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In this guide, rationals are described in terms of the degree of the
numerator/the degree of the denominator. For example, a quadratic/cubic
rational equation is given by

2
plx + p2I+ pa

3 2
X +Q1I +q2x+q3

Like polynomials, rationals are often used when a simple empirical model
is required. The main advantage of rationals is their flexibility with data
that has complicated structure. The main disadvantage is that they become
unstable when the denominator is around zero. For an example that uses
rational polynomials of various degrees, refer to “Example: Rational Fit”
on page 2-82.

Sum of Sines. The sum of sines model is used for fitting periodic functions,
and is given by the equation

n
N = Z a;sin(b.x +¢;)
i=1

where a is the amplitude, b is the frequency, and c is the phase constant for
each sine wave term. 7 is the number of terms in the seriesand 1 <n < 8.
This equation is closely related to the Fourier series described previously. The
main difference is that the sum of sines equation includes the phase constant,
and does not include a constant (intercept) term.

Weibull Distribution. The Weibull distribution is widely used in reliability
and life (failure rate) data analysis. The toolbox provides the two-parameter
Weibull distribution

-1 —ax®
v =abx e

where a is the scale parameter and b is the shape parameter. Note that there
is also a three-parameter Weibull distribution with x replaced by x — ¢ where
¢ is the location parameter. Additionally, there is a one-parameter Weibull
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distribution where the shape parameter is fixed and only the scale parameter
1s fitted. To use these distributions, you must create a custom equation.

Curve Fitting Toolbox software does not fit Weibull probability distributions
to a sample of data. Instead, it fits curves to response and predictor data such
that the curve has the same shape as a Weibull distribution.

Custom Models

e “Custom Models vs. Library Models” on page 2-56

® “Creating Custom Models” on page 2-56

¢ “Editing and Saving Custom Models” on page 2-60

¢ “Example: Legendre Polynomial” on page 2-62

e “Example: Fourier Series” on page 2-68

¢ “Example: Gaussian with Exponential Background” on page 2-74

Custom Models vs. Library Models. If the toolbox library does not contain
a desired parametric equation, you can create your own custom equation.

Library models, however, offer the best chance for rapid convergence. This is
because:

¢ For most library models, optimal default coefficient starting points are
calculated. For custom models, the default starting points are chosen at
random on the interval [0,1].

¢ Library models use an analytic Jacobian; custom models use finite
differencing.

¢ When using the Analysis GUI, library models use analytic derivatives and
integrals if the integral can be expressed in closed form; custom models use
numerical approximations.

Creating Custom Models. Create custom equations with the New Custom
Equation GUI. Open the GUI in one of two ways:

¢ From Curve Fitting Tool, select Tools > Custom Equation.
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® From the Fitting GUI, select Custom Equations from the Type of fit list,
then click the New button.

The GUI contains two panes: one for creating linear custom equations and
one for creating general (nonlinear) custom equations.

Linear Equations

Linear models are linear combinations of (perhaps nonlinear) terms. They
are defined by equations that are linear in the parameters. Use the Linear

Equations pane on the New Custom Equation GUI to create custom linear
equations. Interface controls are described below.

) New custom Equation ———————IelF]

Linear Equations | General Equations |

Independent variable: |><

~Equation
Unknown
Coefficients Terms
y = |a ( fsin(x - pi) )

N

IV Unknown constant coefficient Add a terml Femove |ast terml

Equation: a*(sin - pi))+c

Equation name: |a*(sir‘|(>< - pi))+c

QK | Cancel | Help |
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¢ Independent variable — Symbol representing the independent
(predictor) variable. The default symbol is x.

¢ Equation — Symbol representing the dependent (response) variable,
followed by the linear equation. The default symbol is y.

= Unknown Coefficients — The unknown coefficients to be determined
by the fit. The default symbols are a, b, ¢, and so on.

= Terms — Functions of the independent variable. These may be
nonlinear. Terms may not contain a coefficient to be fitted.

= Unknown constant coefficient — If selected, a constant term
(y-intercept) is included in the equation. Otherwise, a constant term
is not included.

= Add a term — Add a term to the equation. An unknown coefficient is
automatically added for each new term.

= Remove last term — Remove the last term added to the equation.

¢ Equation name — The name of the equation. By default, the name is
automatically updated to be identical to the custom equation given by
Equation. If you override the default, the name is no longer automatically
updated.

General Equations

General models are, in general, nonlinear combinations of (perhaps
nonlinear) terms. They are defined by equations that may be nonlinear
in the parameters. Use the General Equations pane on the New Custom
Equation GUI to create custom general equations. Interface controls are
described below.
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) New Custom Equation———————JRBIEY

Linear Equations ; General Equations |

Independent variable: |><

Equation: |y

= |a*e><p (-b*x)+C

Unknowns | StartPoint Lower Upper
A 0,171 -Irf] INf]
o] 9,65e-03 -Inf Irf]
C 0,404 -Irf] INf]

Equation name: |a*e><p(—b*><)+c

QK | Cancel | Help

¢ Independent variable — Symbol representing the independent

(predictor) variable. The default symbol is x.

¢ Equation — Symbol representing the dependent (response) variable,
followed by the general equation. The default symbol is y. As you type in

the terms of the equation, the unknown coefficients, associated starting

values, and constraints automatically populate the table. By default,

the starting values are randomly selected on the interval [0,1] and are
unconstrained.

You can immediately change the default starting values and constraints in
this table, or you can change them later using the Fit Options GUI.

¢ Equation name — The name of the equation. By default, the name is
automatically updated to be identical to the custom equation given by
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Equation. If you override the default, the name is no longer automatically
updated.

Note If you use the General Equations pane to define a linear equation, a
nonlinear fitting procedure is used. While this is allowed, it is inefficient, and
can result in less than optimal fitted coefficients. Use the Linear Equations
pane to define custom linear equations.

Editing and Saving Custom Models. When you click OK on the New
Custom Equation GUI, the displayed Equation name is saved for the
current session in the Custom Equations list on the Fitting GUI. The list is
highlighted in the picture of the Fitting GUI below.



Fitting Data

Fit Editor

Mew fit | Copy fit |

Fit name:  [fit 1

Data set: ﬂ Exclusion rule: I(HDHE) "I

Type of fit: | Custom Equations Ll ™ Center and scale ¥ data

-Custom Equations
Mew
Edit
Copy and Edit
Delete
Fit options... [ Immediate apply ~ Cancel | Apply |

Results
Click "Rpply" to save the changes to the fit.

4 [*]
Table of Fits
@ Fitname Data set Equation name SSE R...
|@ ffit 1 (none) MaM MaM
Delete fit Save to workspace. .. Table options... |
Close | Help |
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To edit a custom equation, select the equation in the Custom Equations list
and click the Edit button. The Edit Custom Equation GUI appears. The
Edit Custom Equation GUI is identical to the New Custom Equation GUI,
but i1s pre-populated with the selected equation. After editing an equation

in the Edit Custom Equation GUI, click OK to save it back to the Custom
Equations list for further use in the current session. A button to Copy
and Edit is also available, if you want to save both the original and edited
equations for the current session.

To save custom equations for future sessions, select the File > Save Session
menu item in Curve Fitting Tool.

Example: Legendre Polynomial. This example fits data using several
custom linear equations. The data is generated, and is based on the nuclear
reaction 2C(e,e’a)®Be. The equations use sums of Legendre polynomial terms.

Consider an experiment in which 124 MeV electrons are scattered from 2C
nuclei. In the subsequent reaction, alpha particles are emitted and produce
the residual nuclei ®Be. By analyzing the number of alpha particles emitted as
a function of angle, you can deduce certain information regarding the nuclear
dynamics of 12C. The reaction kinematics are shown below.

e is the incident electron.

12¢is the corbon furget.

f is the momentum trunsferred to *Be.
g' is the scottered electron,

coisthe emitted olpho porticle.
_ B, is the electron scottering ongle.

B, is the ulpho seottering ongle.

The data is collected by placing solid state detectors at values of ® _ ranging
from 10° to 240° in 10° increments.

It is sometimes useful to describe a variable expressed as a function of angle
in terms of Legendre polynomials



Fitting Data

y(x) = Y a,P (x)
n=10

where P_(x) is a Legendre polynomial of degree n, x is cos(0®,), and a, are the
coefficients of the fit. Refer to the legendre function for information about
generating Legendre polynomials.

For the alpha-emission data, you can directly associate the coefficients with
the nuclear dynamics by invoking a theoretical model. Additionally, the
theoretical model introduces constraints for the infinite sum shown above.

In particular, by considering the angular momentum of the reaction, a
fourth-degree Legendre polynomial using only even terms should describe the
data effectively.

You can generate Legendre polynomials with Rodrigues’ formula:

Po) = —(7) o -1

The Legendre polynomials up to fourth degree are given below.

Legendre Polynomials up to Fourth Degree

P.(x)
1

x
(1/2)(3x%— 1)
(1/2)(5x3 — 3x)
(1/8)(35x% — 3022 + 3)

A|lw|olr|lols

The first step is to load the 2C alpha-emission data from the file
carboni2alpha.mat, which is provided with the toolbox.

load carboni2alpha
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The workspace now contains two new variables, angle and counts:

® angle is a vector of angles (in radians) ranging from 10° to 240° in 10°
increments.

® counts 1s a vector of raw alpha particle counts that correspond to the
emission angles in angle.

Import these two variables into Curve Fitting Tool and name the data set
C12Alpha.

The Fit Editor for a custom equation fit type is shown below.

<) Fitting =]

Fit Editor

e fit | Copy fit |

Fit Mame: |Leg4E\ren

Specify a meaningful it name,

the data set, and the type of fit.

Data set: |C12Alpha j Exclusion rule:  |{nane) -

Type of fit: |Cust0m Equations j [ Center and scale ¥ data

~Custam Egquation

Open the Create Custom
Equations GUI.

FPress "Mew Equation” to create a custom eguation. Mews equation. ..

Copy equation

Delete equation

Fit options... | Efimmediate apply Cancel | Apply |

Results

Fit the data using a fourth-degree Legendre polynomial with only even terms:
1 ) 1 4 2,
yilx) = apg+ ag[ij(ﬂx -1)+ ad__[ﬁj(ﬂﬁx —30x" +3)

Because the Legendre polynomials depend only on the predictor variable
and constants, you use the Linear Equations pane on the Create Custom
Equation GUI. This pane is shown below for the model given by y,(x). Note
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that because angle is given in radians, the argument of the Legendre terms is
given by cos(0,).

<} Create Custom Equation ;Iglil

Linear Equations | General Equations |

Independent variahle: E

~Equation
Unknown |
Coefficients Termns
b = fa2 # iz eosiea-1) ) (reafe a custom linear equation
+ o ( [7EF (35 cos 60 e 30 cos 602+ ) ) using even Legendre terms up

N to fourth degree.
=
v Unknown caonstant coefficient Add aterm I Femove last term |

Equation: A2 I 00 2-10+ad* (178" (35 cos (0™ -30% cos (g 2+ 3 +al

___ Spedly a meaningful

Equation name: |Leg4Even !
equation name.

Ok | Cancel | Help |
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The fit and residuals are shown below. The fit appears to follow the trend of

the data well, while the residuals appear to be randomly distributed and do
not exhibit any systematic behavior.

<) Curve Fitting Tool (O] %]

File “iewy Toolz ‘Whdow Help

2 & & H

Dets... |

Exclude... | Plotting. .. | Analysis. |

Data and Fits
T T

+  GCizalpha
LegdEven

The numerical fit results are shown below. The 95% confidence bounds
indicate that the coefficients associated with P,(x) and P,(x) are known fairly
accurately, but that the P,(x) coefficient has a relatively large uncertainty.

Results

Linear model: 1=
£ix) = a2t (1/2)% (3¥cos(x)*2-1] + ads[1/8)%

Coefficients (with 95% confidence bounds): The (oef‘ficienisnssociuiedwilh Pﬂ()()ﬂl'ld
az 23.86 [4.436, 43.29)
ad 201.9  (180.2, 223.6) P4x)are known accurately, butthe Po(x)

0 1028 195,21, 1251 coefficient has o larger uncertainty.

Goodness of fit:
S3E: 7968
R-square: 0.9665
Adjusted R-sguare: 0.9637

FMSE: 19.48 =
1| | _’I_I
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To confirm the theoretical argument that the alpha-emission data is best
described by a fourth-degree Legendre polynomial with only even terms, fit
the data using both even and odd terms:

Volx) = yq(x)+aqx+ aa[%j(ﬁxa —3x)

The Linear Equations pane of the Create Custom Equation GUI is shown
below for the model given by y,(x).

~) Create Custom Equation =101 x|
unearEquaﬁnnsl GeneraIEquaﬁonsl
Independentuariable: f
~Equation
LumnLEe e &)
I = 2 * sz (3costin2- 1) )
+ a4 * Ji108r (35 e 050t 4-30 s (2 +3) ) Creale a custom linear equation
+ [t +{ feostn ) using even and odd Legendre
- (12 5vr0s 6a-Trust) ylL terms up fo fourth degree.
N qld
[¥ Unknown constant coefiicient ’W Remove last term | (|l(|( Add o term fo ndd the O‘H
Legendre terms.
Equation BZHIZI (IR C0S (0P 2-1 1)+ ad (1 B) 35 Cos (M- 30705 (9" 2+ ) +a1 .. Speci inahul
Enuation name: |Leg4EvenOdd e ez::llf[?;: :Len::mg v
QK | Cancel | Help |

The numerical results indicate that the odd Legendre terms do not contribute
significantly to the fit, and the even Legendre terms are essentially unchanged
from the previous fit. This confirms that the initial model choice is the best
one.

Resulis

Linear model: =
fix)] = a2#(1/2)%(3%cos(x)"2-1) + ad*(l/8)*
Coefficients (with 95% confidence bounds):
a2 24.19 (3.291, 45.1)

The odd Legendre coefficients ore likely

ad = 201.5 (177.6, 225.5) . L .
al = 1.837 {-12.89, 16.56) condidotes for removal to simplify the fit
ad = 1.2l (-2z.52, 20.1] becouse their values are small and their
al = 103.1 (92.71, 1ll3.86)

confidence bounds contuin zero.
Goodness of £it:
S8E: 7940
R-scuare: 0,9669
Adjusted R-zgquare: 0.98
RMSE: 20.44

4] |

Fle |
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Example: Fourier Series. This example fits the ENSO data using several
custom nonlinear equations. The ENSO data consists of monthly averaged
atmospheric pressure differences between Easter Island and Darwin,
Australia. This difference drives the trade winds in the southern hemisphere.

As shown in “Example: Smoothing Data” on page 2-32, the ENSO data is
clearly periodic, which suggests it can be described by a Fourier series

X . x
y(x) = ap+ Z aims(ﬂngj + bism(ﬂﬂ:;)

i= I I

where a; and b, are the amplitudes, and c; are the periods (cycles) of the data.
The question to be answered in this example is how many cycles exist? As

a first attempt, assume a single cycle and fit the data using one sine term
and one cosine term.

x . x
y1lx) = ag +a1ms(2nc—1) +by sm[?nc—l)

If the fit does not describe the data well, add additional sine and cosine terms
with unique period coefficients until a good fit is obtained.

Because there is an unknown coefficient ¢, included as part of the
trigonometric function arguments, the equation is nonlinear. Therefore, you
must specify the equation using the General Equations pane of the Create
Custom Equation GUI.
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This pane is shown below for the equation given by y,(x).

) crerecustomeauation S _iix
Linear Equations General Equations |
Independent variatle: F{
Equation: [y = [aovat cos @ pinuc b1 *sinz pic) — Begin with a single cycle.
Unknowns | StartPaint Lawer Upper . o
- i By default, the coefficients are
al 0.961 Inf In
al 0.852 I Inf unbounded and have random
o1 0.368 mll In slarfing values between O and 1.
¢ 0.547 I Inf
Specify a meaningful
Equation name: IEnsm Period pe l:y L
equafion nome.
OK | Cancel | Help |

Note that the toolbox includes the Fourier series as a nonlinear library
equation. However, the library equation does not meet the needs of this
example because its terms are defined as fixed multiples of the fundamental
frequency w. Refer to “Fourier Series” on page 2-52 for more information.

The numerical results shown below indicate that the fit does not describe
the data well. In particular, the fitted value for c1 is unreasonably small.
Because the starting points are randomly selected, your initial fit results
might differ from the results shown here.

Results

General model: =
fix) = al+al*cos(2¥pi*x/cl)+bl¥sin(2%pi*xscl)

Coefficients (with 95% confidence bounds):
al = 10.64 (10.12, 11.17)
al -0.06473  [-1.548, 1.418)
bl 0.3578 (-0.4135, 1.129)
cl 0.6402 (0.6374, 0.643)

Goodness of fit:
S5E: 1952
B-square: 0.005695
Adjusted R-sgquare: -0.01249 —
RM3E: 3.45

As you saw in “Example: Smoothing Data” on page 2-32, the data include
a periodic component with a period of about 12 months. However, with c1
unconstrained and with a random starting point, this fit failed to find that
cycle. To assist the fitting procedure, constrain ¢1 to a value between 10 and
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14. To define constraints for unknown coefficients, use the Fit Options GUI,
which you open by clicking the Fit options button in the Fitting GUI.

<) Fit Options for custom: Ensol ' ﬂ
Method: MonlinearLeastSquares
Robust: jor =l
Algarithm: |Trust—Regi0n LI
DifMinChange: | 1.0E-8
DiffaxChange: | 0.1
MaxFunEvals: | 600
Maxlter: | 400
TalFun: | 1.0E-6
Tal: | 1.0E-6
Unknowns| StartPoint|  Lower Upper
al 5.000 -Inf| Inf|
al 0.3145 -Inf| Inf|
b1 0.700 cIn In Constrain the cyde fo be
cl 0.642 10.000 14.000| | ——
between 10 and 14 months,

Help |
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The fit, residuals, and numerical

results are shown below.

-} Curve Fitting Tool =10 x|
File View Tools Window Help
g ® 2ls |5k
Data... | Fitting... | Exclude... Flotting... Analyzis... |
Data and Fits
* . . ..... + enso
Lin . e | — EnzolPeriod ]
1 \/\-)/ \j ] L The fit for one cycle.
+ A ¢
5k - ot L. s, ‘. ]
D C 1 1 1 1 1 1 hd 1 1 b
0 20 40 =il a0 100 120 140 160
Residuals
107 T T T T T T T
.|+ EnsolPeriod
st . . ..
ST s R R The residuaks indicate that at
I A Y A Jol T AN — .
O 0o ol AR AR least one more cycle exists.
TV e .t IR v e .t
. - . . .°
Results
_1D [l 1 1 1 1 1 . -
o0 40 50 a0 100 General model: =

fix) = al+al*cos(Z*pi*xscl)+bl*sin(Z*%pi*x/cl)
Coefficients (with 95% confidence bounds):
al = 10.63 (10.22, 11.03) -
al = 2,876 (2.187, 3.565)
The numerical results bl = 1.176 (0.09147, 2.261)
cl = 11.94 (1l.85, 12.03)

indicate a 12 month cycle.

The fit appears to be reasonable for some of the data points but clearly does
not describe the entire data set very well. As predicted, the numerical results
indicate a cycle of approximately 12 months. However, the residuals show a
systematic periodic distribution indicating that there are additional cycles
that you should include in the fit equation. Therefore, as a second attempt,
add an additional sine and cosine term to y,(x)

x . x
Volx) = 31(1:""52‘305[2“(_.—2)"' bzsm[ﬂnc—z)
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and constrain the upper and lower bounds of ¢, to be roughly twice the bounds

used for c;.

The fit, residuals, and numerical

results are shown below.
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-} Curve Fitting Tool =101 x|
File View Tools Window Help
|&|® 2|2
Data... | Fitting... | Exclude... Flotting... Analyziz... |
Data and Fits
* . + o [+ enso
15 . . » ;o . ‘s| — Enso2Period [
. S, Ry ._U\
10F iy d . RERY 1 .
i . A . L The fit for two cycles.
- - .. - -
5L - e . ., s J
Dl’ 1 1 1 1 1 1 hd 1 1 b
] 20 40 G0 a0 100 120 140 160
Residuals
10 T T T T T T T T
+  Enso2Period
&
& * ;¢ c o 1 . e
. . ST S e The residuals indicate that
A I . . * . ey + * Y N N
L . .t e ,_ .
N ALY one more cyce might exist
L . . o T e T e, o .
sl LN . . . . 1
4+
Results
_10 [l 1 1 1 1 1
20 40 B0 80 100 | |General model: =
fix) = al+al*cos(2%pi*x/cli+bl*sin(2%pi*x/cl)+
Coefficients (with 95% confidence bhounds):
al = 10,59 (10.2, 10.99)
al = 2,865 (2.172, 3.557)
az = -0.8126 (-1.567, -0.05857) -
bl = 1.282 (0.223, 2.341)
bz = 0.5006 (-0.4819, 1.483)
The numerical results indicate cl = 11,93 (11.85, 12.02)
cZ = 21.86 (20.95, 22.76)

an additional 22 month cycle.

i of

The fit appears to be reasonable for most of the data points. However, the
residuals indicate that you should include another cycle to the fit equation.
Therefore, as a third attempt, add an additional sine and cosine term to y,(x)
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X . x
Va(x) = ¥qo(x) +agycos 211:(3—3.]+ b,sin 211:(.‘—3-]

and constrain the lower bound of ¢, to be roughly three times the value of c;.

The fit, residuals, and numerical results are shown below.

.} Curve Fitting Tool ;Iglll

File View Tools Window Help
&l 2 ez

Data... | Fitting... | Exclude... | Flotting... | Analyziz... |

Data and Fits

°. . * :.. + enso
L12) .. . | — Enso3Period
* L . o . <o . R 3
10 AN - 1 b U v — The fit for three cycles.
A . ) A
5 - . .o .o s i
D I 1 1 1 1 hd i

1 1 1 1
] 20 40 60 80 100 120 140 160

10 T T T T T T

+  Enso3Period

The residuals appear
—— fairly random for most
of the data set.

S . . Results
General model: 1=
-0 ' L ' ' ’ fix) = al+al*cos(2%pi*xscl)+bl*sin(Z%pi*x/icl)+
0 40 60 80 100 Coefficients (with 25% confidence bounds):
an = 10.52 (10.16, 10.89)
al = 2.804 (2.144, 3.464)
az = -0.7867 (-1.58, 0.006603)
a3 = -1.608 (-2.13, -1.088)
bl = 1.474 (0.5307, 2.418)
b2 = 0.7441 (-0.06543, 1.554) [
b3 = 0.1669 (-0.8447, 1.179)
The numerical results indicate [st- i1.92 (l1.84, 11.33)
cz = 22.04 (21.29, 22.78)
12, 22, and 44 month cycles. L .-

43.56 (4l.64, 45.48) -
4| | »
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The fit 1s an improvement over the previous two fits, and appears to account
for most of the cycles present in the ENSO data set. The residuals appear
random for most of the data, although a pattern is still visible indicating that
additional cycles may be present, or you can improve the fitted amplitudes.

In conclusion, Fourier analysis of the data reveals three significant cycles.
The annual cycle is the strongest, but cycles with periods of approximately 44
and 22 months are also present. These cycles correspond to El Nino and the
Southern Oscillation (ENSO).

Example: Gaussian with Exponential Background. This example fits
two poorly resolved Gaussian peaks on a decaying exponential background
using a general (nonlinear) custom model. To get started, load the data from
the file gauss3.mat, which is provided with the toolbox.

load gauss3
The workspace now contains two new variables, xpeak and ypeak:

® xpeak is a vector of predictor values.

® ypeak is a vector of response values.

Import these two variables into Curve Fitting Tool and accept the default data
set name ypeak vs. xpeak.

You will fit the data with the following equation

_E.u; ;l.b 1]2 _[.1; :E ]3

-bx
yix) = ae +aqe +age

where a, are the peak amplitudes, b, are the peak centroids, and c; are related
to the peak widths. Because there are unknown coefficients included as part
of the exponential function arguments, the equation is nonlinear. Therefore,
you must specify the equation using the General Equations pane of the Create
Custom Equation GUI. This pane is shown below for y(x).



Fitting Data

<} Create Custom Equation : ;Iglll

Linear Equations  General Equations |

Independent variahle: &

Two Gaussian peaks on an

Equation: = |a*expi-h&g+al exp-(Ge-b1 e +a2%exp - 20c )42 _ .
4 b oo PR TIET) P DIED) exponential background.

Unknowns | StartPoint Lower Upper
a 0.167 -Inif| Irtf
al 0.809 -Inf| Irtf
a2 0523 -Inf In] By defuuh, the coefficients are
b 0.744 -Infl Inf| unbounded and have random
b1 0.105 -Inf| Irtf .
b2 0.204 i nf starting values between O and 1.
ol 0173 -Inf| Irtf
o2 0.345 -Inf| Irtf

Equation name: IGaussEExm
Ok | Cancel I Help |
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-} Curve Fitting Tool
File ‘Wiew Tools

Window  Help

The data, fit, and numerical fit results are shown below. Clearly, the fit is
poor.

i =10l ]

g ® 2|12k

[rata... | Fitting... | Exclude... | Flotting... | Analyziz... |

180
160
140
120
100
80
60
40
20

+  ypeak vs xpeak |7
— GaussZExpl

Results

Fit cowputation did not conwverge: =
Maximum number of function evaluations exceeded. Increasing
MaxFunEvals (in fit options) may allow for a better £it, or
the current ecquation may not be a good model for the data.

Fit found when optimization terminated:

General model:

fix) = a*expi-b¥x)4+al%exp(-(ix-bl]/cl)*2]+a2%expi-i (>
Coefficients (with 95% confidence bounds):

a = 495,2 (-Inf, Inf)

al = 0.8086 (-Inf, Inf)

az = -323.8 (-Inf, Inf) 1
b = 0.01304 (-Inf, Inf)

bl = 0.1053  {-Inf, Inf)

bz = -Z.094 (-Inf, Inf)

cl 0.1733 (-Inf, Inf)

oz = -7z.89 (-Inf, Inf) =
4| | »

Because the starting points are randomly selected, your initial fit results
might differ from the results shown here.

The results include this warning message.
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Fit computation did not converge:

Maximum number of function evaluations exceeded. Increasing
MaxFunEvals (in fit options) may allow for a better fit, or
the current equation may not be a good model for the data.

To improve the fit for this example, specify reasonable starting points for
the coefficients. Deducing the starting points is particularly easy for the
current model because the Gaussian coefficients have a straightforward
interpretation and the exponential background is well defined. Additionally,
as the peak amplitudes and widths cannot be negative, constrain a,, a,, ¢,,

and c, to be greater then zero.

To define starting values and constraints for unknown coefficients, use the
Fit Options GUI, which you open by clicking the Fit options button. The
starting values and constraints are shown below.

<} Fit Dptions for custom: Gauss 1[
Method: MonlinearLeastSguares

Robust: jort =
Algarithim: |Trust—Regi0n LI
DiftinChange: | 1.0E-8
DifaxChange: | 01
MaxFunEvals: | 600
Maxiter: | 400
TalFun: | 1.0E-6
Tolx: | 1.0E-6
Unknowns| StartPaint Lower Upper
a 100.000 -Inf] Inf]
al 100.000 1] 1f]
al g0.000 1] Inf]
b 1.00e-01 -Inf] Inf]
b1 110.000 -Inf] Inf]
b2 140.000 -Inf] Inf]
cl 20,000 a Inif]
c2 20.000 1] 1]

o |

Specify reasonable coefficient
starting values and constraints.

2-77



Interactive Curve Fitting

2-78

The data, fit, residuals, and numerical results are shown below.

-} Curve Fitting Tool

File View Tools Window Help

=1ol]

g ® 2|2k

[rata... | Fitting... | Exclude... | Flotting... | Analyziz... |

120

ypeak vs. xpeak
— Gauss2Expl

0 a0 100 150

Specifying Fit Options

¢ “Introduction” on page 2-79

Results
General model: 1=
fix) = avexpi-b¥x)+al%exp(-((x-bl)/cl)*2]+az¥exp
Coefficients (with 95% confidence bounds):
a = 95,94  (97.9, 99.98)
al = lo0.7  (99.09, 102.3)
az = 73,71 (71.32, 76.09)
b = 0.01085  (0.0107, 0.0111%9)
bl = 11l.6 {l10.9, 112.3)
bz = 147.8 (147, 148.6)
cl = 23.3  (22.58, 24.02)
cz = 192,67 (l8.92, 20.41)

Goodness of firt:
35E: 1244
R-square: 0.9969
Adjusted B-scquare:
RMZE: Z.Z263

4 |

0.9965

¢ “Fitting Method and Algorithm” on page 2-79
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e “Finite Differencing Parameters” on page 2-80

e “Fit Convergence Criteria” on page 2-81

e “Coefficient Parameters” on page 2-81

Introduction. You specify fit options with the Fit Options GUI. The fit

options for the single-term exponential are shown below. The coefficient
starting values and constraints are for the census data.

<) Fit Dptions for expl x|
Method: MonlinearLeastSquares -
DS |off =I'| |- Fiiting method and algorithm
Algarithm: |Trust—RegiDn j
DifinChange: 10E8 | | pow e .
! — Finite dlﬁerencmg parameters
CifaxChanoe: | o1 ) _
MaxFunEvals: | 600
Maxitar: | 400 . _
— Fit convergence criteria
TalFun; | 1.0E-6
Tal; | 1.0E-6 | _|
Lnknowns| StadPoint| Lower Upper 7]
a 304815 -Inf ini | | Coefficient parameters
b 1.81e-02 -Inf Inf]

The available GUI options depend on whether you are fitting your data using
a linear model, a nonlinear model, or a nonparametric fit type. All the options
described below are available for nonlinear models. Method, Robust, and
coefficient constraints (Lower and Upper) are available for linear models.
Interpolants and smoothing splines include Method, but no configurable
options.

Fitting Method and Algorithm.

¢ Method — The fitting method.
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The method is automatically selected based on the library or custom model
you use. For linear models, the method is LinearLeastSquares. For
nonlinear models, the method is NonlinearLeastSquares.

* Robust — Specify whether to use the robust least-squares fitting method.
The values are

= Off — Do not use robust fitting (default).
= On — Fit with default robust method (bisquare weights).
= LAR — Fit by minimizing the least absolute residuals (LAR).

Bisquare — Fit by minimizing the summed square of the residuals,
and down-weight outliers using bisquare weights. In most cases, this is
the best choice for robust fitting.

® Algorithm — Algorithm used for the fitting procedure:

= Trust-Region — This is the default algorithm and must be used if you
specify coefficient constraints.

= Levenberg-Marquardt — If the trust-region algorithm does not
produce a reasonable fit, and you do not have coefficient constraints, you
should try the Levenberg-Marquardt algorithm.

= Gauss-Newton — This algorithm is included for pedagogical reasons
and should be the last choice for most models and data sets.

Finite Differencing Parameters.

¢ DiffMinChange — Minimum change in coefficients for finite difference
Jacobians. The default value is 108,

¢ DiffMaxChange — Maximum change in coefficients for finite difference
Jacobians. The default value is 0.1.

Note that DiffMinChange and DiffMaxChange apply to

¢ Any nonlinear custom equation — that is, a nonlinear equation that you
write.

® Some, but not all, of the nonlinear equations provided with Curve Fitting
Toolbox software.
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However, DiffMinChange and DiffMaxChange do not apply to any linear
equations.

Fit Convergence Criteria.

e MaxFunEvals — Maximum number of function (model) evaluations
allowed. The default value is 600.

¢ MaxIter — Maximum number of fit iterations allowed. The default value
is 400.

¢ TolFun — Termination tolerance used on stopping conditions involving
the function (model) value. The default value is 107,

¢ TolX — Termination tolerance used on stopping conditions involving the
coefficients. The default value is 10,

Coefficient Parameters.

¢ Unknowns — Symbols for the unknown coefficients to be fitted.

¢ StartPoint — The coefficient starting values. The default values depend
on the model. For rational, Weibull, and custom models, default values are
randomly selected within the range [0,1]. For all other nonlinear library
models, the starting values depend on the data set and are calculated
heuristically.

¢ Lower — Lower bounds on the fitted coefficients. The bounds are used
only with the trust region fitting algorithm. The default lower bounds for
most library models are -Inf, which indicates that the coefficients are
unconstrained. However, a few models have finite default lower bounds.
For example, Gaussians have the width parameter constrained so that it
cannot be less than 0.

e Upper — Upper bounds on the fitted coefficients. The bounds are used
only with the trust region fitting algorithm. The default upper bounds
for all library models are Inf, which indicates that the coefficients are
unconstrained.

For more information about these fit options, refer to the Optimization
Toolbox documentation.
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The default coefficient starting points and constraints for library and custom
models are given below. If the starting points are optimized, then they are
calculated heuristically based on the current data set. Random starting
points are defined on the interval [0,1] and linear models do not require
starting points.

If a model does not have constraints, the coefficients have neither a lower
bound nor an upper bound. You can override the default starting points and

constraints by providing your own values using the Fit Options GUI.

Default Starting Points and Constraints

Model Starting Points Constraints
Custom linear N/A None
Custom nonlinear Random None
Exponentials Optimized None
Fourier series Optimized None
Gaussians Optimized >0
Polynomials N/A None
Power series Optimized None
Rationals Random None
Sum of sines Optimized b,>0
Weibull Random a,b>0

Note that the sum of sines and Fourier series models are particularly sensitive
to starting points, and the optimized values might be accurate for only a few
terms in the associated equations.

Example: Rational Fit

This example fits measured data using a rational model. The data describes
the coefficient of thermal expansion for copper as a function of temperature
in degrees kelvin.



Fitting Data

To get started, load the thermal expansion data from the file hahn1.mat,
which 1s provided with the toolbox.

load hahn1
The workspace now contains two new variables, temp and thermex:

® temp is a vector of temperatures in degrees kelvin.

® thermex is a vector of thermal expansion coefficients for copper.

Import these two variables into Curve Fitting Tool and name the data set
CuThermEx.

For this data set, you will find the rational equation that produces the best fit.

As described in “Library Models” on page 2-51, rational models are defined as
a ratio of polynomials

n-1
=p1xn+p2x +. D, 1

y

n n
X +gqx +...+4q,,

where n is the degree of the numerator polynomial and m is the degree of the
denominator polynomial. Note that the rational equations are not associated
with physical parameters of the data. Instead, they provide a simple and

flexible empirical model that you can use for interpolation and extrapolation.
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As you can see by examining the shape of the data, a reasonable initial choice
for the rational model is quadratic/quadratic. The Fitting GUI configured for
this equation is shown below.

-0l =]
Fit Editor
ey fit | Copy fit |
FitName: |Rat22
Data set  |CuThermEx | Exclusion rule:  [inone) -
Type of it [Rational | [T Center and scale X data
Rational
Mumerator Denominator
canstant = |/linear polynomial |
linear palynamial : Begin the fitting process with a
guadratic po cubic polynomial | qUtII‘.II'tIﬁquI.I:ItII‘tIﬁC ruIionul f“
i i Tl 4th deares polvnomial ~
Fit options... | [ Immediate apply Zaricel | ARl |
Results
General model RatiZzZ: 1E5
fix) = (pl*x*Z 4+ p2Z%x + p3) / (242 4+ gql¥x 4+ g2)
Coefficients (with 95% confidence bhounds):
pl = 21.21 (2l.01, Z1.42)
p2 = -876.5 (-948.5, -804.2) —
p3 = 9147 (7620, 1.067=+004)
ql = 23.55 (18.8, 28.3)
q2 = 756.5  (233.4, 1280) -
Table of Fits

MName Data set

CuThermEx |Rational

Delete fit Save towarkspace... | Table options... |

Close |
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The data, fit, and residuals are shown below.

The fit clearly misses

o some of the data.

&
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° LT et ™ indicating a better fitis possible.
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The fit clearly misses the data for the smallest and largest predictor values.
Additionally, the residuals show a strong pattern throughout the entire data
set indicating that a better fit is possible.
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For the next fit, try a cubic/cubic equation. The data, fit, and residuals are
shown below.

J Curve Fitting Tool =10l

File W“iew Tools “Window Help
&l &2 k=E

Data... | Fitting... | Exclude... | Flotting... | Analysis.. |

Data and Fits

CuThermEx
Rat33

The fit exhibits several
—— discontinuities around the
zeros of the denominator.

1 1 1 1 1 1 1 1
100 200 300 400 500 B00 700 800

Residuals
15 T T T T T T T T
1
L]
05T e 4 -
.. N .:‘-.»‘. e
it et 1
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The numerical results shown below indicate that the fit did not converge.

Results

Fit computation did not converge: = E .
Maximum number of iterations exceeded. Increasing MaxIter :I.he‘ f" dld nof (Onverge, w_hICh
(in fit options) may allow for a better fit, or the current - md'“ﬂes thut ”’B mOdeI mlght
eruation may not be a good model for the data. he a poor (hoice for Ihe dﬂﬂ

Fit found when optimization terminated:

General model Rat33:
£ix) = (pl*=x*3 + p2*x*2 + p3*x + p4) /
(%43 + gl*®*2 + g2%% + g3)
Coefficients (with 95% confidence bounds):
pl = 21.2 (20.85, 21.55)

p2 = -888.8 (-2168, 390.4) =
p3 = 1.069e+004 (-3.784e+004, 5.922e+004)

pd = -3.353e+004  (-4.694e+005, 4.023e+005)

ql = 20.82  (-31.13, 72.77)

qz = 1428  (-1804, 4659)

g3 = -2.545:+004  (-5.456e+004, -2337) =
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Although the message in the Results window indicates that you might
improve the fit if you increase the maximum number of iterations, a better
choice at this stage of the fitting process is to use a different rational equation
because the current fit contains several discontinuities. These discontinuities
are due to the function blowing up at predictor values that correspond to

the zeros of the denominator.

As the next try, fit the data using a cubic/quadratic equation. The data, fit,

and residuals are shown below.

-} Curve Fitting Tool

File View Tools Window Help

=10l x|

P
Data... | Fitting... | Exclude... Flotting... Analyziz... |
Data and Fits
of T T T T T T T T
15+ +  CuThermEx H
— Rat32
10 B
5 -
] 1 1 1 1 1 1 1 1 .
100 200 300 400 500 B00 700 800
Residuals
0.4 T T T T T T T T
. .
02f ,* B %]
s . [ T . .
P BT R qe T S . *
Oftom o a0t dtond o0 Java "S0% " o* o ¢ -
£ AT T S e L
a2l - ' - : .
-0.4

1 1 1 1 1 1
100 200 300 400 500 500

1 1
700 800

The fit is well be haved

over the entire data range.

The residuals are
—— randomly scattered
about zero.

The fit is well behaved over the entire data range, and the residuals are
randomly scattered about zero. Therefore, you can confidently use this fit

for further analysis.
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Example: Robust Fitting

This example fits data that is assumed to contain one outlier. The data
consists of the 2000 United States presidential election results for the state of
Florida. The fit model is a first degree polynomial and the fit method is robust
linear least squares with bisquare weights.

In the 2000 presidential election, many residents of Palm Beach County,
Florida, complained that the design of the election ballot was confusing, which
they claim led them to vote for the Reform candidate Pat Buchanan instead
of the Democratic candidate Al Gore. The so-called “butterfly ballot” was
used only in Palm Beach County and only for the election-day ballots for the
presidential race. As you will see, the number of Buchanan votes for Palm
Beach is far removed from the bulk of data, which suggests that the data
point should be treated as an outlier.

To get started, load the Florida election result data from the file
flvote2k.mat, which is provided with the toolbox.

load flvote2k

The workspace now contains these three new variables:

® buchanan is a vector of votes for the Reform Party candidate Pat Buchanan.
® bush is a vector of votes for the Republican Party candidate George Bush.

® gore is a vector of votes for the Democratic Party candidate Al Gore.

Each variable contains 68 elements, which correspond to the 67 Florida
counties plus the absentee ballots. The names of the counties are given in
the variable counties. From these variables, create two data sets with the

Buchanan votes as the response data: buchanan vs. bush and buchanan
vs. gore.

For this example, assume that the relationship between the response and
predictor data is linear with an offset of zero.

buchanan votes = (bush votes)(m,)

buchanan votes = (gore votes)(m.)
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m, is the number of Bush votes expected for each Buchanan vote, and m, is
the number of Gore votes expected for each Buchanan vote.

To create a first-degree polynomial equation with zero offset, you must create
a custom linear equation. You create a custom equation using the Fitting GUI
by selecting Custom Equations from the Type of fit list, and then clicking
the New Equation button.

The Linear Equations pane of the Create Custom Equation GUI is shown
below.

<} Create Custom Equation ;|g|5|
Linear Equations | General Equationsl
Independent variahle: l)c—
~Eqguation
Unknown
Coefleients  Terms Create a first-degree
] = Im (e "' polynomial with zero offset.
[ Unknawn constant coefficient Add aterm | Fermove [astterm |
N Clear this check box.
Equation: ()
Equation name: [FaElection —— Assign a meaningful name

QK | Cancel | Help | I‘”I'leet]m:lﬁ()n_

Before fitting, you should exclude the data point associated with the absentee
ballots from each data set because these voters did not use the butterfly
ballot. As described in “Marking Outliers” on page 2-38, you can exclude
individual data points from a fit either graphically or numerically using the
Exclude GUI. For this example, you should exclude the data numerically. The
index of the absentee ballot data is given by

ind = find(strcmp(counties, 'Absentee Ballots'))
ind

68
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The Exclude GUI is shown below.

<) Exclude

Exclugion rule name: IAbsenteeVDtes

=10l

Existing exlusion rules:

~Exclude Points

Checkto exclude paint:

Select data set: Ibuchanan ws. hush VI Exclude graphically |

Index H A

|66 12182 120 -]
Mark the absentee [je? 4994 83 |

v/ 68 158745 i -
votes to be excluded.

~Exclude Section
Exclude X [= -] | Exclude ¥ [»= | |
Exclude [<= -] | Exclude ¥ [== | |

Create exclusion rule |

Copy | ey |

Fenarme | [Uelete I

Close | Help |

The exclusion rule is named AbsenteeVotes. You use the Fitting GUI to

associate an exclusion rule with the data set to be fit.

For each data set, perform a robust fit with bisquare weights using the
FlaElection equation defined above. For comparison purposes, also perform

a regular linear least-squares fit.

You can identify the Palm Beach County data in the scatter plot by using the
data tips feature, and knowing the index number of the data point.

ind
ind =
50
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The Fit Editor and the Fit Options GUI are shown below for a robust fit.

preng -0l x|

Fit Edlitor

ey fit Copy fit

Fithame: |[BELinRob .
= Associate the excluded
Data set: huchananwvs. bush = Exclusion rule: UGN 1] — . .
—— absentee votes with the fit.

Type of it |Custom Equations hd [ Center and scale ¥ data

Custam Equation 1l

FlaElection <) Fit Options for custom: FlaElect x|

Method: LinearLeastSquares

rebust: [N - —— Choose robust fitting
Unknowns | Lower | Upper | with bisquare weights.
Fit options... [ Immediate appl | | -In] Inf]

Open the Fit Options GUI. v |

The data, robust and regular least-squares fits, and residuals for the buchanan
vs. bush data set are shown below.

J Curve Fitting Tool ;Iglll

File “ew Tools “Window Help

|la|# 2|2k

Data... | Fitting... | Exclude. . | Flatting... | Analysiz... |
Data and Fits
5000 T T T T T
AT buchanan vs. bush, point #50 The data ﬁp shows that
i (x=152951, y=3411) l .
ool : Buchanan received 3411
© buchanan vs bush votes in Palm Beach County.
2000 | ~-- BBLinRob
— BBLin
1000
1),
0 05 1 15 2 25
Residuals k3 105
000 ‘ ' . ' : The Palm Beach County
000 residual is very large.
| | — BBLinRob
—— BBLin
1000+

The Miami/Dade County

residual is abo very large.

-1000
0
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The graphical results show that the linear model is reasonable for the majority
of data points, and the residuals appear to be randomly scattered around
zero. However, two residuals stand out. The largest residual corresponds to
Palm Beach County. The other residual is at the largest predictor value, and
corresponds to Miami/Dade County.

The numerical results are shown below. The inverse slope of the robust fit
indicates that Buchanan should receive one vote for every 197.4 Bush votes.

Results

Linear model: <
fix) = n*x

Coefficients (with 95% confidence bounds):
m = 0.005066  (0.004794, 0.005337) j

The data, robust and regular least-squares fits, and residuals for the buchanan
vs. gore data set are shown below.

-} Curve Fitting Tool E =1al x|

File Wiew Tools ‘Window Help
a2z

Data... | Fitting... | Exclude... Flatting.. Analysiz... |

Data and Fits

]
3000 O buchanan vs. gore b
--- BGLinRob

2000

1000

Residuals x 10
4000 v . T T

e The Palm Beach County

residual is very large.

2000

The Miomi/Dade and
- Broward County residuals
are also very large.

-2000
0
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Again, the graphical results show that the linear model is reasonable for the

majority of data points, and the residuals appear to be randomly scattered
around zero. However, three residuals stand out. The largest residual

corresponds to Palm Beach County. The other residuals are at the two largest
predictor values, and correspond to Miami/Dade County and Broward County.

The numerical results are shown below. The inverse slope of the robust fit

indicates that Buchanan should receive one vote for every 189.3 Gore votes.

Results

Linear model:
fix) = n¥x

-

Coefficients (with 95% confidence bhounds):
m = 0.005254 (0.00504, 0.005528) ;I

Using the fitted slope value, you can determine the expected number of
votes that Buchanan should have received for each fit. For the Buchanan
versus Bush data, you evaluate the fit at a predictor value of 152,951. For

the Buchanan versus Gore data, you evaluate the fit at a predictor value of

269,732. These results are shown below for both data sets and both fits.

Expected Buchanan Votes in Palm Beach County

Expected Buchanan

Data Set Fit Votes

Buchanan vs. Bush Ordinary least squares | 814
Robust least squares 775

Buchanan vs. Gore Ordinary least squares | 1246
Robust least squares 1425

The robust results for the Buchanan versus Bush data suggest that Buchanan
received 3411 — 775 = 2636 excess votes, while robust results for the Buchanan
versus Gore data suggest that Buchanan received 3411 — 1425 = 1986 excess

votes.

The margin of victory for George Bush is given by

margin = sum(bush)-sum(gore)
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margin =
537

Therefore, the voter intention comes into play because in both cases, the
margin of victory is less than the excess Buchanan votes.

In conclusion, the analysis of the 2000 United States presidential election
results for the state of Florida suggests that the Reform Party candidate
received an excess number of votes in Palm Beach County, and that this excess
number was a crucial factor in determining the election outcome. However,
additional analysis is required before a final conclusion can be made.

Nonparametric Fitting

® “Introduction” on page 2-94

¢ “Example: Nonparametric Fitting” on page 2-94

Introduction

In some cases, you are not concerned about extracting or interpreting fitted
parameters. Instead, you might simply want to draw a smooth curve through
your data. Fitting of this type is called nonparametric fitting. The Curve
Fitting Toolbox software supports these nonparametric fitting methods:

¢ Interpolants — Estimate values that lie between known data points.

® Smoothing spline — Create a smooth curve through the data. You adjust
the level of smoothness by varying a parameter that changes the curve from
a least-squares straight-line approximation to a cubic spline interpolant.

For more information about interpolation, refer to “Polynomials” and the
interp1 function in the MATLAB documentation.

Example: Nonparametric Fitting

This example fits the following data using a cubic spline interpolant and
several smoothing splines.

X = (4*pi)*[0 1 rand(1,25)];



Fitting Data

y = sin(x) + .2*(rand(size(x))-.5);

As shown below, you can fit the data with a cubic spline interpolant by
selecting Interpolant from the Type of fit list.

ST
Fit Editor

I fit Copy fit
FitMame: |CubicSp
Data set: MoisySine 'l Exclusion rule:  |inone) 'l
Type offit:  |Interpolant 'l [ Center and scale X data

Interpolant

linear
nearest neighbor

shape-preserving

The results shown below indicate that goodness-of-fit statistics are not defined
for interpolants.

Results

Cubic spline interpolant:

fi(x) = piecewize polynomial computed from p
Coefficienta:

p = coefficient structure

Goodness of fit:

S5E: 2.35%9e-033

R-smquare: 1 [
Adjusted R-square: Nall

A cubic spline interpolation is defined as a piecewise polynomial that results
in a structure of coefficients. The number of “pieces” in the structure is one
less than the number of fitted data points, and the number of coefficients for

each piece is four because the polynomial degree is three. The toolbox does
not allow you to access the structure of coefficients.

As shown below, you can fit the data with a smoothing spline by selecting
Smoothing Spline in the Type of fit list.
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Fit Editor

[lew fit | Copy fit |

Fit Mame ISmnntm
Diata set INmsvSine - Exclusion rule I(none) -
Type offit  |Smoothing Spline < [ Center and scale X data

Smoothing Spline
Smoothing Parameter:

& Default The default smoothing
© Bpecity ;l [o-39819 ;l —— parameter i based on
the data set you fit.

The level of smoothness is given by the Smoothing Parameter. The default
smoothing parameter value depends on the data set, and is automatically
calculated by the toolbox after you click the Apply button.

For this data set, the default smoothing parameter is close to 1, indicating
that the smoothing spline is nearly cubic and comes very close to passing
through each data point. Create a fit for the default smoothing parameter and
name it Smooth1. If you do not like the level of smoothing produced by the
default smoothing parameter, you can specify any value between 0 and 1. A
value of 0 produces a linear polynomial fit, while a value of 1 produces a
piecewise cubic polynomial fit that passes through all the data points. For
comparison purposes, create another smoothing spline fit using a smoothing
parameter of 0.5 and name the fit Smooth2.

The numerical results for the smoothing spline fit Smooth1 are shown below.

Results

Smoothing spline: =
fix) = piecewise polynomial computed from p
Smoothing parameter:
p = 0.99919036

Goodness of fir:
S5E: 0.003493
R-smquare: 0.9937
Adjusted R-square: 0.5353
BMZE: 0.02217 j

The data and fits are shown below. The default abscissa scale was increased
to show the fit behavior beyond the data limits. You change the axes limits
with Tools > Axes Limit Control menu item.
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.} Curve Fitting Tool =] 3]

File Wiew Tools wWindow Help
el o2k

Data... | Fitting... | Exclude... Flatting. . Analpsiz... |

< MoisySine
L N - S L CubicZp H
— Smaoothl
=== Smaooth2
. / _ The cubic spline and default
smoothing spline results are
similar for interior points.
D | -
' .
The cubic spline and default
sl . smoothing spline results

diverge at the end poinis.

The default smoothing
parameter produces a /
smoother result than
the interpolant.

Note that the default smoothing parameter produces a curve that is smoother
than the interpolant, but is a good fit to the data. In this case, decreasing
the smoothing parameter from the default value produces a curve that is
smoother still, but is not a good fit to the data. As the smoothing parameter
increases beyond the default value, the associated curve approaches the cubic
spline interpolant.
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Interactive Surface Fitting

¢ “Fitting a Surface” on page 3-2

¢ “Interactive Surface Fitting Examples” on page 3-10

e “Selecting Fit Settings” on page 3-28

¢ “Fitting Multiple Surfaces ” on page 3-35

¢ “Comparing Surface Fits” on page 3-37

® “Generating M-Files and Exporting Fits to the Workspace” on page 3-43
¢ “Working with Sessions” on page 3-48
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Fitting a Surface

In this section...

“Introducing the Surface Fitting Tool” on page 3-2
“How to Fit a Surface” on page 3-3

“Opening the Surface Fitting Tool” on page 3-4
“Selecting Data” on page 3-4

“Refining Your Fit” on page 3-6

“Removing Outliers” on page 3-6

“Selecting Validation Data” on page 3-7

“Exploring and Customizing Plots” on page 3-8

Introducing the Surface Fitting Tool

You can interactively fit surfaces to data and view plots with the flexible and
intuitive Surface Fitting Tool graphical user interface. You can use Surface
Fitting Tool to:

® Create, plot, and compare multiple surface fits

® Use linear or nonlinear regression, interpolation, local smoothing
regression, or custom equations

® View goodness-of-fit statistics, display confidence intervals and residuals,
remove outliers and assess fits with validation data

¢ Automatically generate M-code for fitting and plotting surfaces, or export

fits to workspace for further analysis

The following image shows the Surface Fitting Tool displaying a session with
multiple fits and plots.
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Surface Fitting Tool

Fit name: m | Pobvnamial
input: I" TI Degress: x: |4 w3
Thpt: L = Fiohust; F
T otput: [0 ot [ Certer and scale
Waights:  limore] -
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How to Fit a Surface
The process of fitting a surface to data involves the following steps:

1 “Opening the Surface Fitting Tool” on page 3-4

2 “Selecting Data” on page 3-4



3 Interactive Surface Fitting

3 “Refining Your Fit” on page 3-6

4 “Removing Outliers” on page 3-6

5 “Selecting Validation Data” on page 3-7

6 “Exploring and Customizing Plots” on page 3-8

For instructions demonstrating how to load some example data and create a
surface fit, see “Interactive Surface Fitting Examples” on page 3-10.

For next steps, see also “Fitting Multiple Surfaces ” on page 3-35 and
“Comparing Surface Fits” on page 3-37

Opening the Surface Fitting Tool
Open the Surface Fitting Tool using one of these methods:
* Enter sftool at the MATLAB command line.
® Select from the MATLAB Start menu:
Start > Toolboxes > Curve Fitting > Surface Fitting Tool (sftool)

Next, you are ready to select the data you want to fit to the surface.

Selecting Data

To select data to fit, use the drop-down lists in the Surface Fitting Tool to
select variables for X input, Y input and Z output.

Note To load example data to use in the Surface Fitting Tool, enter load
franke at the command line. See “Franke Data Interactive Surface Fitting
Example” on page 3-10 for more instructions.

You can use the Surface Fitting Tool drop-down lists to select any vector (of
type double) in your MATLAB workspace.
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Fit name: |p-:.|y2

¥ input: IGn ]
¥ input: INE |
Z output: IOT ]
Weights: |(nane] ~|

Similarly you can select any vector (of type double) in your workspace to
use as Weights.

When you select three variables, the Surface Fitting Tool immediately
creates a fit with the default settings. You can turn off Auto fit to avoid
time-consuming refitting for large data sets, by clearing the Auto fit check
box.

[+ Auto fit

it

Note The Surface Fitting Tool uses a snapshot of the data you select.
Subsequent workspace changes to the data have no effect on your surface fits.
If you want to update your fit data from the workspace, change the variable
selection, and then reselect the variable with the drop-down controls.

Troubleshooting Data Problems

If there are problems with the data you select, you see messages in the
Results pane. For example, the Surface Fitting Tool ignores Infs, NaNs, and
imaginary components of complex numbers in the data, and you see messages
in the Results pane in these cases.

If you see the following warning: Duplicate x-y data points detected:
using average of the z values., this means that there are two or more
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data points where the input values (x, y) are the same or very close together.
The default interpolant fit type needs to calculate a unique value at that
point. You do not need do anything to fix the problem, this warning is just for
your information. The Surface Fitting Tool automatically takes the average z
value of any group of points with the same x-y values.

Other problems with your selected data can produce the following error:
Error computing Delaunay triangulation. Please try again with
different data. Some arrangements of data make it impossible for Surface
Fitting Tool to compute a Delaunay triangulation. Three out of the four
surface interpolation methods (linear, cubic, and nearest) require a Delaunay
triangulation of the data. An example of data that can cause this error is a
case where all the data lies on a straight line in x-y. In this case, Surface
Fitting Tool cannot fit a surface to the data. You need to provide more data in
order to fit a surface.

Refining Your Fit

You can refine your fit, using any of the following optional steps:

® Change fit type and settings. Select GUI settings to use the Surface
Fitting Tool built-in fit types or create custom equations. Built-in fit types
are Interpolant, Polynomial, and Lowess. See “Selecting Fit Settings”
on page 3-28.

¢ Exclude data by removing outliers in the Surface Fitting Tool. See
“Removing Outliers” on page 3-6.

® Select weights. See “Selecting Data” on page 3-4.
® Select validation data. See “Selecting Validation Data” on page 3-7

® (Create multiple fits and you can compare different fit types and settings
side by side in the Surface Fitting Tool. See “Fitting Multiple Surfaces ” on
page 3-35 and “Comparing Surface Fits” on page 3-37.

Removing Outliers

To remove outliers, follow these steps:

1 Select Tools > Exclude Outliers.
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When you move the mouse cursor to the plot, it changes to a cross-hair to
show you are in outlier selection mode.

2 Click a point that you want to exclude in the surface plot or residuals
plot. Alternatively, click and drag to define a rectangle and remove all
enclosed points.

A removed plot point becomes a red star in the plots. If you have Auto-fit
selected, the Surface Fitting Tool refits the surface without the point.
Otherwise, you can click Fit to refit.

3 Repeat for all points you want to exclude.

When removing outliers, it can be helpful to display a 2-D residuals plot for
examining and removing outliers. With your plot cursor in rotation mode
(select Tools > Rotate 3D.) Next, right-click the plot to select X-Y, X-Z, or

Y-Z view. The following image shows an X-Z plot with some outliers removed.

T2

016247 ~

BN 11 = =7 S TR P
Saa

- :
—#  |owess - residuals
: —k  Excluded T3 we b, L

J
4454 375

i

To replace excluded points in the fit, click them again in Exclude Outliers
mode.

Selecting Validation Data
To specify validation data for the currently selected fit, follow these steps:
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1 Select Fit > Specify Validation Data. The Specify Validation Data
dialog box opens.

2 Select variables for X input, Y input, and Z output. You can use these
drop-down lists to select any vector (of type double) in your MATLAB
workspace.

When you select the three variables, the tool calculates validation statistics
(SSE and RMSE) and displays them in the Results pane and the Table
of Fits. For definitions of these statistics, see “Using the Statistics in the
Table of Fits” on page 3-41. Your validation data points display on the
surface plot and residual plot along with the original data.

3 Close the dialog box.

Exploring and Customizing Plots

You can change mouse mode for manipulating plots, customize your view to
show different plots of your fit, and control plot options with the Tools and
View menus. This section describes the options available.

Using Rotation, Data Cursor, and Outlier Exclusion
Use the Tools menu to toggle your mouse mode in your plots:

* Rotate 3D selects click-and-drag rotation mode.

e Data Cursor selects data cursor mode, where you can click points to
display input and output values.

¢ Exclude Outliers selects outlier mode, where you can click points to
remove or include them in your fit. See “Removing Outliers” on page 3-6.

Customizing the Fit Display
To customize your plot display, you can use the Tools menu or the View
menu. See also “Comparing Surface Fits” on page 3-37.

Tools Menu.

¢ Legend toggles display of the Legend on all plots in the currently selected
fit tab.
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® Grid toggles display of the grid on all plots in the currently selected fit tab.

e Surface Prediction Bounds allows you to choose which bounds to
display: None, 90%, 95%, 99%, or Custom., The custom option opens a dialog
box where you can enter the required confidence level.

* Axes Limits opens a dialog box where you can specify upper and lower
bounds for the X and Y axes of plots.

¢ Default Axes Limits returns plots to the default axes limits.
View Menu.

¢ Fit Settings toggles display of the fit controls pane in the currently
selected fit tab (Fit name, inputs, fit type, and so on).

¢ Fit Results toggles the display of the Results pane in the currently
selected fit tab. When you display the Results pane, you can see model
terms and coefficients, goodness-of-fit statistics, and information messages
about the fit.

* Surface Plot toggles display of the surface plot in the currently selected fit
tab. This menu item is disabled if only the surface plot is displayed.

* Residuals Plot toggles display of the residuals plot in the currently
selected fit tab. This menu item is disabled if only the residuals plot is
displayed.

¢ Contour Plot toggles display of the contour plot in the currently selected
fit tab. This menu item is disabled if only the contour plot is displayed.
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Interactive Surface Fitting Examples

In this section...

“Franke Data Interactive Surface Fitting Example” on page 3-10

“Biopharmaceutical Interactive Surface Fitting Example” on page 3-20

Franke Data Interactive Surface Fitting Example

The Surface Fitting Tool provides some example data generated from Franke’s
bivariate test function. This data is suitable for trying various fit settings in
Surface Fitting Tool.

To load the example data and create, compare, and export surface fits, follow
these steps:

1 To load example data to use in the Surface Fitting Tool, enter 1load franke
at the MATLAB command line. The variables x, y, and z appear in your
workspace.

The example data is generated from Franke’s bivariate test function, with
added noise and scaling, to create suitable data for trying various fit
settings in Surface Fitting Tool. For details on the Franke function, see
the following paper:

Franke, R., Scattered Data Interpolation: Tests of Some Methods,
Mathematics of Computation 38 (1982), pp. 181-200.

2 To divide the data into fitting and validation data, enter the following

syntax:
Xv = x(200:293);
yv = y(200:293);
zv = z(200:293);
X = x(1:199);
y = y(1:199);
z = 2z(1:199);

3 To fit a surface using this example data:

3-10
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a Open Surface Fitting Tool. Enter sftool, or select
Start > Toolboxes > Curve Fitting > Surface Fitting Tool
(sftool).

b Select the variables x, y, and z interactively in the Surface Fitting Tool.

Fit name: Iunﬁtleu:l fit1
X input: (none) LI
g —
Z output: [V
¥
Weights: |yv
Z =
Results v
0 Select X input, ¥ input and Z output

Alternatively, you can specify the variables when you enter

sftool(x,y,z) to open Surface Fitting Tool (if necessary) and create a
default fit.

The Surface Fitting Tool plots the data points as you select variables.
When you select x, y, and z, the tool automatically creates a default surface

fit. The default fit is an interpolating surface that passes through the
data points.
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) Surface Fitting Tool ; £ =10l x|
File Tools Fit View Desktop Window Help £ | A X
BODB =0

Fit name: Iuntiﬂed fit 1| I Interpolant ¥ Auto fit

[=
Xinput: Ix j' Method: I Linear LI Hit
¥ input: I‘f' j' ¥ Center and scale Stop
Z output: Iz vl

Weights: |{none) -

Results

Linear interpolant: e [ Juntitled fit 5

flx,v) = piecewise linear su

where x is normalized by m

and where v is normalized b
Coefficents:

p = coefficent structure

Goodness of fit:
S55E; 7.25%e-031
R-square: 1
Adjusted R-square: NaM
RMSE: NaM

1| | »

|| untited fit5 = ‘ ‘|

Table of Fits .- o o o £ (o &
Fit.. 2 [Data  [Fittype [352  [rsquare[DFE  [Adirsq [mmse  [#coeff |validati...|vaiidati.. |validati..|
& unt... [z vs. x, y [inearin... [7.2588... [1 o [Mat [Mal | 193] | | |

£

4 Try a Lowess fit type. Select the Lowess fit type from the drop-down list
in the Surface Fitting Tool.

Interpolant LI
Interpalant

Polynomial

Custom Equation

The Surface Fitting Tool creates a local smoothing regression fit.

5 Try altering the fit settings. Enter 10 in the Span edit box.
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By reducing the span from the default to 10% of the total number of data
points you produce a surface that follows the data more closely. The span
defines the neighboring data points the toolbox uses to determine each
smoothed value.

. . .
y s00 1000 1500 2000 2500 3000
K

6 Edit the Fit name to Smoothing regression.

7 If you divided your data into fitting and validation data in step 2, select
this validation data. Use the validation data to help you check that your
surface is a good model, by comparing it against some other data not used
for fitting.

a Select Fit > Specify Validation Data. The Specify Validation Data
dialog box opens.

b Select the validation variables in the drop-down lists for X input, Y
input, and Z output: xv, yv, and zv.

Review your selected validation data in the plots and the validation
statistics (SSE and RMSE) in the Results pane and the Table of Fits.
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. _ _ . [ Smoathing regression
1% ___________ oo ) G ononssrammcies ® zuysowy
: TV WS, W, Y

y 0 “epp 1000 1500 2000 2500 3000
H

8 Create another fit to compare by making a copy of the current surface fit.
Either select Fit > Duplicate "Smoothing regression”, or right-click the
fit in the Table of Fits, and select Duplicate

The tool creates a new fit figure with the same fit settings, data, and
validation data. It also adds a new row to the table of fits at the bottom.

9 Change the fit type to Polynomial and edit the fit name to Polynomial.

Lowess LI
Interpolant

Polynomial
Custom Equation
Lowess

10 Change the Degrees of x and y to 3, to fit a cubic polynomial in both
dimensions.

11 Look at the scales on the x and y axes, and read the warning message
in the Results pane:

Equation is badly conditioned. Remove repeated data points
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or try centering and scaling.

Select the Center and scale check box to normalize and correct for the
large difference in scales in x and y.

Polynomial ;I
Degrees: x: |3 LI VE |3 LI
Robust: I off LI

Fit Options... |

Normalizing the surface fit removes the warning message from the Results
pane.

12 Look at the Results pane. You can view (and copy if desired):
® The model equation
® The values of the estimated coefficients
® The goodness of fit statistics

¢ The goodness of validation statistics

Linear model Poly33:
f(x,y) = p00 + p10*x + pO1*y + p20*x"2 + p1i1*x*y...
+ p02*y"2 + p30*Xx"3 + p21*x"2*y
+ p12*x*y~2 + p03*y"3
where x is normalized by mean 1977 and std 866.5
and where y is normalized by mean 0.4932 and std 0.29
Coefficients (with 95% confidence bounds):

p00 = 0.4359 (0.3974, 0.4743)
p10 = -0.1375 (-0.194, -0.08104)
po1 = -0.4274 (-0.4843, -0.37086)
p20 = 0.0161 (-0.007035, 0.03923)
p11 = 0.07158 (0.05091, 0.09225)
p02 = -0.03668 (-0.06005, -0.01332)
p30 = 0.02081 (-0.005475, 0.04709)
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p21 = 0.02432 (0.0012, 0.04745)
p12 = -0.03949 (-0.06287, -0.01611)
po3 = 0.1185 (0.09164, 0.1453)

Goodness of fit:
SSE: 4.125
R-square: 0.776
Adjusted R-square: 0.7653
RMSE: 0.1477

Goodness of validation:
SSE : 2.26745
RMSE : 0.155312

13 To export this fit information to the workspace, select Fit > Save to
Workspace. Executing this command also exports other information

such as the numbers of observations and parameters, residuals, and the
fitted model.

You can treat the fitted model as a function to make predictions or evaluate
the surface at values of X and Y. For details see “Exporting a Fit to the
Workspace” on page 3-45.

14 Display the residuals plot to check the distribution of points relative to the

.

surface. Select View > Residuals Plot.

500 1000 1500 2000 2500 3000 |
¥
X
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15 Right-click the residuals plot to select the Go to X-Z view. The X-Z view is
not required, but the view makes it easier to see to remove outliers.

16 To remove outliers, select Tools > Exclude Outliers.

When you move the mouse cursor to the plot, it changes to a cross-hair to
show you are in outlier selection mode.

a Click a point that you want to exclude in the surface plot or residuals
plot. Alternatively, click and drag to define a rectangle and remove all

enclosed points.

A removed plot point displays as a red star in the plots.

I:IE = At T 1 I T
' : —® Falynomial - residuals
— Excluded z vs. %, ¥

Paolynomial - walidation residuals
n . [l 1Y Ca

- il

0 T S S T T E
a00 1000 1500 2000 2500 3000

b If you have Auto-fit selected, the Surface Fitting Tool refits the surface
without the point. Otherwise, you can click Fit to refit the surface.

¢ To return to rotation mode, select Tools > Rotate 3D.

17 To compare your fits side-by-side, use the tile tools. Select
Window > Left/Right Tile, or use the toolbar buttons.
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) surface Fitting Tool : o [=] 3]
File Tools Fit View Desktop Window Help B |
=R=Nx)

Polynomial O a x

Fit name: ISmoDﬂmng regression I Lowess Fit name: IPonnomiaI I Polynomial "
X input: IX ol l Folynomial: lLinear— K input: Ix B I Degrees: x: | 3 vl v |3 |
viout: [y T | s o || et [y =2 off E
Z output: m Robust: I@‘fi Z output: Iz b I ¥ Center and scale

Weights: |(none) = ¥ Center and scale Weights: |(none) b Fit Options. ..
Results Results ey
Locally weighted R Linear model Paly33: 1 Palynaormial
floy) =loweg [ =moothing regression fl,y) =p00 +p *oTws Y
where x is nor| +p12¥y *  Excluded L
and where y ig ® zws wy where x is norm EIGIMS | 25, E i
Coefficents: O Tvus WY,y and where yis O Zvvs. Xy, yy
p = coefficien [ERRTUPPP PP Coeffidents (with 95
poi0 = 0421 |~ 05
Goodness of fit: plo= -0.114
SSE: 2.424 p0l=-0.412;
R-square: 0,8684 p0= 0.014 o..
Adjusted R-squar| pli= 0.067¢
RMSE: 0.117 p02 = -0.029% 4
p3d= 0.016
Goodness of validg | ., p2l= 0.0253 3000
SSE: 1.76692 pl2 = -0.045§ 3
RMSE : 0137102 p03=  0.113 y 0 1000 .
Goodness of fit:
SSE: 3.665 &
R-square: 0.7785 —e p i
s olynomial - residuals
Adjusted R-square 0. b
RMSE: 0.1404 —k Excluded 7 vs_ ¥, y

ial - validation residuals
Goodness of validati kA |
55E: 2.33863
RMSE : 0.157731

~
0.2
-0.4 ' R i oL
i 500 1000 1500 2000
4 3 4 »
X
Smoothing regression = IPonnomiaI ® ‘ﬂ
Table of R ET
Fitname : |Data Fit type SSE R-square DFE Adj R-sg RMSE # Coeff HOr .. f 1 55E i e
[d Smoothi... [z vs. x, v lowess 2.4233 0.8684 177.1000 0.8529 0.1170 21)zv vs. xv, yv |1.7669 0.1371
[l Polynomial [z vs. x, v poly33 3.6655 0.7785 136 0.7678 0. 1404 10(zv vs. xv, yv |2.3386 0.1577
&

18 Review the information in the Table of Fits. Compare goodness of fit
statistics for all fits in your session to determine which is best.

3-18



Interactive Surface Fitting Examples

19 To save your interactive surface fitting session, select File > Save Session.
You can save and reload sessions to access multiple fits. The session file
contains all the fits and variables in your session and remembers your
layout.

20 After interactively creating and comparing fits, you can generate an
M-file for all fits and plots in your Surface Fitting Tool session. Select
File > Generate M-File.

The Surface Fitting Tool creates an M-file from your session and displays
the file in the MATLAB Editor. The file includes all fits and plots in your
current session.

21 Save the file with the default name, createSurfaceFits.m.

22 You can recreate your fits and plots by calling the M-file from the command
line (with your original data or new data as input arguments). In this case,
your original variables still appear in the workspace.

¢ Highlight and evaluate the first line of the M-file (excluding the word
function). Either right-click and select Evaluate, press F9, or copy and
paste the following to the command line:

[fitresult, gof] = createSurfaceFits(x, y, z, xv, yv, zv)

¢ The function creates a figure window for each fit you had in your session.
Observe that the polynomial fit figure shows both the surface and
residuals plots that you created interactively in the Surface Fitting Tool.

¢ If you want you can use the generated code as a starting point to change
the surface fits and plots to fit your needs. For a list of methods you can
use, see “Surface Fit Methods” on page 6-5.

For more information on all fit settings and tools for comparing fits, see:

® “Selecting Fit Settings” on page 3-28
e “Fitting Multiple Surfaces ” on page 3-35
® “Comparing Surface Fits” on page 3-37
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Biopharmaceutical Interactive Surface Fitting
Example

Curve Fitting Toolbox software provides some example data for an anesthesia
drug interaction study. You can use Surface Fitting Tool to fit response
surfaces to this data to analyze drug interaction effects. Response surface
models provide a good method for understanding the pharmacodynamic
interaction behavior of drug combinations.

This data is based on the results found in the following paper:

Kern SE, Xie G, White JL, Egan TD. Opioid-hypnotic synergy: A response
surface analysis of propofol-remifentanil pharmacodynamic interaction in
volunteers. Anesthesiology 2004; 100: 1373-81.

Anesthesia is typically at least a two-drug process, consisting of an opioid
and a sedative hypnotic. This example uses Propofol and Reminfentanil

as drug class prototypes. Their interaction is measured by four different
measures of the analgesic and sedative response to the drug combination.
Algometry, Tetany, Sedation, and Laryingoscopy comprise the four measures
of surrogate drug effects at various concentration combinations of Propofol
and Reminfentanil.

Perform the following steps to interactively create response surfaces for this
drug combination:

1 Use the Current Folder browser to locate and view the folder
matlab\toolbox\curvefit\curvefit.

2 Right-click the file OpioidHypnoticSynergy.txt, and select Import Data.
The Import Wizard appears.

a Click Next to accept the default column separator (tab).

b Click the option button labeled Create vectors from each column
using column names. Review the six variables selected for import:
Algometry, Laryingoscopy, Propofol, Reminfentanil, Sedation, and
Tetany.

¢ Click Finish to import the dose-response data into the MATLAB
workspace.
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Alternatively you can import the data programmatically. Enter the
following code to read the dose-response data from the file into the

MATLAB workspace.

data = importdata(
data.
data.
data.
data.
data.
data.

Propofol =
Remifentanil
Algometry =
Tetany =
Sedation =
Laryingoscopy =

data(:
data(:
data(:
data(:
data(:
data(:

313
12) 3
33) 3
4) 3
39) 3
16) 3

'OpioidHypnoticSynergy.txt' );

3 To create response surfaces you must select the two drugs for the X and
Y inputs, and one of the four effects for the Z output. After you load the
variables into your workspace, you can either open the tool and select
variables interactively, or specify the initial fit variables with the sftool

command.

Enter the following to open Surface Fitting Tool (if necessary) and create a
new response surface for Algometry:

sftool(Propofol, Remifentanil, Algometry)

Review the Surface Fitting Tool X, Y, and Z input and output controls.
The tool displays the selected variables Propofol, Remifentanil and
Algometry, with a surface fit. The default fit is an interpolating surface
that passes through the data points.
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) Surface Fitting Tool : i ]
File Tools Fit View Desktop Window Help k] | A X
HODEA0
Fit name: Iuntitled fit 1| I Interpolant LI v Auto fit
X input: IPropofaI '] Method: ILinear LI Fit

¥ input: IRemifentanil 'l ¥ Center and scale Stop |
2Z output: IAIgometry - l

-

Weights: |(none)

—T—

untitled fit 1

Algornetry ws. Propofol, Remifentanil

Results
Duplicate x-y data points g

sl e ,

Linear interpolant:
fx,y) = piecewise line
where x is normalized |
and where y is normali ]
Coeffidents: fone D
p = coefficent structu

Algametry

20

Goodness of fit: _ILI 5
i 1 : Rermifentanil uo Propofal
5 [untted fit 1 7
e T L o o T L L e ml
Fit... + |Data Fit type |SSE R-sguare | DFE AdjR-sg |RMSE # Coeff |valida... |validat...|valida...
[d unti... [Algome. .. [inearin... |2.2039... [1 0 MNak Mah 396
A

4 Create a copy of the current surface fit by either:
a Selecting Fit > Duplicate "Current Fit Name".
b Right-clicking a fit in the Table of Fits, and selecting Duplicate.

5 Select the Custom Equation fit type from the drop-down list to define
your own equation to fit the data.

6 Select and delete the example custom equation text in the edit box.

You can use the custom equation edit box to enter MATLAB code to define
your model. The equation that defines the model must depend on the input
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variables x and y and a list of fixed parameters, estimable parameters,
or both.

The model from the paper is:

n
Emax.[ Ca + Cp +a Ca Cr )
E_

1C50,  IC505  IC50, IC50g

n
o Ca , CB , Ca Cp
150, T 1C505 7 1C50, IC504

where C, and Cj; are the drug concentrations, and IC50A, IC50B, alpha,
and n are the coefficients to be estimated.

You can define this in M-code as

Effect = Emax*( CA/IC50A + CB/IC50B + alpha*( CA/IC50A )...
.* ( CB/IC50B ) ).”"n ./(( CA/IC50A + CB/IC50B + ...
alpha*( CA/IC50A ) .* ( CB/IC50B ) )."n + 1);

Telling the tool which variables to fit and which parameters to estimate,
requires rewriting the variable names CA and CB to x, and y. You must
include x and y when you enter a custom equation in the edit box. Assume
Emax = 1 because the effect output is normalized.

Enter the following text in the custom equation edit box, and click Fit.
( x/IC50A + y/IC50B + alpha*( x/IC50A ) .* ( y/IC50B ) )."n

./(( x/IC50A + y/IC50B + alpha*( x/IC50A ) .*
( y/IC50B ) )."n + 1);

Surface Fitting Tool fits a surface to the data using the custom equation
model.
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) Surface Fitting Tool i ] [
Eile Tools Fit Yiew Desktop Window Help k] | A X
HDB 0

¥ Auto fit

Fit name: |Cusb3m I Custom Equation

X input: IPropofUI

|z = f{ | Ly

El
)

¥ input: IRernifentaniI

Z output: IAIgomet’\;

Led Lef Lef Lol

Weights: I (none)

|1 ( %x/IC50R + y/ICS0B + alpha*( =
1] n [
Fit Options... |

Fit |
Stop |

Results

| v

General model:
fx,v) = {x/IC50A + y/ICS0B + alph:
U x/IC508 + y/IC508
= (v/IC50B ) )."n
Coeffidents (with 95% confidence boun 1
IC50A = 4.127 (4.005, 4.25)
IC50E = 8,882 (8.526,9.237)
alpha = 8.22 (7.328,9.113)
n= 8.83 (7.951, 9.708)

Algarmetry

Goodness of fit: |
S5E: 2,175 0-:
R-square: 0.9754
Adjusted R-square: 0.9762
RMSE: 0.07439 I

20

| | _'l—l Remifertanil

B Costom

Algometry vs. Propofol, Remifentanil

|

Propofal
|| Custom = | Interp = ﬂ
R e e e e L e L e R R =i
Fitmame < |[Data Fit type SSE R-sgquare DFE AdjR-=g RMSE # Coeff Validation ... | Validation ... | Validation ...
[d Interp Algometry ... [inearinterp  |2,203%e-29 |1 0 Mah Mah 396
[@ Custom  |Algometry ... |(%/IC50A ... [2.1746 0.9754 393 0.9762 0.0744 4
4

8 Set some of the fit options by clicking Fit Options under your custom

equation.

In the Fit Options dialog box:
a Set Robust to Lar

b Set the alpha Start Point to 1 and lower bound to —5.
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) Fit Options

Method: MorlinearLeastSguares
Robust: Lar -
Algorithm: I Trust-Region ;I
DiffMinChange: | 1.0e-8
DiffMaxChange: I 0.1
MaxFunEvals: I a00
ManIter: | 400
TolFun: I 1.0e-5
Tolx: | 1.0e-6
LInknowns StartPoint Lower Upper
IC50A 0.4719 -Inf Inf
IC50B 0.4225 -Inf Inf
alpha 1 -5 Inf
n 0.8455 -Inf Inf

Close |

¢ Leave the other defaults, and click Close.

9 In Surface Fitting Tool, click Fit to refit with your new options.

10 Review the Results pane. View (and, optionally, copy) any of these results:

® The model equation

e The values of the estimated coefficients

¢ The goodness of fit statistics

11 Display the residuals plot to check the distribution of points relative to the
surface by selecting View > Residuals Plot.
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— e
B Costom
; Algometry ve. Propofal, Remifentanil
fa O
T ]
= ] )
S 05w
EO
20 =
0 o
Remifentanil Propofol
~—*® Custom - residualsJ
fa
T
=
(=]
=
=
Remifentanil Propofol

12 To generate an M-file for all fits and plots in your Surface Fitting Tool
session, select File > Generate M-File.

The Surface Fitting Tool creates an M-file from your session and displays
the file in the MATLAB Editor. The file includes all fits and plots in your

current session.

13 Save the file with the default name, createSurfaceFits.m.

14 You can re-create your fits and plots by calling the M-file from the command
line (with your original data or new data as input arguments). In this case,

your original data still appears in the workspace.
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15

Highlight the first line of the M-file (excluding the word function), and
evaluate it by either right-clicking and selecting Evaluate, pressing F9, or
copying and pasting the following to the command line:

[fitresult, gof] = createSurfaceFits(Propofol,...
Remifentanil, Algometry)

The function creates a figure window for each fit you had in your session.
The custom fit figure shows both the surface and residuals plots that you
created interactively in the Surface Fitting Tool.

Create a new fit to the Tetany response instead of Algometry by entering:

[fitresult, gof] = createSurfaceFits(Propofol,...
Remifentanil, Tetany)

You need to edit the M-file if you want the new response label on the plots.
You can use the generated code as a starting point to change the surface
fits and plots to fit your needs. For a list of methods you can use, see
“Surface Fit Methods” on page 6-5.

To see how to programmatically fit surfaces to the same example problem,
see “Biopharmaceutical Drug Interaction Programmatic Surface Fitting
Example” on page 4-53.
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Selecting Fit Settings

In this section...

“Introduction” on page 3-28

“Selecting Fit Category” on page 3-28

“Using Center and Scale Setting” on page 3-29
“Using Interpolant Fit Category” on page 3-29
“Using Polynomial Fit Category” on page 3-30
“Using Lowess Fit Category” on page 3-32

“Using Custom Equation Fit Category” on page 3-33

Introduction

Surface Fitting Tool provides a selection of fit types and settings that you
can alter to try to improve your fit. Try the defaults first, then experiment
with other settings. This section describes how to use the available fit types
and settings.

You can try a variety of settings within a single fit tab, and you can also create
multiple fits to compare. When you create multiple fits you can compare
different fit types and settings side by side in the Surface Fitting Tool. See
“Fitting Multiple Surfaces ” on page 3-35 and “Comparing Surface Fits” on
page 3-37.

Selecting Fit Category
Select a fit category from the drop-down list in the Surface Fitting Tool:

® Interpolant — for interpolating a surface through the data points.
Interpolant is the default fit type.

® Polynomial — for linear regression

® | owess — for local smoothing regression

® Custom Equation — for nonlinear regression




Selecting Fit Settings

Each fit category has specific settings that appear when you choose a fit type.
The settings for each fit category are described in the following sections.

For all fit categories, look in the Results pane to see the model terms, the
values of the coefficients, and the goodness-of-fit statistics.

Tip If there are problems with your fit, messages appear in the Results pane
to help you identify better settings.

Using Center and Scale Setting

Each fit category (except Custom equation) shares the Center and scale
option. When you select the Center and scale option, the Surface Fitting
Tool refits with the data centred and scaled, by applying the Normalize
setting to the variables. Normalize is an input argument to the fitoptions
function. See the fitoptions reference page.

Generally it 1s a good idea to normalize inputs (also known as predictor data),
which can alleviate numerical problems with variables of different scales. For
example, suppose your inputs are engine speed with a range of 500—-4500
r/min and engine load with a range of 0—1. Then, Center and scale generally
improves the fit because of the great difference in scale between the two
inputs. However, if your inputs are in the same units or similar scale (e.g.,
eastings and northings for geographic data), then Center and scale is less
useful. When you normalize inputs with the Center and scale option, the
values of the fitted coefficients change when compared to the original data.

If you are fitting a surface to estimate coefficients, or the coefficients have
physical significance, clear the Center and scale check box. The Surface
Fitting Tool plots use the original scale with or without the Center and
scale option.

Using Interpolant Fit Category

The Interpolant fit category fits an interpolating surface that passes
through all the data points. This fit category uses the MATLAB GRIDDATA
function. The settings are shown below.
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Interpolant

Method: I Linear LI

W Center and scale

You can specify the Methods setting: Linear, Cubic, Nearest, or Biharmonic
(v4). For details on these methods, see the documentation for the MATLAB
GRIDDATA function.

Tip If your input variables have different scales, turn the Center and
scale option on and off to see the difference in the surface fit. Normalizing
the inputs can have a strong influence on the results of the triangle-based
(i.e., piecewise Linear and Cubic interpolation) and Nearest-neighbour
interpolation methods.

Using Polynomial Fit Category

The Polynomial fit uses the Curve Fitting Toolbox polynomial library model.
This library model is an input argument to the fit and fittype functions.
See thefitoptions reference page.

The Polynomial fit type fits a polynomial in x and y.

Degrees: x: IE ;I W Iz ;I
=

Robust: I Off
[T Center and scale

Fit Options... |




Selecting Fit Settings

You can specify the following options:

® The degree for the x and y inputs (maximum of 5 in each case). The degree
of the polynomial is the maximum of x and y degrees. See “Defining
Polynomial Terms for Polynomial Fit Category” on page 3-31.

® The robust linear least-squares fitting method to use (0ff, LAR, or
Bisquare). For details, see Robust on the fitoptions reference page.

® Set bounds or exclude terms by clicking Fit Options. You can exclude a
term by setting its bounds to zero.

Tip If your input variables have very different scales, turn the Center and
scale option on and off to see the difference in the surface fit.

Defining Polynomial Terms for Polynomial Fit Category

You can control the terms to include in the polynomial model by specifying
the Degrees for the x and y inputs. If i is the degree in x and j is the degree
in y, the total degree of the polynomial is the maximum of i and j. The degree
of x in each term is less than or equal to i, and the degree of y in each term is
less than or equal to .

For example, if you specify an x degree of 3 and a y degree of 2, the model
name is poly32. The model terms follow the form shown in the following table.

Degree of term | 0 1 2
0 1 y y?
1 X Xy Xy?
2 x? x%y

3 x3

The total degree of the polynomial cannot exceed the maximum of i and j. In
this example, terms such as x%y and x%y? are excluded because their degrees
sum to more than 3. In both cases, the total degree is 4.
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You can exclude any term by clicking the Fit Options button, and setting the
bounds to zero for any terms you want to remove. Look in the Results pane
to see the model terms, the values of the coefficients, and the goodness-of-fit
statistics.

Using Lowess Fit Category

The Lowess fit category uses locally weighted linear regression to smooth data.

I Lowess o |

Palynomial; I Linear LI
Span: |25 %
Robust: I OFfF LI

[# Center and scale

You can specify the following options:

e Select Linear or Quadratic in the drop-down to specify the type of
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Polynomial model to use in the regression. . In Curve Fitting Toolbox,
lowess fitting uses a linear polynomial, while loess fitting uses a quadratic
polynomial. For more information on these two types of smoothing fit, see
“Local Regression Smoothing” on page 5-7.

The Span as a percentage of the total number of data points in the data
set. The toolbox uses neighboring data points defined within the span to
determine each smoothed value. This role of neighboring points is the
reason why the smoothing process is called “local.”

Tip Increase the span to make the surface smoother. Reduce the span to
make the surface follow the data more closely.

The Robust linear least-squares fitting method you want to use (Off, LAR,
or Bisquare). The local regression uses the Robust option. Using the



Selecting Fit Settings

Robust weight function can make the process resistant to outliers. For
details, see Robust on the fitoptions reference page.

The fit type name lowess derives from the term "locally weighted scatter plot
smooth." The process is weighted because the toolbox defines a regression
weight function for the data points contained within the span. In addition to
the regression weight function, the Robust option is a weight function that
can make the process resistant to outliers. For more information, see “Local
Regression Smoothing” on page 5-7.

Tip If your input variables have very different scales, turn the Center and
scale option on and off to see the difference in the surface fit. Normalizing
the inputs can have a strong influence on the results of a Lowess fitting.

Using Custom Equation Fit Category

You can use the Custom Equation fit category to define your own equations.
An example i1s provided. The example custom equation displays when you
select Custom Equation from the drop-down, as shown here.

z =i Ix Jlaf )

T la + b*sinim*pi*x*y)
+ crexpi—(w*y) ~2)

Fit Options. ..

You can enter any valid MATLAB expression in terms of x and y .

You can save your custom equations as part of your saved Surface Fit Tool
sessions.

Your function may execute a number of times, both during fitting and during
preprocessing before fitting. Be aware of this if you are using functions with
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side effects such as writing data to a file, or displaying diagnostic information
to the Command Window.
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Fitting Multiple Surfaces

In this section...

“Introduction” on page 3-35
“Fitting Additional Surfaces” on page 3-35
“Duplicating a Surface Fit” on page 3-35

“Deleting a Surface Fit” on page 3-36

Introduction

After you create a single fit, it can be useful to create multiple fits to compare.
When you create multiple fits you can compare different fit types and settings
side-by-side in the Surface Fitting Tool.

Fitting Additional Surfaces

After creating a fit, you can add an additional surface using either of these
methods:

e (Click the New Fit toolbar button.
e Select Fit > New Fit.

Each additional fit appears as a new tab in the Surface Fitting Tool and a new
row in the Table of Fits. See “Comparing Surface Fits” on page 3-37 for
information about displaying and analyzing multiple fits.

Optionally, after you create an additional fit, you can copy your data selections
from a previous fit by selecting Fit > Use Data From > Other Fit Name.
This copies your selections for x, y, and z from the previous fit, and any
selected validation data. No fit options are changed.

Duplicating a Surface Fit

To create a copy of the current surface fit tab, select Fit > Duplicate
"Current Fit Name". You also can right-click a fit in the Table of Fits
and select Duplicate

3-35



3 Interactive Surface Fitting

3-36

Each additional fit appears as a new tab in the Surface Fitting Tool.

Deleting a Surface Fit

Delete a fit from your session using one of these methods:

e Select the fit tab display and select Fit > Delete Current Fit Name.
e Select the fit in the Table of Fits and press Delete.
¢ Right-click the fit in the table and select Delete Current Fit Name.
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Comparing Surface Fits

In this section...

“Introduction” on page 3-37
“Displaying Multiple Fits Simultaneously” on page 3-37
“Displaying Surface, Residual, and Contour Plots” on page 3-39

“Using the Statistics in the Table of Fits” on page 3-41

Introduction

When you have created multiple fits you can compare different fit types

and settings side by side in the Surface Fitting Tool. You can view plots
simultaneously and you can examine the goodness-of-fit statistics to compare
your fits. This section describes how to compare multiple fits.

Displaying Multiple Fits Simultaneously

To compare plots and see multiple fits simultaneously, use the layout controls
at the top right of the Surface Fitting Tool. Alternatively, you can click
Window on the menu bar to select the number and position of tiles you want
to display. The following example shows two fit tabs displayed side by side.
You can see three fits in the session listed in the Table of Fits.
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You can close fit tab displays (with the Close button, Fit menu, or context
menu), but they remain in your session. The Table of Fits displays all your
fits (open and closed). Double-click a fit in the Table of Fits to open a fit tab
display. To remove a fit, see “Deleting a Surface Fit” on page 3-36

You can dock and undock individual fits and navigate between them using
the standard MATLAB Desktop and Window menus in the Surface Fitting
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Tool. For more information, see “Opening and Arranging Desktop Tools” in
the MATLAB Desktop Tools and Development Environment documentation.

Displaying Surface, Residual, and Contour Plots

Within each fit tab, you can display up to three plots simultaneously to
examine the fit. Use the View menu to select the type of plot to display:
surface plot, residuals plot, or contour plot. See also “Exploring and
Customizing Plots” on page 3-8.
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Surface Plot

The surface plot displays by default. For polynomial and custom fits, you also
can use the Tools menu to display Surface Prediction Bounds. When you
display Surface Prediction Bounds, two additional surfaces are plotted to
show the prediction bounds on both sides of your model fit.

Choose which bounds to display: None, 90%, 95%, 99%, or Custom. The custom
option opens a dialog box where you can enter the required confidence level.
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The following example shows prediction bounds. You can see three surfaces
on the plot. The top and bottom surfaces show the prediction bounds at the
specified confidence level on either side of your model fit surface.

1.2322

TG

0011197 | o
4484 375

300
i

0.99358

You can also switch your surface plot to a 2-D plot if desired. Your plot
cursor must be in rotation mode. Select Tools > Rotate 3D if necessary.
Then, right-click the plot to select X-Y, X-Z, or Y-Z view, or to select Rotate
Options. All these context menu options are standard MATLAB 3-D plot
tools. See “Rotate 3D — Interactive Rotation of 3-D Views” in the MATLAB
Graphics documentation.

Residuals Plot

On the Residuals Plot, you can view the errors between your fitted surface
and your data, and you can remove outliers. See “Removing Outliers” on page
3-6. The following example shows a residuals plot with some excluded outliers.
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Contour Plot
Use the contour plot to examine a contour map of your surface. A contour plot
makes it easier to see points that have the same height. An example is shown
in “Displaying Surface, Residual, and Contour Plots” on page 3-39.
Using the Statistics in the Table of Fits
The Table of Fits list pane shows all fits in the current session.
Table of Fits .-
Fit name ¢ |Data Type of it S5E R-square DFE Adj R-sq RMSE # Coeff
[ interp TQvs. N, L Inkerpalant 9,8023e-31 1 0 Mal WEN] 293
M polyaz  [TQvs. N, L |Polynomial  |1.3055 0,9458 279 0.9433 0,0684 14
M lowess  [TQvs.N,L  |Lowess 0.2728 0,9857 271.4667 0.9878 0.0317 21

After using graphical methods to evaluate the goodness of fit, you can examine
the goodness-of-fit statistics shown in the table to compare your fits. The
goodness-of-fit statistics help you determine how well the surface fits the data.
Click the table column headers to sort by statistics, name, fit type, and so on.

The following guidelines help you use the statistics to determine the best fit:

® SSE is the sum of squares due to error of the fit. A value closer to zero
indicates a fit that is more useful for prediction.
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® R-square is the square of the correlation between the response values and
the predicted response values. A value closer to 1 indicates that a greater
proportion of variance is accounted for by the model.

* DFE is the degree of freedom in the error.

* Adj R-sq is the degrees of freedom adjusted R-square. A value closer to 1
indicates a better fit.

® RMSE is the root mean squared error or standard error. A value closer to 0
indicates a fit that is more useful for prediction.

e # Coeff is the number of coefficients in the model. When you have several
fits with similar goodness-of-fit statistics, look for the smallest number of
coefficients to help decide which fit is best. You must trade off the number
of coefficients against the goodness of fit indicated by the statistics to avoid
overfitting.

For a more detailed explanation of the Curve Fitting Toolbox statistics, see
“Goodness-of-Fit Statistics” on page 5-31.

To compare the statistics for different surfaces and decide which fit is the
best tradeoff between over- and under-fitting, use a similar process to that
described for curve fitting in “Determining the Best Fit” on page 2-8.
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Generating M-Files and Exporting Fits to the Workspace

In this section...

“Introducing Programmatic Surface Fitting” on page 3-43

“Generating M-Files from the Surface Fitting Tool” on page 3-43

“Exporting a Fit to the Workspace” on page 3-45

Introducing Programmatic Surface Fitting

Surface Fitting Tool makes it easy to plot and analyze fits at the command
line. You can export individual fits to the workspace for further analysis,
or you can generate an M-file to recreate all fits and plots in your session.
By generating M-files you can use your interactive surface fitting session to
quickly assemble code for surface fits and plots into useful programs.

For programmatic surface fitting examples, see “Programmatic Surface
Fitting” on page 4-41.

Generating M-Files from the Surface Fitting Tool

You can generate and use MATLAB code from an interactive session in the
Surface Fitting Tool. In this way, you can transform your interactive analysis
into reusable functions for batch processing of multiple data sets. You can
use the generated M-file without modification, or you can edit and customize
the M-file as needed.

To generate an M-file for all fits and plots in your Surface Fitting Tool session
follow these steps:

1 Select File > Generate M-File.

The Surface Fitting Tool creates an M-file from your session and displays
the file in the MATLAB Editor. The file includes all fits and plots in your
current session. The M-file captures the following information:

e Names of fits and their variables

* Fit settings and options
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* Plots
e Surface fitting objects and methods used to create the fits:
= A cell-array of sfit objects representing the fits

= A structure array with goodness-of fit information.
2 Save the M-file.

To recreate your fits and plots, call the M-file from the command line with your
original data as input arguments. You also can call the M-file with new data.

For example, enter:

[fitresult, gof] = myFileName(a, b, C)
where a, b, and ¢ are your variable names, and myFileName is the M-file name.

Calling the M-file from the command line does not recreate your Surface
Fitting Tool GUI and session. When you call the M-file, you get the same plots
you had in your Surface Fitting Tool session in standard MATLAB figure
windows. There is one window for each fit. For example, if your fit in the
Surface Fitting Tool session displayed surface, residual and contour plots, all
three plots appear in a single figure window. The following example shows a
fit figure with surface and residual plots and some removed outliers.
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For more information on working with surface fitting objects and methods,
see “Programmatic Surface Fitting” on page 4-41.

Exporting a Fit to the Workspace
To export a fit to the MATLAB workspace, follow these steps:
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1 Select a fit and save it to the MATLAB workspace using one of these
methods:

e Select a fit tab in the Surface Fit Tool and select Fit > Save to
Workspace.

¢ Right-click the fit listed in the Table of Fits and select Save Fit
myfitname to Workspace
The Save Fit to MATLAB Workspace dialog box opens.

) Save Fit to MATLAB Workspace b N (=] 4|

¥ Save fit to MATLAB ohject named: Iﬂl‘tedmudel

¥ Save goodness of fit to MATLAB struct named: Ignndness

¥ Save fit output to MATLAB struct named: }‘Ju‘tput

0K Cancel I

2 Edit the names as appropriate. If you previously exported fits, the toolbox
automatically adds a numbered suffix to the default names so there is no
danger of overwriting them.

3 Choose which options you want to export by selecting the check boxes.
Check box options are as follows:

¢ Save fit to MATLAB object named fittedmodel — This option
creates an sTit object, that encapsulates the result of fitting a surface
to data. You can examine the fit coefficients at the command line, for
example:

fittedmodel
Linear model Poly22:
fittedmodeli(x,y) = p00 + p10*x + pO1*y + p20*x"2...
+ pl1*x*y + p02*y~2
Coefficients (with 95% confidence bounds):

po0 = 302.1 (247.3, 356.8)

p10 = -1395 (-1751, -1039)

po1 = 0.03525 (0.01899, 0.05151)
p20 = 1696 (1099, 2293)
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p11 = -0.1119  (-0.1624, -0.06134)
p02 2.36e-006 (-8.72e-007, 5.593e-006)

You also can treat the sfit object as a function to make predictions or
evaluate the surface at values of X and Y. See the sfit reference page.

¢ Save goodness of fit to MATLAB struct named goodness — This
option creates a structure array that contains statistical information
about the fit, for example:

goodness =
sse: 0.0234
rsquare: 0.9369
dfe: 128
adjrsquare: 0.9345
rmse: 0.0135

® Save fit output to MATLAB struct named output — This option
creates a structure array that contains information such as numbers of
observations and parameters, residuals, and so on. For example:

output =
numobs: 134
numparam: 6
residuals: [134x1 double]
Jacobian: [134x6 double]
exitflag: 1
algorithm: 'QR factorization and solve'
iterations: 1

Note Goodness of fit and Output arrays are outputs of the fit
function. See the fit reference page.

4 Click OK to save the fit options to the workspace.

For more information on working with surface fitting objects and methods at
the command line, see “Programmatic Surface Fitting” on page 4-41.
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Working with Sessions

In this section...

“Overview” on page 3-48
“Saving Sessions” on page 3-48

“Reloading Sessions” on page 3-48

“Removing Sessions” on page 3-48

Overview

You can save and reload sessions for easy access to multiple fits. The session
file contains all the fits and variables in your session and remembers your
layout.

Saving Sessions

To save your session, first select File > Save Session to open your file
browser. Next, select a name and location for your session file (with file
extension .sfit).

After you save your session once, you can use File > Save MySessionName to
overwrite that session for subsequent saves.

To save the current session under a different name, select File > Save
Session As .

Reloading Sessions

Use File > Load Session to open a file browser where you can select a saved
surface fit session file to load.

Removing Sessions

Use File > Clear Session to remove all fits from the current Surface Fitting
Tool session.



Programmatic Curve and
Surface Fitting

¢ “Introducing Programmatic Curve Fitting” on page 4-2
e “Curve Fitting Objects and Methods” on page 4-9
® “Generating M-files From Curve Fitting Tool” on page 4-30

® “Programmatic Surface Fitting” on page 4-41



4 Programmatic Curve and Surface Fitting

Introducing Programmatic Curve Fitting

In this section...

“Using Curve Fitting Objects and Methods” on page 4-2

“Interactive Code Generation” on page 4-5

Using Curve Fitting Objects and Methods

The Curve Fitting Tool is a graphical user interface that allows convenient,
interactive use of Curve Fitting Toolbox functions, without programming.
You can, however, access Curve Fitting Toolbox functions directly, and write
programs that combine curve fitting functions with MATLAB functions and
functions from other toolboxes. This allows you to create a curve fitting
environment that is precisely suited to your needs.

Models and fits in Curve Fitting Tool are managed internally as curve
fitting objects. Objects are manipulated through a variety of functions
called methods. You can create curve fitting objects, and apply curve fitting
methods, outside of Curve Fitting Tool.

For example, the following code, using Curve Fitting Toolbox methods,
reproduces an analysis of the census data that was carried out interactively in
Curve Fitting Tool in “Interactive Curve Fitting Example” on page 2-2.

Load and plot the data in census.mat:

load census
plot(cdate,pop,'o"')
hold on
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Create a fit options structure and a fittype object for the custom nonlinear
model y = a(x—b)", where a and b are coefficients and n is a problem-dependent
parameter:

s = fitoptions('Method', 'NonlinearLeastSquares',...
"Lower',[0,0],...
"Upper',[Inf,max(cdate)],...
'Startpoint',[1 1]);

f = fittype('a*(x-b)"n', 'problem','n','options',s);

Fit the data using the fit options and a value of n = 2:

[c2,g0f2] = fit(cdate,pop,f, ' 'problem',2)

c2 =
General model:
c2(x) = a*(x-b)"n
Coefficients (with 95% confidence bounds):
a = 0.006092 (0.005743, 0.006441)
b = 1789 (1784, 1793)
Problem parameters:
n = 2
gof2 =

sse: 246.1543
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4-4

rsquare: 0.9980

dfe: 19
adjrsquare: 0.9979
rmse: 3.5994

Fit the data using the fit options and a value of n = 3:

[c3,90f3] = fit(cdate,pop,f, 'problem',3)
c3 =
General model:
c3(x) = a*(x-b)"n
Coefficients (with 95% confidence bounds):
a = 1.359e-005 (1.245e-005, 1.474e-005)

b = 1725 (1718, 1731)
Problem parameters:
n = 3

gof3 =
sse: 232.0058
rsquare: 0.9981
dfe: 19
adjrsquare: 0.9980
rmse: 3.4944

Plot the fit results with the data:

plot(c2,'m")
plot(c3,'c')
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Interactive Code Generation

Curve fitting code can be assembled into an M-file by hand, as shown in
“Curve Fitting Objects and Methods” on page 4-9, or it can be generated
automatically from an interactive session in Curve Fitting Tool, as described
in “Generating M-files From Curve Fitting Tool” on page 4-30. In practice,
automatically generated code, giving the broad outlines of an analysis, can be
combined with hand-coded refinements. This allows you to write functions
that are customized to your data and your analysis, without having to write
all of the basic programming structures.

For example, the following M-file was generated from a session in Curve
Fitting Tool that imported the data from census.mat and fit a custom
nonlinear model of the form y = a(x—b):

function myfit(cdate,pop)

SMYFIT Create plot of datasets and fits

MYFIT (CDATE,POP)

Creates a plot, similar to the plot in the main curve fitting
window, using the data that you provide as input. You can
apply this function to the same data you used with cftool

o® o° o°

o°
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o°

or with different data. You may want to edit the function to
customize the code and this help message.

o® o°

o°

Number of datasets: 1
Number of fits: 1

o°

o°

Data from dataset "pop vs. cdate":

% X = cdate:
% Y = pop:
% Unweighted

o°

o°

This function was automatically generated on 11-Sep-2007 01:07:

o°

Set up figure to receive datasets and fits

_ = clf;

figure(f_);

set(f_, 'Units', 'Pixels', 'Position',[439.6 193.6 814.4 576.8]);
legh_ = [1; legt_ = {}; % handles and text for legend

xlim_ = [Inf -Inf]; % limits of x axis

ax_ = axes;

set(ax_, 'Units', 'normalized', 'OuterPosition',[0 O 1 1]);
set(ax_, 'Box','on'");

axes(ax_); hold on;

-

% --- Plot data originally in dataset "pop vs. cdate"
cdate = cdate(:);
pop = pop(:);

11

h_ = line(cdate,pop, 'Parent',ax_, 'Color',[0.333333 0 0.666667],...

'LineStyle', 'none', 'LineWidth',1,...
'‘Marker',"'.', 'MarkerSize',12);
xlim_(1) = min(x1lim_(1),min(cdate));
xlim_(2) = max(xlim_(2),max(cdate));
legh_(end+1) = h_;
legt {end+1} = 'pop vs. cdate';

% Nudge axis limits beyond data limits

if all(isfinite(xlim_ ))
xlim_ = x1im_ + [-1 1] * 0.01 * diff(xlim_);
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set(ax_, 'XLim',x1lim_)

else
set(ax_, 'XLim',[1788, 1992]);
end
% --- Create fit "fit 1"
ok_ = isfinite(cdate) & isfinite(pop);
if ~all( ok_ )
warning( 'GenerateMFile:IgnoringNansAndInfs',
‘Ignoring NaNs and Infs in data' );
end
st = [0.51510504095942344 0.35210694524343056 ];
ft = fittype('a*(x-b)"3',...

'dependent',{'y'}, 'independent',{'x'},...

‘coefficients',{'a’',

'}

% Fit this model using new data

cf_ = fit(cdate(ok_),pop(ok_),ft ,'Startpoint',st );

% Or use coefficients from the original fit:

if 0
cv_ = { 1.3594203554767276¢e-005,
cf_ = cfit(ft_,cv_{:});

end

% Plot this fit

h_ = plot(cf_,'fit',0.95);

legend off;

set(h_(1),'Color',[1 O O],...
'LineStyle','-",
'Marker', 'none’,

legh_(end+1) h _(1);

legt {end+1} = 'fit 1';

‘MarkerSize',6);

% Done plotting data and fits.
hold off;

leginfo_ = {'Orientation', 'vertical',

'LineWidth',2,...

‘Location’,

1724.6959436137356} ;

% turn off legend from plot method call

Now finish up loose ends.

'NorthEast'};

h_ = legend(ax_,legh_,legt ,leginfo_{:}); % create legend

set(h_, 'Interpreter', 'none');
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xlabel(ax_,"'"'); % remove x label
ylabel(ax_,"'"); % remove y label

A quick look through the code shows that it has automatically assembled
for you many of the Curve Fitting Toolbox curve fitting methods, such as
fitoptions, fittype, fit, and plot.

A natural modification of the M-file would be to edit the function declaration
at the top of the file to return the cfit object created by the fit, as follows:

function cf_ = myfit(cdate,pop)

You might also modify the code to produce a variety of different plots, or
to return goodness-of-fit statistics.

Coding with curve fitting objects and methods is given complete treatment
in “Curve Fitting Objects and Methods” on page 4-9 and “Generating M-files
From Curve Fitting Tool” on page 4-30.
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Curve Fitting Objects and Methods

In this section...

“Overview” on page 4-9

“Curve Fitting Objects” on page 4-10

“Curve Fitting Methods” on page 4-11

“Workflow for Object-Oriented Fitting” on page 4-13

“Examples” on page 4-15

This section describes how to use Curve Fitting Toolbox functions from the
command-line or to write programs for curve fitting applications.

For surface fitting, see “Programmatic Surface Fitting” on page 4-41.

Overview

In MATLAB programming, all workspace variables are objects of a particular
class. Familiar examples of MATLAB classes are double, char, and
function_handle. You can also create custom MATLAB classes, using
object-oriented programming.

Methods are functions that operate exclusively on objects of a particular
class. Data types package together objects and methods so that the methods
operate exclusively on objects of their own type, and not on objects of other
types. A clearly defined encapsulation of objects and methods is the goal of
object-oriented programming.

Curve Fitting Toolbox software provides you with two new MATLAB data
types for performing curve fitting:

e fittype — Objects allow you to encapsulate information describing a
parametric model for your data. Methods allow you to access and modify
that information.

e cfit — A subtype of fittype. Objects capture information from a
particular fit by assigning values to coefficients, confidence intervals, fit
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statistics, etc. Methods allow you to post-process the fit through plotting,
extrapolation, integration, etc.

fFittype
objects

Because cfit is a subtype of fittype, cfit inherits all fittype methods.
In other words, you can apply fittype methods to both fittype and cfit
objects, but cfit methods are used exclusively with cfit objects.

As an example, the fittype method islinear, which determines if a model
is linear or nonlinear, would apply equally well before or after a fit; that is,
to both fittype and cfit objects. On the other hand, the cfit methods
coeffvalues and confint, which, respectively, return fit coefficients and
their confidence intervals, would make no sense if applied to a general
fittype object which describes a parametric model with undetermined
coefficients.

Curve Fitting Objects

Curve fitting objects have properties that depend on their type, and also on
the particulars of the model or the fit that they encapsulate. For example, the
following code uses the constructor methods for the two curve fitting types

to create a fittype object f and a cfit object c:

f = fittype('a*x"2+b*exp(n*x)"')
f =
General model:
f(a,b,n,x) = a*x"2+b*exp(n*x)
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(@]
I

cfit(f,1,10.3,-1e2)

General model:
c(x) = a*x"2+b*exp(n*x)

Coefficients:
a = 1
b = 10.3
n = -100

Note that the display method for fittype objects returns only basic
information, piecing together outputs from formula and indepnames.

cfit and fittype objects are evaluated at predictor values x using feval.
You can call feval indirectly using the following functional syntax:

cfun(x) % cfit objects;
ffun(coefi,coef2,...,x) % fittype objects;

y
y

Curve Fitting Methods

Curve fitting methods allow you to create, access, and modify curve fitting
objects. They also allow you, through methods like plot and integrate,
to perform operations that uniformly process the entirety of information
encapsulated in a curve fitting object.

The methods listed in the following table are available for all fittype objects,
including cfit objects.

Fit Type Method Description

argnames Get input argument names

category Get fit category

coeffnames Get coefficient names

dependnames Get dependent variable name

feval Evaluate model at specified predictors
fittype Construct fittype object

formula Get formula string

indepnames Get independent variable name
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Fit Type Method

Description

islinear

Determine if model is linear

numargs

Get number of input arguments

numcoeffs

Get number of coefficients

probnames

Get problem-dependent parameter names

setoptions

Set model fit options

type

Get name of model

The methods listed in the following table are available exclusively for cfit

objects.

Curve Fit Method

Description

cfit

Construct cfit object

coeffvalues

Get coefficient values

confint

Get confidence intervals for fit coefficients

differentiate

Differentiate fit

integrate

Integrate fit

plot

Plot fit

predint

Get prediction intervals

probvalues

Get problem-dependent parameter values

A complete list of methods for a curve fitting object can be obtained with the
MATLAB methods command. For example,

f = fittype('a*x"2+b*exp(n*x)"');

methods ()

Methods for class fittype:

argnames dependnames fittype islinear probnames
category feval formula numargs setoptions
coeffnames fitoptions indepnames numcoeffs type
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Note that some of the methods listed by methods do not appear in the
tables above, and do not have reference pages in the Curve Fitting Toolbox
documentation. These additional methods are generally low-level operations

used by Curve Fitting Tool, and not of general interest when writing curve
fitting applications.

There are no global accessor methods, comparable to getfield and setfield,
available for fittype objects. Access is limited to the methods listed above.
This is because many of the properties of fittype objects are derived from
other properties, for which you do have access. For example,

f = fittype('a*cos( b*x-c )')

f =
General model:
f(a,b,c,x) = a*cos( b*x-c )
formula(f)
ans =

a*cos( b*x-c )

argnames (T)
ans =

You construct the fittype object f by giving the formula, so you do have
write access to that basic property of the object. You have read access to
that property through the formula method. You also have read access to the
argument names of the object, through the argnames method. You don’t,
however, have direct write access to the argument names, which are derived
from the formula. If you want to set the argument names, set the formula.

Workflow for Object-Oriented Fitting

Curve Fitting Toolbox software provides a variety of methods for data analysis
and modeling. In application, these methods are applied in a systematic
manner, which can be represented in a standard workflow diagram such

as the one below.
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differentiate
integrate
fitoptions plot
fittype fittype L
ohject
fit E:Flt feval
ohject
load data T
coeffralues
excludedat a
probvalues
oth confint
predint

A typical analysis using curve fitting methods proceeds as follows:

1 Import your data into the MATLAB workspace using the 1load command
(if your data has previously been stored in MATLAB variables) or any of
the more specialized MATLAB functions for reading data from particular
file types.

2 If your data is noisy, you might want to smooth it using the smooth
function. Smoothing is used to identify major trends in the data that can
assist you in choosing an appropriate family of parametric models. If a
parametric model is not evident or appropriate, smoothing can be an end in
itself, providing a nonparametric fit of the data.

4-14



Curve Fitting Objects and Methods

Note Smoothing estimates the center of the distribution of the response
at each predictor. It invalidates the assumption that errors in the data
are independent, and so also invalidates the methods used to compute
confidence and prediction intervals. Accordingly, once a parametric model
1s 1dentified through smoothing, the original data should be passed to the
fit function.

3 A parametric model for the data—either a Curve Fitting Toolbox library
model or a custom model that you define—is specified as a fittype
object using the fittype function. Library models are displayed with the
cflibhelp function.

4 A fit options structure can be created for the fit using the fitoptions
function. Fit options specify things like weights for the data, fitting
methods, and low-level options for the fitting algorithm.

5 An exclusion rule can be created for the fit using the excludedata function.
Exclusion rules indicate which data values will be treated as outliers and
excluded from the fit.

6 Data, a fittype object, and (optionally) a fit options structure and an
exclusion rule are all passed to the fit function to perform the fit. The fit
function returns a cfit object that encapsulates the computed coefficients
and the fit statistics.

7 cfit objects returned by the fit function can then be passed to a variety of
postprocessing functions, such as feval, differentiate, integrate, plot,
coeffvalues, probvalues, confint, and predint.

Examples

The following examples illustrate the standard workflow outlined in
“Workflow for Object-Oriented Fitting” on page 4-13. Further examples of
programmatic fitting can be found in the reference pages for individual curve
fitting methods.

¢ “Example: Smoothing Data I” on page 4-16

e “Example: Smoothing Data II” on page 4-17
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e “Example: Excluding Data” on page 4-18

e “Example: Specifying Fit Options” on page 4-21

e “Example: Robust Fitting” on page 4-22

¢ “Example: Differentiating and Integrating a Fit” on page 4-24

e “Example: Prediction Intervals” on page 4-28

Example: Smoothing Data |
Load the data in count.dat:

load count.dat

The 24-by-3 array count contains traffic counts at three intersections for
each hour of the day.

First, use a moving average filter with a 5-hour span to smooth all of the
data at once (by linear index) :

c = smOOth(COUﬂt(:));
C1 = reshape(c,24,3);

Plot the original data and the smoothed data:

subplot(3,1,1)
plot(count,':");

hold on

plot(C1,'-");

title('Smooth C1 (All Data)')

Second, use the same filter to smooth each column of the data separately:

C2 = zeros(24,3);
for I = 1:3,

C2(:,I) = smooth(count(:,I));
end

Again, plot the original data and the smoothed data:

subplot(3,1,2)
plot(count,':");
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hold on
plot(C2,"-");
title('Smooth C2 (Each Column)')

Plot the difference between the two smoothed data sets:

subplot(3,1,3)
plot(C2 - C1,'0-")
title('Difference C2 - C1')

Smoaoth C1 (Al Data)

400 . r : .
2001 .
O = = = i -
0 5 10 15 20 25
Smooth C2 (Each Column)
400 T T T .
200F .
O .-'-#J- r - - fl -
0 5 10 15 20 25
Difference C2 - C1
10 T T T T
O-—@ﬁkﬂ %Efg_
_-10 1 1 1 1
0 5 10 15 20 25

Note the additional end effects from the 3-column smooth.

Example: Smoothing Data Il
Create noisy data with outliers:

X 15*rand(150,1);
y sin(x) + 0.5*(rand(size(x))-0.5);
y(ceil(length(x)*rand(2,1))) = 3;

Smooth the data using the loess and rloess methods with a span of 10%:

yy1l = smooth(x,y,0.1,"'loess');
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yy2 = smooth(x,y,0.1,'rloess');

Plot original data and the smoothed data.

[xx,ind] = sort(x);

subplot(2,1,1)

plot(xx,y(ind), 'b."',xx,yy1(ind), " 'r-")

set(gca, 'YLim',[-1.5 3.5])

legend('Original Data', 'Smoothed Data Using '‘'loess''',...
‘Location', 'NW")

subplot(2,1,2)

plot(xx,y(ind), 'b."',xx,yy2(ind), "'r-")

set(gca, 'YLim',[-1.5 3.5])

legend('Original Data', 'Smoothed Data Using '‘'rloess''',...
‘Location', 'NW")

+  Original Data *

3

2 = Smoocthed Data Using 'loess' .
.1 - =

0

3 +  Original Data *
2 F|— Smoothed Data Using 'floess' .
0

Note that the outliers have less influence on the robust method.

Example: Excluding Data

Load the vote counts and county names for the state of Florida from the 2000
U.S. presidential election:
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load flvote2k

Use the vote counts for the two major party candidates, Bush and Gore, as
predictors for the vote counts for third-party candidate Buchanan, and plot
the scatters:

plot(bush,buchanan, 'rs')

hold on
plot(gore,buchanan, 'bo"')
legend('Bush data', 'Gore data')

3500 T 5 T 5
O Bush data
30007 C Gore data ||
2500 F -
2000 F 4
1500 F 4
1000 4
o
500 | S .
O 1
3 4
x10°

Assume a model where a fixed proportion of Bush or Gore voters choose to
vote for Buchanan:

f
f:

fittype({'x"'})

Linear model:
f(a,x) = a*x

Exclude the data from absentee voters, who did not use the controversial
“butterfly” ballot:
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absentee = find(strcmp(counties, 'Absentee Ballots'));
nobutterfly = excludedata(bush,buchanan,'indices',absentee);

Perform a bisquare weights robust fit of the model to the two data sets,
excluding absentee voters:

bushfit = fit(bush,buchanan,f,...

"Exclude’' ,nobutterfly, 'Robust','on');
fit(gore,buchanan,f,...

"Exclude’' ,nobutterfly, 'Robust','on');

gorefit

Robust fits give outliers a low weight, so large residuals from a robust fit
can be used to identify the outliers:

figure
plot(bushfit,bush,buchanan,'rs', 'residuals')
hold on
plot(gorefit,gore,buchanan, 'bo', 'residuals')

3000 . . .

O O data
zero line ||
2000} o © daa
zero ling
1500 | .

2500+

1000 .
500 .
0

-500F .
-1000 ¢ .

-1500 . : :
0

5
¥ 10

The residuals in the plot above can be computed as follows:

bushres = buchanan - feval(bushfit,bush);
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goreres = buchanan - feval(gorefit,gore);

Large residuals can be identified as those outside the range [ -500 500]:

bushoutliers excludedata(bush,bushres, 'range',[-500 500]);
goreoutliers = excludedata(gore,goreres, 'range',[-500 500]);

The outliers for the two data sets correspond to the following counties:

counties(bushoutliers)
ans =

‘Miami-Dade'

‘Palm Beach'

counties(goreoutliers)
ans =
'‘Broward’
‘Miami-Dade'
‘Palm Beach'

Miami-Dade and Broward counties correspond to the largest predictor values.
Palm Beach county, the only county in the state to use the “butterfly” ballot,
corresponds to the largest residual values.

Example: Specifying Fit Options
Create the default fit options structure and set the option to center and scale
the data before fitting:

options = fitoptions;
options.Normal = 'on';
options
options =
Normalize: 'on'
Exclude: [1x0 double]
Weights: [1x0 double]
Method: 'None’

Modifying the default fit options structure is useful when you want to set the
Normalize, Exclude, or Weights fields, and then fit your data using the same
options with different fitting methods. For example:
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load census

f1 = fit(cdate,pop, 'poly3',options);
f2 = fit(cdate,pop, 'expl1',options);
f3 = fit(cdate,pop, 'cubicsp',options);

Data-dependent fit options are returned in the third output argument of the
fit function. For example:

[f,g0f,out] fit(cdate,pop, 'smooth');

smoothparam = out.p

smoothparam
0.0089

The default smoothing parameter can be modified for a new fit:
options = fitoptions('Method', 'Smooth', 'SmoothingParam',0.0098);
[f,gof,out] = fit(cdate,pop, 'smooth',options);

Example: Robust Fitting
Create a baseline sinusoidal signal:

xdata = (0:0.1:2*pi)';
y0 = sin(xdata);

Add noise to the signal with non-constant variance:

% Response-dependent Gaussian noise
gnoise = y0.*randn(size(y0));

% Salt-and-pepper noise

spnoise = zeros(size(y0));

p = randperm(length(y0));

sppoints = p(1:round(length(p)/5));
spnoise(sppoints) = 5*sign(y0(sppoints));

ydata = y0 + gnoise + spnoise;

Fit the noisy data with a baseline sinusoidal model:

f = fittype('a*sin(b*x)"');
fit1 = fit(xdata,ydata,f,'StartPoint',[1 1]);
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Identify “outliers” as points at a distance greater than 1.5 standard deviations
from the baseline model, and refit the data with the outliers excluded:

fdata = feval(fit1,xdata);
I = abs(fdata - ydata) > 1.5*std(ydata);
outliers = excludedata(xdata,ydata, 'indices',I);

fit2 = fit(xdata,ydata,f, 'StartPoint’',[1 1], 'Exclude’',outliers);

Compare the effect of excluding the outliers with the effect of giving them

lower bisquare weight in a robust fit:

fit3 = fit(xdata,ydata,f, 'StartPoint',[1 1], 'Robust','on');

Plot the data, the outliers, and the results of the fits:

plot(fit1,'r-',xdata,ydata, 'k."',outliers, 'm*")
hold on

plot(fit2,'c--")

plot(fit3,'b:")

x1im ([0 2*pi])

g T . T T . .
#* +  data
6L * o + ¥ excluded data |
* #* fited curve
4l * fitted curve
""""" fitted curve
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Plot the residuals for the two fits considering outliers:

figure
plot(fit2,xdata,ydata,'co', 'residuals')
hold on
plot(fit3,xdata,ydata, 'bx', 'residuals')
6 T T T T T T
. X" B g daml
al zero line ||
w = data
zero line
2 % 1
H
Xx # ¥ w W o
0 X« * B wen ¥ Xxxx * 2 |
Koo w8 o
® ® x X
ot P i
4t . :
XX = X w
-6 1 1 1 1 1 1
0 1 2 3 4 5 4] 7
X

Example: Differentiating and Integrating a Fit
Create a baseline sinusoidal signal:

xdata = (0:.1:2*pi)';
y0 = sin(xdata);

Add noise to the signal:

noise = 2*y0.*randn(size(y0)); % Response-dependent noise
ydata = y0 + noise;

Fit the noisy data with a custom sinusoidal model:

f = fittype('a*sin(b*x)"');
fit1 = fit(xdata,ydata,f,'StartPoint',[1 1]);
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Find the derivatives of the fit at the predictors:

[d1,d2] = differentiate(fiti1,xdata);

Plot the data, the fit, and the derivatives:

subplot(3,1,1)

plot(fit1,xdata,ydata) % cfit plot method
subplot(3,1,2)

plot(xdata,d1,'m') % double plot method
grid on

legend('1st derivative')

subplot(3,1,3)

plot(xdata,d2,'c') % double plot method
grid on

legend('2nd derivative')
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Note that derivatives can also be computed and plotted directly with the
cfit plot method, as follows:

plot(fit1,xdata,ydata,{'fit', 'derivi', 'deriv2'})
The plot method, however, does not return data on the derivatives.

Find the integral of the fit at the predictors:
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int = integrate(fiti1,xdata,0);

Plot the data, the fit, and the integral:

subplot(2,1,1)

plot(fitl1,xdata,ydata) % cfit plot method
subplot(2,1,2)

plot(xdata,int,'m') % double plot method
grid on

legend('integral')
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Note that integrals can also be computed and plotted directly with the cfit
plot method, as follows:

plot(fiti,xdata,ydata,{'fit', 'integral'})

The plot method, however, does not return data on the integral.
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Example: Prediction Intervals
Generate data with an exponential trend:

x = (0:0.2:5)';
y 2*exp(-0.2*x) + 0.5*randn(size(x));

Fit the data using a single-term exponential:

fitresult = fit(x,y, ' 'expl');

Compute prediction intervals:

p11 = predint
pi2 predint
p21 predint
p22 = predint

fitresult,x,0.95, 'observation', 'off');
fitresult,x,0.95, 'observation','on');
fitresult,x,0.95, 'functional', 'off');
fitresult,x,0.95, 'functional','on');

—_~ o~~~

Plot the data, fit, and prediction intervals:

subplot(2,2,1)

plot(fitresult,x,y), hold on, plot(x,p11,'m--"), x1lim([O0 5])
title('Nonsimultaneous observation bounds', 'Color','m')
subplot(2,2,2)

plot(fitresult,x,y), hold on, plot(x,p12,'m--"'), x1lim([O0 5])
title('Simultaneous observation bounds', 'Color','m')
subplot(2,2,3)

plot(fitresult,x,y), hold on, plot(x,p21,'m--"), x1lim([O0 5])
title('Nonsimultaneous functional bounds', 'Color','m')
subplot(2,2,4)

plot(fitresult,x,y), hold on, plot(x,p22,'m--'), x1lim([O0 5])
title('Simultaneous functional bounds', 'Color','m')
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Monsimultaneous observation bounds
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Generating M-files From Curve Fitting Tool

In this section...

“Overview” on page 4-30

“The Generated M-file” on page 4-31

“Running the Generated M-file” on page 4-33
“Components of the Generated M-File” on page 4-35
“Modifying the Code” on page 4-38

This section describes how to generate and use MATLAB code from an
interactive session in Curve Fitting Tool.

For Surface Fitting Tool, see “Generating M-Files from the Surface Fitting
Tool” on page 3-43.

Overview

One way to quickly assemble curve fitting objects and methods into useful
programs is to generate an M-file from a session in Curve Fitting Tool. In this
way, interactive analysis of a single data set is transformed into a reusable
function for batch processing of multiple data sets. The generated M-file can
be used without modification, or it can be edited and customized as needed.

To generate an M-file from a session in Curve Fitting Tool, select the menu
item File > Generate M-file.

The M-file captures the following information from Curve Fitting Tool:

® Names of variables, fits, and residuals

* Fit options, such as whether the data should be normalized, initial values
for the coefficients, and the fitting method

e Curve fitting objects and methods used to create the fit

You can recreate your Curve Fitting Tool session by calling the M-file from
the command line with your original data as input arguments. You can also
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call the M-file with new data, applying the assembled curve fitting methods
to recompute curve fitting objects.

The Generated M-file

M-files generated from Curve Fitting Tool are constructed from building-block
components of code, which you can analyze, modify, and reuse in your own
M-files. The components of the generated M-file provide good examples of
how to assemble curve fitting objects and methods to perform basic tasks.
The larger M-file shows you how to assemble those tasks into a complete
analysis of your data.

For example, the following M-file was generated from a session in Curve
Fitting Tool that imported the data from census.mat and fit a custom
nonlinear model of the form y = a(x—b)%:

function myfit(cdate,pop)

SMYFIT Create plot of datasets and fits

MYFIT (CDATE,POP)

Creates a plot, similar to the plot in the main curve fitting
window, using the data that you provide as input. You can
apply this function to the same data you used with cftool

or with different data. You may want to edit the function to
customize the code and this help message.

® o° % ° o° o o°

o°

Number of datasets: 1
Number of fits: 1

o°

o°

Data from dataset "pop vs. cdate":

% X = cdate:
% Y = pop:
% Unweighted

o°

o°

This function was automatically generated on 11-Sep-2007 01:07:11

o°

Set up figure to receive datasets and fits

f_ = clf;

figure(f_);

set(f_, 'Units', 'Pixels', 'Position',[439.6 193.6 814.4 576.8]);
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legh_ = [1; legt_ = {}; % handles and text for legend
xlim_ = [Inf -Inf]; % limits of x axis
ax_ = axes;

se%(ax_,'Units','normalized','OuterPosition',[O 011]);
set(ax_, 'Box','on'");
axes(ax_); hold on;

% --- Plot data originally in dataset "pop vs. cdate"
cdate = cdate(:);
pop = pop(:);

h_ = line(cdate,pop, 'Parent',ax_, 'Color',[0.333333 0 0.666667],...

'LineStyle', 'none', 'LineWidth',1,...
'Marker',"'.', 'MarkerSize',12);
xlim_(1) = min(xlim_(1),min(cdate));
xlim_(2) = max(xlim_(2),max(cdate));
legh_(end+1) = h_;
legt {end+1} = 'pop vs. cdate';

% Nudge axis limits beyond data limits
if all(isfinite(x1lim_))
xlim_ = xlim_ + [-1 1] * 0.01 * diff(xlim_);
set(ax_, 'XLim',x1lim_)
else
set(ax_, 'XLim',[1788, 1992]);

end
% --- Create fit "fit 1"
ok_ = isfinite(cdate) & isfinite(pop);

if ~all( ok_ )
warning( 'GenerateMFile:IgnoringNansAndInfs',
‘Ignoring NaNs and Infs in data' );
end
st = [0.51510504095942344 0.35210694524343056 1];
ft_ = fittype('a*(x-b)"3',...
‘"dependent',{'y'}, 'independent',{'x"'},...
‘coefficients',{'a', 'b'});

% Fit this model using new data
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cf_ = fit(cdate(ok_),pop(ok_),ft ,'Startpoint',st );

% Or use coefficients from the original fit:

if 0
cv_ = { 1.3594203554767276e-005, 1724.6959436137356};
cf_ = cfit(ft_,cv_{:});

end

% Plot this fit
h_ = plot(cf_,'fit',0.95);
legend off; % turn off legend from plot method call
set(h_(1),'Color',[1 0 O],...
'LineStyle','-"', 'LineWidth',2,...
'Marker', 'none', 'MarkerSize',6);
legh_(end+1) h _(1);
legt {end+1} = 'fit 1';

% Done plotting data and fits. Now finish up loose ends.

hold off;

leginfo_ = {'Orientation', 'vertical', 'Location', 'NorthEast'};
h_ = legend(ax_,legh_,legt ,leginfo_{:}); % create legend
set(h_, 'Interpreter', 'none');

xlabel(ax_,"'"'); % remove x label

ylabel(ax_,"'"); % remove y label

A quick look through the code shows that it has automatically assembled
for you many of the Curve Fitting Toolbox curve fitting methods, such as
fitoptions, fittype, fit, and plot.

Running the Generated M-file

To run the generated M-file without modification, and reproduce your original
Curve Fitting Tool session, type:

load census
myfit(cdate,pop)
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To run the M-file without modification on new data, pass the new data to the
function as input arguments:

newpop = pop + 50*randn(size(pop));
myfit(cdate,newpop)
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The M-file recomputes the cfit object for the fit and displays the new data
with the new fit.

Components of the Generated M-File

It 1s useful to take a closer look at the components of the generated M-file, to
understand the role that each component plays in the overall visualization
and analysis of the data. This allows you to change the M-file, and customize
it to your needs.

The M-file begins with a function declaration:

function myfit(cdate,pop)

The function accepts predictor and response data for a predefined fit type.
The inputs are called cdate and pop because those were the predictor and
response variables used in Curve Fitting Tool session that produced the file.
If you like, you can find and replace the input names here and elsewhere in
the file to indicate a more generic application of the fit.

Note that the file, as generated, returns no outputs. It simply applies the fit
to the input data and displays the results.

The next component of the M-file, after the help information, is the following:

% Set up figure to receive datasets and fits

f_ = clf;

figure(f_);

set(f_, 'Units', 'Pixels', 'Position',[439.6 193.6 814.4 576.8]);
legh_ = [1; legt_ = {}; % handles and text for legend

xlim_ = [Inf -Inf]; % limits of x axis

ax_ = axes;

set(ax_, 'Units', 'normalized', 'OuterPosition',[0 O 1 1]);
set(ax_, 'Box','on'");

axes(ax_); hold on;

These are Handle Graphics® methods, applied to Handle Graphics objects
that encapsulate information on the display of the figure window, the legend,
and the axes. This component of the M-file creates a figure for plotting that
mimics the Plotting GUI in Curve Fitting Tool. Note that at the end of this
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component hold is toggled on. This allows the input data and the fit to be
plotted together on the axes.

The next component of the M-file plots the input data, using Handle Graphics
methods to set properties of the line object, the axes, and the legend that
mimic the plot in Curve Fitting Tool:

% --- Plot data originally in dataset "pop vs. cdate"
cdate = cdate(:);
pop = pop(:);

h_ = line(cdate,pop, 'Parent',ax_, 'Color',[0.333333 0 0.666667],...

'LineStyle', 'none', 'LineWidth',1,...
'Marker','."', 'MarkerSize',12);
x1lim_(1) = min(xlim_(1),min(cdate));
x1lim_(2) max (xlim_(2),max(cdate));
legh_(end+1) = h_;
legt_{end+1} = 'pop vs. cdate';

The next component “nudges” the x-axis limits, leaving a space of 1% of the x
data range between the data and the vertical axes. This gives a tight plot,
while preventing data from being plotted directly onto the vertical axes, where
it would be difficult to see.

% Nudge axis limits beyond data limits

if all(isfinite(x1lim_))
xlim_ = xlim_ + [-1 1] * 0.01 * diff(xlim_);
set(ax_, 'XLim',x1lim_)

else
set(ax_, 'XLim',[1788, 1992]);

end

After all of the preliminaries, the M-file gets down to the business of fitting
the data. The next component of the M-file uses fitoptions and fittype to
create a fit options structure fo_ and a fittype object ft_that encapsulate,
respectively, information on the fitting method and the model. The inputs to
fitoptions and fittype are read from the Fitting GUI in Curve Fitting Tool.

% --- Create fit "fit 1"
ok_ = isfinite(cdate) & isfinite(pop);
if ~all( ok_ )
warning( 'GenerateMFile:IgnoringNansAndInfs',
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‘Ignoring NaNs and Infs in data' );

end
st = [0.51510504095942344 0.35210694524343056 ];
ft_ = fittype('a*(x-b)"3',...

‘"dependent',{'y'}, 'independent',{'x'},...
‘coefficients',{'a', 'b'});

The fit method is then called to fit the predefined fit type to the input data.
Note that NaNs are removed from the data before the fit, using the logical
vector ok _ defined in the previous component.

% Fit this model using new data
cf_ = fit(cdate(ok_),pop(ok_),ft_, 'Startpoint',st_);

The next component of the M-file is a little obscure, since it uses a conditional
with a guard condition that is always false (0). This code is generated
intentionally, to give you the option of plotting the new input data against a
fit based on the old data (the data that was originally imported into Curve
Fitting Tool). To do so, simply change the 0 to true. The modified M-file then
uses the cfit method to set the coefficients of the cfit object cf_ to the
stored values computed with the old data. If you do not wish to do this, leave
this component of the M-file alone, or delete it.

% Or use coefficients from the original fit:

if 0
cv_ = { 1.3594203554767276e-005, 1724.6959436137356};
cf_ = cfit(ft_,cv_{:});

end

With the fitting complete, the M-file calls the plot method to plot the cfit
object cf_. Note that plot is called with the default plot type 'fit' (data
and fit), but is also passed a confidence level of 0.95. To use this confidence
level to plot prediction bounds for the fit or for new observations, change
'fit' to 'predfunc' or 'predobs', respectively. The rest of the code in this
component of the M-file is more Handle Graphics, along the lines of previous
components, setting Handle Graphics object properties that mimic the plot of
the fit in Curve Fitting Tool.

% Plot this fit

h_ = plot(cf_, 'fit',0.95);
legend off; % turn off legend from plot method call
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set(h_(1),'Color',[1 0 O],...
'LineStyle','-"', 'LineWidth',2,...
'Marker', 'none', 'MarkerSize',6);

legh_(end+1) = h_(1);

legt {end+1} = 'fit 1';

Finally, the M-file takes care of “loose ends”: hold is toggled off to its default
behavior, the legend is positioned, and the x and y labels ('x' and 'y' by
default) are removed.

% Done plotting data and fits. Now finish up loose ends.

hold off;

leginfo_ = {'Orientation', 'vertical', 'Location', 'NorthEast'};
h_ = legend(ax_,legh_,legt_,leginfo_{:}); % create legend
set(h_, 'Interpreter', 'none');

xlabel(ax_,"'"); % remove x label

ylabel(ax_,"'"); % remove y label

Modifying the Code

With an understanding of the components of the generated M-file, it is easy
to modify the code to produce a customized curve fit and display. The basic
structure of the M-file is already in place for you, and you can concentrate on
the details that interest you most.

A natural modification of the M-file would be to edit the function declaration
at the top of the file to return the cfit object cf_ created by the fit, as follows:

function cf_ = myfit2(cdate,pop)

Note the change in the function name from myfit to myfit2. The modified
M-file should then be saved to a file named myfit2.m.

You might also want to return goodness-of-fit statistics, which the M-file, by
default, does not compute. You would have to modify both the call to fit:

[cf_,gof] = fit(cdate(ok_),pop(ok_),ft_,fo_);

and the function declaration:

function [cf_,gof] = myfit2(cdate,pop)
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You might also want to alter the call to plot, say to show prediction intervals
for new observations:

h_ = plot(cf_, 'predobs',0.95);

Running the M-file with the above modifications on the new data from
“Running the Generated M-file” on page 4-33 produces the following output
to the command line:

[c,g] = myfit2(cdate,newpop)

C:
General model:
c(x) = a*(x-b)"3
Coefficients (with 95% confidence bounds):
a= 7.211e-006 (-2.389e-006, 1.681e-005)
b = 1670 (1548, 1792)
g:

sse: 5.5691e+004
rsquare: 0.6561
dfe: 19
adjrsquare: 0.6380
rmse: 54.1398

and the following display:
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Programmatic Surface Fitting

In this section...
“Surface Fitting Objects and Methods” on page 4-41

“Automotive Fuel Efficiency Programmatic Surface Fitting Example” on
page 4-42

“Biopharmaceutical Drug Interaction Programmatic Surface Fitting
Example” on page 4-53

Surface Fitting Objects and Methods

e “Overview” on page 4-41

e “Surface Fitting Objects and Methods” on page 4-41

This section describes how to use Curve Fitting Toolbox functions from the
command-line or to write programs for surface fitting applications.

Overview

One way to quickly assemble code for surface fits and plots into useful
programs is to generate an M-file from a session in Surface Fitting Tool. In
this way, you can transform your interactive analysis of a single data set
into a reusable function for command-line analysis or for batch processing of
multiple data sets. You can use the generated M-file without modification,
or edit and customize the code as needed. See “Generating M-Files from the
Surface Fitting Tool” on page 3-43.

Surface Fitting Objects and Methods

The surface fit object (sfit) stores the results from a surface fitting operation,
making it easy to plot and analyze fits at the command line.

Like cfit objects, sfit objects are a subclass of fittype objects, so they

inherit all the same methods of fittype. For a list of available methods,
see “Fit Type Methods” on page 6-2.
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sfit objects also provide methods exclusively for sfit objects, listed in the
table here: “Surface Fit Methods” on page 6-5.

See Chapter 6, “Function Reference” for information on all Curve Fitting
Toolbox functions, classes, and methods.

Automotive Fuel Efficiency Programmatic Surface
Fitting Example

® “Load and Preprocess Data” on page 4-43
* “Fit and Plot Surfaces of Fuel Efficiency” on page 4-44
e “Create a Table from the Surface” on page 4-48

Curve Fitting Toolbox software provides some example data generated from
a GTPOWER predictive combustion engine model. The model emulates a
naturally aspirated spark ignition, 2-liter, inline 4-cylinder engine. You can
use surface fitting methods to fit a response surface to this data to investigate
fuel efficiency.

The data set includes the following variables you need to model response
surfaces:

® Speed is in revolutions per minute (RPM) units.

e Load is the normalized cylinder air mass (the ratio of cylinder aircharge to
maximum naturally aspirated cylinder aircharge at standard temperature
and pressure).

e BSFC is the brake-specific fuel consumption in g/Kwh; that is, the energy
flow in divided by mechanical power out (fuel efficiency).

The aim is to model a response surface to find the minimum BSFC as a
function of speed and load. You can use this surface as a table, included as
part of a hybrid vehicle optimization algorithm combining the use of a motor
and your engine. To operate the engine as fuel efficiently as possible, the table
must operate the engine near the bottom of the BSFC bowl.
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Load and Preprocess Data
Follow these steps to load and process the data:

1 Load the data from the XLS spreadsheet. Use the 'basic' command
option for non- Windows® platforms.

Create a variable n that has all the numeric data in one array.

n = xls
II, Ib

read( 'Engine_Data_SI_NA 2L_I4.x1s', 'SI NA 2L I4',...
asic' );

2 Extract from the variable n the columns of interest:

SPEED =
LOAD_CM
LOAD =
BSFC

3 Process the
sweep. The

n(:,2);
D =n(:,3);
n(:,8);
n(:,22);

data before fitting, to pick out the min (BSFC) values from each
data points are organized insweeps on speed/load.

a Get a list of the speed/load sites:

SL =
nRuns

b For each

unique( [SPEED, LOAD_CMD], 'rows' );
= size( SL, 1 );

speed/load site, find the data at the site and extract the actual

measured load and the minimum BSFC.

minBS
Load
Speed
for i

i

m
L
S

end

FC = zeros( nRuns, 1 );
= zeros( nRuns, 1 );
= zeros( nRuns, 1 );
= 1:nRuns
dx = SPEED == SL(i,1) & LOAD_CMD == SL(1i,2);
inBSFC(i) = min( BSFC(idx) );
oad(1i) = mean( LOAD(idx) );
peed(1i) = mean( SPEED(idx) );
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Fit and Plot Surfaces of Fuel Efficiency
Follow these steps to fit and plot some surfaces:

1 Fit a surface to the preprocessed data.

f1 = fit( [Speed, Load], minBSFC, 'Lowess', 'Normalize', 'on'

This command results in the following output:

Locally weighted smoothing linear regression:

f1(x,y) = lowess (linear) smoothing regression

computed from p

where x is normalized by mean 3407 and std 1214

and where y is normalized by mean 0.5173 and std 0.1766
Coefficients:

p = coefficient structure

2 Plot your fit:

plot( f1, [Speed, Load], minBSFC );
xlabel( 'Speed [RPM]' );

ylabel( 'Load [%]' );

zlabel( 'Minimum BSFC [g/Kwh]' );
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3 Review the resulting plot:

¢ There are points where BSFC is negative because this data is generated
by an engine simulation.

¢ Remove those problem data points and keep points in the range [0,
Inf].

out = excludedata( Speed, minBSFC, 'Range', [0, Inf] );
f2 = fit( [Speed, Load], minBSFC, 'Lowess',
"Normalize', 'on', 'Exclude', out )

Examine the following output:

Locally weighted smoothing linear regression:
f2(x,y) = lowess (linear) smoothing regression
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computed from p

where x is normalized by mean 3443 and std 1187

and where y is normalized by mean 0.521 and std 0.175
Coefficients:

p = coefficient structure

4 Plot the new fit:

plot( f2, [Speed, Load], minBSFC, 'Exclude', out );
xlabel( 'Speed [RPM]' );

ylabel( 'Load [%]' );

zlabel( 'Minimum BSFC [g/Kwh]' );

5 Zoom in on the part of the z-axis of interest:

set( gca, 'ZLim', [0, max( minBSFC )] );
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6 Because you want to operate the engine efficiently, create a contour plot to
see the region where the BSFC is low. Use the plot command, and specify
the parameter/value pair 'style' 'Contour'.

plot( f2, [Speed, Load], minBSFC, 'Exclude', out,...
'Style', 'Contour' );

xlabel( 'Speed [RPM]' );

ylabel( 'Load [%]' );

colorbar
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Create a Table from the Surface
In this exercise, you generate a table from the original data using model f2.

1 Create variables for the table breakpoints.

speedbreakpoints = linspace( 1000, 5500, 17 );
loadbreakpoints = 1linspace( 0.2, 0.8, 13 );

2 To generate values for the table, evaluate the model over a grid of points.

[tSpeed, tLoad] = meshgrid( speedbreakpoints,...
loadbreakpoints );
tBSFC = f2( tSpeed, tLoad );



Programmatic Surface Fitting

3 Examine the rows and columns of the table at the command line.

tBSFC(1:2:end,1:2:end)

4 Plot the table against the original model. The grid on the model surface
shows the table breakpoints.

h = plot( f2 );
set( h, 'EdgeColor', 'none' );

hold on
mesh( tSpeed, tLoad, tBSFC,
‘LineStyle', '-', 'LineWidth', 2, 'EdgeColor', 'k',
'FaceColor', 'none', 'FaceAlpha'; 1 );
hold off

xlabel( 'Speed [RPM]' );
ylabel( 'Load [%]' );
zlabel( 'Minimum BSFC [g/Kwh]' );
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5 Check the table accuracy:

a View the difference between the model and the table by plotting the
difference between them on a finer grid.

b Then, use this difference in prediction accuracy between the table and

the model to determine the most efficient table size for your accuracy
requirements.

The following code evaluates the model over a finer grid and plots the
difference between the model and the table:

[tfSpeed, tfLoad] = meshgrid( linspace( 1000, 5500,...

8*17+1 ), linspace( 0.2, 0.8, 8*13+1 ) );
tfBSFC_model = f2( tfSpeed, tfLoad );
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tfBSFC_table = interp2( tSpeed, tLoad, tBSFC, tfSpeed,...
tfLoad, 'linear' );
tfDiff = tfBSFC_model - tfBSFC_table;

surf( tfSpeed, tfLoad, tfDiff, 'LineStyle', 'none' );
hold on
mesh( tSpeed, tLoad, zeros( size( tBSFC ) ),

'LineStyle', '-', 'LineWidth', 2, 'EdgeColor', 'k',
'FaceColor', 'none', 'FaceAlpha';, 1 );
hold off
axis tight

xlabel( 'Speed [RPM]' );

ylabel( 'Load [%]' );

zlabel( 'Difference between model and table [g/Kwh]' );

title( sprintf( 'Max difference: %g', max( abs( tfDiff(:) ) ) ) );
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6 If you have Simulink® software, you can create a Look Up Table block.

a Create a model with a Lookup Table (2-D) block.

simulink

new_system('my_model')

open_system('my_model")

add_block('Simulink/Lookup Tables/Lookup Table (2-D)',...
‘my_model/surfaceblock')

b Populate the Lookup Table with speed breakpoints, load breakpoints,
and a lookup table.

set_param('my_model/surfaceblock',...
"Rowindex', 'loadbreakpoints',...
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"Columnindex', 'speedbreakpoints’,...
'Table', 'tBSFC');

¢ Examine the populated Lookup Table block.

Biopharmaceutical Drug Interaction Programmatic
Surface Fitting Example

¢ “Load Data” on page 4-54

e “Create Model Fit Type” on page 4-54

¢ “Fit a Surface to Algometry” on page 4-54

¢ “Fit a Surface to Tetany” on page 4-56

¢ “Fit a Surface to Sedation” on page 4-56

¢ “Fit a Surface to Laryingoscopy” on page 4-57

Curve Fitting Toolbox provides some example data for an anesthesia drug
interaction study. You can use surface fitting methods to fit response surfaces
to this data to analyze drug interaction effects.

The following code, using Curve Fitting Toolbox methods, reproduces
the interactive surface building with Surface Fitting Tool described in
“Biopharmaceutical Interactive Surface Fitting Example” on page 3-20.

The data is based on the results in the following paper:

Kern SE, Xie G, White JL, Egan TD. Opioid-hypnotic synergy: A response
surface analysis of propofol-remifentanil pharmacodynamic interaction in
volunteers. Anesthesiology 2004; 100: 1373-81.

Anesthesia is typically at least a two-drug process, consisting of an opioid
and a sedative hypnotic. This example uses Propofol and Reminfentanil

as drug class prototypes. Their interaction is measured by four different
measures of the analgesic and sedative response to the drug combination.
Algometry, Tetany, Sedation and Laryingoscopy comprise the four measures
of surrogate drug effects at various concentration combinations of Propofol
and Reminfentanil.
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The following code models the response surfaces for this drug combination:

Load Data

Load the data from file as follows:

data = importdata( 'OpioidHypnoticSynergy.txt' );

Propofol = data.data(:,1);
Remifentanil = data.data(:,2);
Algometry = data.data(:,3);
Tetany = data.data(:,4);
Sedation = data.data(:,5);
Laryingoscopy = data.data(:,6);

Create Model Fit Type
Create the model fit type as follows:

ft = fittype( 'Emax*( CA/IC50A + CB/IC50B + alpha*( CA/IC50A
) * ( CB/IC50B ) )*n /(( CA/IC50A + CB/IC50B + alpha*(
CA/IC50A ) * ( CB/IC50B ) )"n + 1 )",

"indep', {'CA', 'CB'}, 'depend', 'z', 'problem', 'Emax' )

Output:
ft =
General model:
ft(IC50A,IC50B,alpha,n,Emax,CA,CB) = Emax*...
( CA/IC50A + CB/IC50B + alpha*(CA/IC50A )...

* ( CB/IC50B ) )"n /(( CA/IC50A + CB/IC50B...
+ alpha*( CA/IC50A ) * ( CB/IC50B ) )*n + 1)

Assume Emax =1

Emax = 1;

Fit a Surface to Algomeiry
Set fit options as follows:
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opts = fitoptions( ft );

opts.Lower = [0 O -5 -0];

opts.Robust = 'LAR';

opts.StartPoint = [0.00893838724332152 0.706165672266879. ..
1 0.746030748284422];

Fit and plot a surface for Algometry:

[f, gof] = fit( [Propofol, Remifentanil], Algometry, ft,...
opts, 'problem', Emax )
plot( f, [Propofol, Remifentanil], Algometry );

<) Figure 1 i ]
File Edit View Insert Tools Desktop Window Help u
Jcde | 3| RATDLEL-2|0HE =l
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Fit a Surface to Tetany
Fit a surface to Tetany as follows:

[f, gof] = fit( [Propofol, Remifentanil], Tetany,
ft, opts, 'problem', Emax )
plot( f, [Propofol, Remifentanil], Tetany );

<) Figure 1 ; =lolx]
File Edit View Insert Tools Desktop Window Help u
cde | | RATDLRL- 2| 0HE 80

Fit a Surface to Sedation
Fit a surface to Sedation as follows:

[f, gof] = fit( [Propofol, Remifentanil], Sedation,
ft, opts, 'problem', Emax )
plot( f, [Propofol, Remifentanil], Sedation );
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Fit a Surface to Laryingoscopy
Fit a surface to Laryingoscopy as follows:

[f, gof] = fit( [Propofol, Remifentanil], Laryingoscopy,
ft, opts, 'problem', Emax )
plot( f, [Propofol, Remifentanil], Laryingoscopy );
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e “Data Transformations” on page 5-2

¢ “Filtering and Smoothing” on page 5-4
e “Least-Squares Fitting” on page 5-16
e “Residual Analysis” on page 5-28

¢ “Interpolants” on page 5-45
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Data Transformations

5-2

Changing variables through data transformations may lead to a simplified
relationship between the transformed predictor variable and the transformed
response. As a result, model descriptions and predictions may be simplified.

Common transformations include the logarithm In(y), and power functions
such as y'2, y'1, and so on. Using these transformations, you can linearize a
nonlinear model, contract response data that spans one or more orders of
magnitude, or simplify a model so that it involves fewer coefficients.

Note You must transform variables at the MATLAB command line, and
then import those variables into Curve Fitting Tool. You cannot transform
variables using any of the graphical user interfaces.

For example, suppose you want to use the following model to fit your data.

1

y=——
ax +bx+e

If you decide to use the power transform y!, then the transformed model is
given by

2
Yy =ax +bx+e

As another example, the equation

bx
vy = ae

becomes linear if you take the log transform of both sides.
In(yv) = In(a) + bx
You can now use linear least-squares fitting procedures.

There are several disadvantages associated with performing transformations:
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® For the log transformation, negative response values cannot be processed.

e For all transformations, the basic assumption that the residual variance
1s constant is violated. To avoid this problem, you could plot the residuals
on the transformed scale. For the power transformation shown above, the
transformed scale 1s given by the residuals

-1 -
=X —-X

Note that the residual plot associated with Curve Fitting Tool does not
support transformed scales.

Deciding on a particular transformation is not always obvious. However,

a scatter plot will often reveal the best form to use. In practice you can
experiment with various transforms and then plot the residuals from the
command line using the transformed scale. If the errors are reasonable
(they appear random with minimal scatter, and don’t exhibit any systematic
behavior), the transform is a good candidate.

5-3
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Filtering and Smoothing

In this section...

“Moving Average Filtering” on page 5-4
“Savitzky-Golay Filtering” on page 5-6

“Local Regression Smoothing” on page 5-7

“Smoothing Splines” on page 5-13

Moving Average Filtering

A moving average filter smooths data by replacing each data point with the
average of the neighboring data points defined within the span. This process
is equivalent to lowpass filtering with the response of the smoothing given by
the difference equation

JS(E)—ENI 1[}(3+N}+j(E+N Ly+...+y(i-N))

where y (i) is the smoothed value for the ith data point, IV is the number of
neighboring data points on either side of y (i), and 2N+1 is the span.

The moving average smoothing method used by Curve Fitting Toolbox
software follows these rules:

® The span must be odd.

® The data point to be smoothed must be at the center of the span.

® The span is adjusted for data points that cannot accommodate the specified
number of neighbors on either side.

® The end points are not smoothed because a span cannot be defined.

Note that you can use filter function to implement difference equations such
as the one shown above. However, because of the way that the end points are
treated, the toolbox moving average result will differ from the result returned
by filter. Refer to Difference Equations and Filtering in the MATLAB
documentation for more information.
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For example, suppose you smooth data using a moving average filter with a
span of 5. Using the rules described above, the first four elements of y_ are
given by

Note that y_ (1), y,(2), ...
and not necessarily the original order.

|
—_—

(1
y(
y(
y(

)
1
1)+y
2

)ty (3)+y(4)+y(5))/5
)ty (3)+y(4)+y(5)+y(6))/5

,¥.(end) refer to the order of the data after sorting,

The smoothed values and spans for the first four data points of a generated

data set are shown below.
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Plot (a) indicates that the first data point is not smoothed because a span
cannot be constructed. Plot (b) indicates that the second data point is
smoothed using a span of three. Plots (¢) and (d) indicate that a span of five
is used to calculate the smoothed value.

Savitzky-Golay Filtering

Savitzky-Golay filtering can be thought of as a generalized moving average.
You derive the filter coefficients by performing an unweighted linear
least-squares fit using a polynomial of a given degree. For this reason, a
Savitzky-Golay filter is also called a digital smoothing polynomaial filter or a
least-squares smoothing filter. Note that a higher degree polynomial makes
it possible to achieve a high level of smoothing without attenuation of data
features.

The Savitzky-Golay filtering method is often used with frequency data or
with spectroscopic (peak) data. For frequency data, the method is effective at
preserving the high-frequency components of the signal. For spectroscopic
data, the method is effective at preserving higher moments of the peak such
as the line width. By comparison, the moving average filter tends to filter
out a significant portion of the signal’s high-frequency content, and it can
only preserve the lower moments of a peak such as the centroid. However,
Savitzky-Golay filtering can be less successful than a moving average filter
at rejecting noise.

The Savitzky-Golay smoothing method used by Curve Fitting Toolbox
software follows these rules:

® The span must be odd.

¢ The polynomial degree must be less than the span.

® The data points are not required to have uniform spacing.

Normally, Savitzky-Golay filtering requires uniform spacing of the
predictor data. However, the Curve Fitting Toolbox algorithm supports
nonuniform spacing. Therefore, you are not required to perform an
additional filtering step to create data with uniform spacing.

The plot shown below displays generated Gaussian data and several attempts
at smoothing using the Savitzky-Golay method. The data is very noisy and
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the peak widths vary from broad to narrow. The span is equal to 5% of the
number of data points.

Savitzky—Golay Smoothing
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Plot (a) shows the noisy data. To more easily compare the smoothed results,
plots (b) and (c) show the data without the added noise.

Plot (b) shows the result of smoothing with a quadratic polynomial. Notice
that the method performs poorly for the narrow peaks. Plot (¢) shows the
result of smoothing with a quartic polynomial. In general, higher degree

polynomials can more accurately capture the heights and widths of narrow
peaks, but can do poorly at smoothing wider peaks.

Local Regression Smoothing

* “Lowess and Loess” on page 5-8

5-7
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® “The Local Regression Method” on page 5-8
® “Robust Local Regression” on page 5-11

Lowess and Loess

The names “lowess” and “loess” are derived from the term “locally weighted
scatter plot smooth,” as both methods use locally weighted linear regression
to smooth data.

The smoothing process is considered local because, like the moving average
method, each smoothed value is determined by neighboring data points
defined within the span. The process is weighted because a regression
weight function is defined for the data points contained within the span.

In addition to the regression weight function, you can use a robust weight
function, which makes the process resistant to outliers. Finally, the methods
are differentiated by the model used in the regression: lowess uses a linear
polynomial, while loess uses a quadratic polynomial.

The local regression smoothing methods used by Curve Fitting Toolbox
software follow these rules:

® The span can be even or odd.

® You can specify the span as a percentage of the total number of data points
in the data set. For example, a span of 0.1 uses 10% of the data points.

The Local Regression Method

The local regression smoothing process follows these steps for each data point:

1 Compute the regression weights for each data point in the span. The
weights are given by the tricube function shown below.

aja

d(x)

w.=[1_

L

x 1s the predictor value associated with the response value to be smoothed,
x, are the nearest neighbors of x as defined by the span, and d(x) is the
distance along the abscissa from x to the most distant predictor value
within the span. The weights have these characteristics:
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® The data point to be smoothed has the largest weight and the most
influence on the fit.

® Data points outside the span have zero weight and no influence on the fit.

2 A weighted linear least-squares regression is performed. For lowess, the
regression uses a first degree polynomial. For loess, the regression uses a
second degree polynomial.

3 The smoothed value is given by the weighted regression at the predictor
value of interest.

If the smooth calculation involves the same number of neighboring data points
on either side of the smoothed data point, the weight function is symmetric.
However, if the number of neighboring points is not symmetric about the
smoothed data point, then the weight function is not symmetric. Note that
unlike the moving average smoothing process, the span never changes. For
example, when you smooth the data point with the smallest predictor value,
the shape of the weight function is truncated by one half, the leftmost data
point in the span has the largest weight, and all the neighboring points are
to the right of the smoothed value.

5-9
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The weight function for an end point and for an interior point is shown below
for a span of 31 data points.

Local Regression Weight Function
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Using the lowess method with a span of five, the smoothed values and
associated regressions for the first four data points of a generated data set
are shown below.

5-10
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Notice that the span does not change as the smoothing process progresses
from data point to data point. However, depending on the number of nearest
neighbors, the regression weight function might not be symmetric about the
data point to be smoothed. In particular, plots (a) and (b) use an asymmetric
weight function, while plots (c¢) and (d) use a symmetric weight function.

For the loess method, the graphs would look the same except the smoothed
value would be generated by a second-degree polynomial.

Robust Local Regression

If your data contains outliers, the smoothed values can become distorted,
and not reflect the behavior of the bulk of the neighboring data points. To
overcome this problem, you can smooth the data using a robust procedure that

5-11
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is not influenced by a small fraction of outliers. For a description of outliers,
refer to “Marking Outliers” on page 2-38.

Curve Fitting Toolbox software provides a robust version for both the lowess
and loess smoothing methods. These robust methods include an additional

calculation of robust weights, which is resistant to outliers. The robust

smoothing procedure follows these steps:

1 Calculate the residuals from the smoothing procedure described in the
previous section.

2 Compute the robust weights for each data point in the span. The weights
are given by the bisquare function shown below.
g 2
[(1 ~(r,/6MAD)")" |r,|<6MAD
w, =
0 |r;| = 6MAD

r,is the residual of the ith data point produced by the regression smoothing
procedure, and MAD is the median absolute deviation of the residuals:

MAD = median(|r])

The median absolute deviation is a measure of how spread out the residuals
are. If r, is small compared to 6/MMAD, then the robust weight is close to 1.
If r, is greater than 6MAD, the robust weight is 0 and the associated data
point is excluded from the smooth calculation.

3 Smooth the data again using the robust weights. The final smoothed value
1s calculated using both the local regression weight and the robust weight.

4 Repeat the previous two steps for a total of five iterations.

The smoothing results of the lowess procedure are compared below to the
results of the robust lowess procedure for a generated data set that contains a
single outlier. The span for both procedures is 11 data points.
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Robust Lowess Smoothing
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Plot (a) shows that the outlier influences the smoothed value for several
nearest neighbors. Plot (b) suggests that the residual of the outlier is greater
than six median absolute deviations. Therefore, the robust weight is zero for
this data point. Plot (c) shows that the smoothed values neighboring the
outlier reflect the bulk of the data.

Smoothing Splines

If your data is noisy, you might want to fit it using a smoothing spline.
Alternatively, you can use one of the smoothing methods described in
“Smoothing Data” on page 2-28.

The smoothing spline s is constructed for the specified smoothing parameter p
and the specified weights w,. The smoothing spline minimizes

5-13
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2 .2
pY w3~ s ()’ + (1-p) j—sz dx
i X

If the weights are not specified, they are assumed to be 1 for all data points.

p is defined between 0 and 1. p = 0 produces a least-squares straight-line
fit to the data, while p = 1 produces a cubic spline interpolant. If you do
not specify the smoothing parameter, it is automatically selected in the
“Interesting range.” The interesting range of p is often near 1/(1+h3/6) where
h is the average spacing of the data points, and it is typically much smaller
than the allowed range of the parameter. Because smoothing splines have
an associated smoothing parameter, you might consider these fits to be
parametric in that sense. However, smoothing splines are also piecewise
polynomials like cubic spline or shape-preserving interpolants and are
considered a nonparametric fit type in this guide.

Note The Curve Fitting Toolbox smoothing spline algorithm is based on
the Spline Toolbox™ csaps function.

The nuclear reaction data from the file carbon12alpha.mat is shown below
with three smoothing spline fits. The default smoothing parameter (p = 0.99)
produces the smoothest curve. The cubic spline curve (p = 1) goes through
all the data points, but i1s not quite as smooth. The third curve (p = 0.95)
misses the data by wide margin and illustrates how small the “interesting
range” of p can be.
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Least-Squares Fitting
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In this section...

“Introduction” on page 5-16

“Error Distributions” on page 5-17
“Linear Least Squares” on page 5-18
“Weighted Least Squares” on page 5-21
“Robust Least Squares” on page 5-23

“Nonlinear Least Squares” on page 5-25

Introduction

Curve Fitting Toolbox software uses the method of least squares when fitting
data. Fitting requires a parametric model that relates the response data to
the predictor data with one or more coefficients. The result of the fitting
process is an estimate of the model coefficients.

To obtain the coefficient estimates, the least-squares method minimizes the

summed square of residuals. The residual for the ith data point r, is defined as
the difference between the observed response value y, and the fitted response

value j"i, and is identified as the error associated with the data.
ry=%-Y
residual = data —fit

The summed square of residuals is given by

where n is the number of data points included in the fit and S is the sum of
squares error estimate. The supported types of least-squares fitting include:

¢ Linear least squares
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* Weighted linear least squares
® Robust least squares

® Nonlinear least squares

Error Distributions

When fitting data that contains random variations, there are two important
assumptions that are usually made about the error:

® The error exists only in the response data, and not in the predictor data.

® The errors are random and follow a normal (Gaussian) distribution with
zero mean and constant variance, o2.

The second assumption is often expressed as
2
error - N(0, )

The errors are assumed to be normally distributed because the normal
distribution often provides an adequate approximation to the distribution
of many measured quantities. Although the least-squares fitting method
does not assume normally distributed errors when calculating parameter
estimates, the method works best for data that does not contain a large
number of random errors with extreme values. The normal distribution is
one of the probability distributions in which extreme random errors are
uncommon. However, statistical results such as confidence and prediction
bounds do require normally distributed errors for their validity.

If the mean of the errors is zero, then the errors are purely random. If the
mean is not zero, then it might be that the model is not the right choice for
your data, or the errors are not purely random and contain systematic errors.

A constant variance in the data implies that the “spread” of errors is constant.
Data that has the same variance is sometimes said to be of equal quality.

The assumption that the random errors have constant variance is not implicit
to weighted least-squares regression. Instead, it is assumed that the weights
provided in the fitting procedure correctly indicate the differing levels of
quality present in the data. The weights are then used to adjust the amount

5-17
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of influence each data point has on the estimates of the fitted coefficients to
an appropriate level.

Linear Least Squares

Curve Fitting Toolbox software uses the linear least-squares method to fit a
linear model to data. A linear model is defined as an equation that is linear in
the coefficients. For example, polynomials are linear but Gaussians are not.
To illustrate the linear least-squares fitting process, suppose you have n data
points that can be modeled by a first-degree polynomial.

Y = px+pg

To solve this equation for the unknown coefficients p, and p,, you write S
as a system of n simultaneous linear equations in two unknowns. If n is
greater than the number of unknowns, then the system of equations is
overdetermined.

S= Y (v~ (pyx;+ pg))’
i=1

Because the least-squares fitting process minimizes the summed square of
the residuals, the coefficients are determined by differentiating S with respect
to each parameter, and setting the result equal to zero.

aS .
m = -2 Z x;(y; —(p1x;+ pg)) = 0

i=1
s n
E = _zigl(}'i_(pj_xi+pg)} =0

The estimates of the true parameters are usually represented by b.
Substituting b, and b, for p, and p,, the previous equations become
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Y x(y;—(byx;+ by)) = 0
D (= (byx; +by)) = 0

where the summations run from i =1 to n. The normal equations are defined as

blzx?+b22xi = inj'i
blz;xi+nb2 = Zh
Solving for b,
by = nY AN = DX DY
an?—(in)E

Solving for b, using the b, value

by = }1(23’1—5’12%}

As you can see, estimating the coefficients p, and p, requires only a few
simple calculations. Extending this example to a higher degree polynomial is
straightforward although a bit tedious. All that is required is an additional
normal equation for each linear term added to the model.

In matrix form, linear models are given by the formula
vy =Xp+e
where

® yis an n-by-I vector of responses.
® B1is a m-by-1 vector of coefficients.
® X is the n-by-m design matrix for the model.

® ¢is an n-by-1 vector of errors.

5-19
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For the first-degree polynomial, the n equations in two unknowns are
expressed in terms of y, X, and B as

v xq 1
3 B 3 pl
= %
Py
v, % 1_

The least-squares solution to the problem is a vector b, which estimates the
unknown vector of coefficients B. The normal equations are given by

T T

(X X)b = Xy

where X' is the transpose of the design matrix X. Solving for b,
T 1T

b=(X"X) X'y
Use the MATLAB backslash operator (mldivide) to solve a system of
simultaneous linear equations for unknown coefficients. Because inverting
X"X can lead to unacceptable rounding errors, the backslash operator uses QR
decomposition with pivoting, which is a very stable algorithm numerically.
Refer to Arithmetic Operators in the MATLAB documentation for more

information about the backslash operator and @R decomposition.

You can plug b back into the model formula to get the predicted response
values, .

¥ = Xb = Hy
-1
H-xxTx)y x¥


file:///B:/matlab/doc/src/toolbox/techdoc/ref/arithmeticoperators.html

Least-Squares Fitting

A hat (circumflex) over a letter denotes an estimate of a parameter or a
prediction from a model. The projection matrix H is called the hat matrix,
because it puts the hat on y.

The residuals are given by

r=y-3 = (1-Hy

Weighted Least Squares

It is usually assumed that the response data 1is of equal quality and, therefore,
has constant variance. If this assumption is violated, your fit might be unduly
influenced by data of poor quality. To improve the fit, you can use weighted
least-squares regression where an additional scale factor (the weight) is
included in the fitting process. Weighted least-squares regression minimizes
the error estimate

where w, are the weights. The weights determine how much each response
value influences the final parameter estimates. A high-quality data point
influences the fit more than a low-quality data point. Weighting your data
is recommended if the weights are known, or if there is justification that
they follow a particular form.

The weights modify the expression for the parameter estimates b in the
following way,

- T -1_7
b =P = (XTWX) XTwy
where Wis given by the diagonal elements of the weight matrix w.

You can often determine whether the variances are not constant by fitting the
data and plotting the residuals. In the plot shown below, the data contains
replicate data of various quality and the fit is assumed to be correct. The poor
quality data is revealed in the plot of residuals, which has a “funnel” shape
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where small predictor values yield a bigger scatter in the response values
than large predictor values.
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The weights you supply should transform the response variances to a constant
value. If you know the variances of the measurement errors in your data,
then the weights are given by

2
Ww; = lfr:si-

Or, if you only have estimates of the error variable for each data point, it
usually suffices to use those estimates in place of the true variance. If you

do not know the variances, it suffices to specify weights on a relative scale.
Note that an overall variance term is estimated even when weights have been
specified. In this instance, the weights define the relative weight to each point
in the fit, but are not taken to specify the exact variance of each point.
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For example, if each data point is the mean of several independent
measurements, it might make sense to use those numbers of measurements
as weights.

Robust Least Squares

It 1s usually assumed that the response errors follow a normal distribution,
and that extreme values are rare. Still, extreme values called outliers do occur.

The main disadvantage of least-squares fitting is its sensitivity to outliers.
Outliers have a large influence on the fit because squaring the residuals
magnifies the effects of these extreme data points. To minimize the influence
of outliers, you can fit your data using robust least-squares regression. The
toolbox provides these two robust regression methods:

® Least absolute residuals (LAR) — The LAR method finds a curve that
minimizes the absolute difference of the residuals, rather than the squared
differences. Therefore, extreme values have a lesser influence on the fit.

® Bisquare weights — This method minimizes a weighted sum of squares,
where the weight given to each data point depends on how far the point
is from the fitted line. Points near the line get full weight. Points farther
from the line get reduced weight. Points that are farther from the line than
would be expected by random chance get zero weight.

For most cases, the bisquare weight method is preferred over LAR because
it simultaneously seeks to find a curve that fits the bulk of the data using
the usual least-squares approach, and it minimizes the effect of outliers.

Robust fitting with bisquare weights uses an iteratively reweighted
least-squares algorithm, and follows this procedure:

1 Fit the model by weighted least squares.

2 Compute the adjusted residuals and standardize them. The adjusted
residuals are given by

5-23
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r, are the usual least-squares residuals and h; are leverages that adjust
the residuals by down-weighting high-leverage data points, which have a
large effect on the least-squares fit. The standardized adjusted residuals
are given by

ra,ﬂ'j

uzK&

K is a tuning constant equal to 4.685, and s is the robust variance given by
MADI0.6745 where MAD is the median absolute deviation of the residuals.

3 Compute the robust weights as a function of u. The bisquare weights are
given by

w, =

g 2
[(l—w ) iy < 1
0 |ut| =1
Note that if you supply your own regression weight vector, the final weight

is the product of the robust weight and the regression weight.

4 If the fit converges, then you are done. Otherwise, perform the next
iteration of the fitting procedure by returning to the first step.

The plot shown below compares a regular linear fit with a robust fit using

bisquare weights. Notice that the robust fit follows the bulk of the data and is
not strongly influenced by the outliers.
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Instead of minimizing the effects of outliers by using robust regression, you
can mark data points to be excluded from the fit. Refer to “Excluding and
Sectioning Data” on page 2-36 for more information.

Nonlinear Least Squares

Curve Fitting Toolbox software uses the nonlinear least-squares formulation
to fit a nonlinear model to data. A nonlinear model is defined as an equation
that is nonlinear in the coefficients, or a combination of linear and nonlinear
in the coefficients. For example, Gaussians, ratios of polynomials, and power
functions are all nonlinear.

In matrix form, nonlinear models are given by the formula
v = f(X,P)+e

where
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® yis an n-by-I vector of responses.
® fis a function of B and X.

® B1is a m-by-1 vector of coefficients.

X is the n-by-m design matrix for the model.

® ¢is an n-by-I vector of errors.

Nonlinear models are more difficult to fit than linear models because the
coefficients cannot be estimated using simple matrix techniques. Instead, an
iterative approach is required that follows these steps:

1 Start with an initial estimate for each coefficient. For some nonlinear
models, a heuristic approach is provided that produces reasonable starting
values. For other models, random values on the interval [0,1] are provided.

2 Produce the fitted curve for the current set of coefficients. The fitted
response value ¥ is given by

y=rf(X0b)

and involves the calculation of the Jacobian of f(X,b), which is defined as a
matrix of partial derivatives taken with respect to the coefficients.

3 Adjust the coefficients and determine whether the fit improves. The
direction and magnitude of the adjustment depend on the fitting algorithm.
The toolbox provides these algorithms:

¢ Trust-region — This is the default algorithm and must be used if
you specify coefficient constraints. It can solve difficult nonlinear
problems more efficiently than the other algorithms and it represents an
improvement over the popular Levenberg-Marquardt algorithm.

¢ Levenberg-Marquardt — This algorithm has been used for many years
and has proved to work most of the time for a wide range of nonlinear
models and starting values. If the trust-region algorithm does not
produce a reasonable fit, and you do not have coefficient constraints, you
should try the Levenberg-Marquardt algorithm.

¢ Gauss-Newton — This algorithm is potentially faster than the other
algorithms, but it assumes that the residuals are close to zero. It’s
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included with the toolbox for pedagogical reasons and should be the last
choice for most models and data sets.

4 Iterate the process by returning to step 2 until the fit reaches the specified
convergence criteria.

You can use weights and robust fitting for nonlinear models, and the fitting
process is modified accordingly.

Because of the nature of the approximation process, no algorithm is foolproof
for all nonlinear models, data sets, and starting points. Therefore, if you do
not achieve a reasonable fit using the default starting points, algorithm, and
convergence criteria, you should experiment with different options. Refer to
“Specifying Fit Options” on page 2-78 for a description of how to modify the
default options. Because nonlinear models can be particularly sensitive to the
starting points, this should be the first fit option you modify.
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In this section...

“Introduction” on page 5-28
“Computing Residuals” on page 5-29
“Goodness-of-Fit Statistics” on page 5-31

“Confidence and Prediction Bounds” on page 5-34

“Example: Residual Analysis” on page 5-39

Introduction

After fitting data with one or more models, you should evaluate the goodness
of fit. A visual examination of the fitted curve displayed in Curve Fitting Tool
should be your first step. Beyond that, the toolbox provides these methods to
assess goodness of fit for both linear and nonlinear parametric fits:

® Residual analysis
® Goodness of fit statistics
¢ (Confidence and prediction bounds

As 1s common in statistical literature, the term goodness of fit is used here
in several senses: A “good fit” might be a model

e that your data could reasonably have come from, given the assumptions of
least-squares fitting

® in which the model coefficients can be estimated with little uncertainty

® that explains a high proportion of the variability in your data, and is able
to predict new observations with high certainty

A particular application might dictate still other aspects of model fitting that
are important to achieving a good fit, such as a simple model that is easy to
interpret. The methods described here can help you determine goodness of
fit in all these senses.
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These methods group into two types: graphical and numerical. Plotting
residuals and prediction bounds are graphical methods that aid visual
interpretation, while computing goodness-of-fit statistics and coefficient
confidence bounds yield numerical measures that aid statistical reasoning.

Generally speaking, graphical measures are more beneficial than numerical
measures because they allow you to view the entire data set at once, and they
can easily display a wide range of relationships between the model and the
data. The numerical measures are more narrowly focused on a particular
aspect of the data and often try to compress that information into a single
number. In practice, depending on your data and analysis requirements, you
might need to use both types to determine the best fit.

Note that it is possible that none of your fits can be considered suitable for
your data, based on these methods. In this case, it might be that you need

to select a different model. It is also possible that all the goodness-of-fit
measures indicate that a particular fit is suitable. However, if your goal is to
extract fitted coefficients that have physical meaning, but your model does
not reflect the physics of the data, the resulting coefficients are useless. In
this case, understanding what your data represents and how it was measured
1s just as important as evaluating the goodness of fit.

Computing Residuals

The residuals from a fitted model are defined as the differences between the
response data and the fit to the response data at each predictor value.

residual = data — fit

You display the residuals in Curve Fitting Tool by selecting the menu item
View > Residuals.

Mathematically, the residual for a specific predictor value is the difference
between the response value y and the predicted response value ¥.

r=y-3y
Assuming the model you fit to the data is correct, the residuals approximate

the random errors. Therefore, if the residuals appear to behave randomly, it
suggests that the model fits the data well. However, if the residuals display
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a systematic pattern, it is a clear sign that the model fits the data poorly.
Always bear in mind that many results of model fitting, such as confidence
bounds, will be invalid should the model be grossly inappropriate for the data.

A graphical display of the residuals for a first degree polynomial fit is shown
below. The top plot shows that the residuals are calculated as the vertical
distance from the data point to the fitted curve. The bottom plot displays the
residuals relative to the fit, which is the zero line.
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The residuals appear randomly scattered around zero indicating that the
model describes the data well.
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A graphical display of the residuals for a second-degree polynomial fit is
shown below. The model includes only the quadratic term, and does not
include a linear or constant term.
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The residuals are systematically positive for much of the data range indicating
that this model is a poor fit for the data.

Goodness-of-Fit Statistics
After using graphical methods to evaluate the goodness of fit, you should

examine the goodness-of-fit statistics. Curve Fitting Toolbox software
supports these goodness-of-fit statistics for parametric models:

¢ The sum of squares due to error (SSE)

® R-square

® Adjusted R-square

® Root mean squared error (RMSE)
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For the current fit, these statistics are displayed in the Results list box in the
Fit Editor. For all fits in the current curve-fitting session, you can compare
the goodness-of-fit statistics in the Table of fits.

Sum of Squares Due to Error

This statistic measures the total deviation of the response values from the
fit to the response values. It is also called the summed square of residuals
and is usually labeled as SSE.

n
)
SSE = ) w,(3;,-5;)
i=1

A value closer to 0 indicates that the model has a smaller random error
component, and that the fit will be more useful for prediction.

R-Square

This statistic measures how successful the fit is in explaining the variation of
the data. Put another way, R-square is the square of the correlation between
the response values and the predicted response values. It is also called the
square of the multiple correlation coefficient and the coefficient of multiple
determination.

R-square is defined as the ratio of the sum of squares of the regression (SSR)
and the total sum of squares (SST). SSR is defined as

n
N _.2
SSR = ) w(5;-¥)
i=1
SSTis also called the sum of squares about the mean, and is defined as

n
.2
SST = Y w,(y;-5)
i=1

where SST = SSR + SSE. Given these definitions, R-square is expressed as
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R-square = S8R _ 1 SSE

S58T SST

R-square can take on any value between 0 and 1, with a value closer to 1
indicating that a greater proportion of variance is accounted for by the model.
For example, an R-square value of 0.8234 means that the fit explains 82.34%
of the total variation in the data about the average.

If you increase the number of fitted coefficients in your model, R-square will
increase although the fit may not improve in a practical sense. To avoid this
situation, you should use the degrees of freedom adjusted R-square statistic
described below.

Note that it is possible to get a negative R-square for equations that do not
contain a constant term. Because R-square is defined as the proportion of

variance explained by the fit, if the fit is actually worse than just fitting a

horizontal line then R-square is negative. In this case, R-square cannot be
interpreted as the square of a correlation. Such situations indicate that a

constant term should be added to the model.

Degrees of Freedom Adjusted R-Square

This statistic uses the R-square statistic defined above, and adjusts it based
on the residual degrees of freedom. The residual degrees of freedom is defined
as the number of response values n minus the number of fitted coefficients m
estimated from the response values.

v=n-m

v indicates the number of independent pieces of information involving the

n data points that are required to calculate the sum of squares. Note that

if parameters are bounded and one or more of the estimates are at their
bounds, then those estimates are regarded as fixed. The degrees of freedom is
increased by the number of such parameters.

The adjusted R-square statistic is generally the best indicator of the fit quality
when you compare two models that are nested — that is, a series of models
each of which adds additional coefficients to the previous model.
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SSE(n—1)

adjusted Rsquare = 1-— SST®)

The adjusted R-square statistic can take on any value less than or equal to
1, with a value closer to 1 indicating a better fit. Negative values can occur
when the model contains terms that do not help to predict the response.

Root Mean Squared Error

This statistic is also known as the fit standard error and the standard error
of the regression. It is an estimate of the standard deviation of the random
component in the data, and is defined as

RMSE = s = JMSE

where MSE is the mean square error or the residual mean square

MSE =
U

Just as with SSE, an MSE value closer to 0 indicates a fit that is more useful
for prediction.

Confidence and Prediction Bounds

Curve Fitting Toolbox software lets you calculate confidence bounds for the
fitted coefficients, and prediction bounds for new observations or for the fitted
function. Additionally, for prediction bounds, you can calculate simultaneous
bounds, which take into account all predictor values, or you can calculate
nonsimultaneous bounds, which take into account only individual predictor
values. The coefficient confidence bounds are presented numerically, while
the prediction bounds are displayed graphically and are also available
numerically.

The available confidence and prediction bounds are summarized below.
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Types of Confidence and Prediction Bounds

Interval Type Description

Fitted coefficients Confidence bounds for the fitted coefficients

New observation Prediction bounds for a new observation (response
value)

New function Prediction bounds for a new function value

Note Prediction bounds are also often described as confidence bounds because
you are calculating a confidence interval for a predicted response.

Confidence and prediction bounds define the lower and upper values of the
associated interval, and define the width of the interval. The width of the
interval indicates how uncertain you are about the fitted coefficients, the
predicted observation, or the predicted fit. For example, a very wide interval
for the fitted coefficients can indicate that you should use more data when
fitting before you can say anything very definite about the coefficients.

The bounds are defined with a level of certainty that you specify. The level of
certainty is often 95%, but it can be any value such as 90%, 99%, 99.9%, and
so on. For example, you might want to take a 5% chance of being incorrect
about predicting a new observation. Therefore, you would calculate a 95%
prediction interval. This interval indicates that you have a 95% chance

that the new observation is actually contained within the lower and upper
prediction bounds.

Calculating and Displaying Confidence Bounds
The confidence bounds for fitted coefficients are given by

C = b+ tS

where b are the coefficients produced by the fit, ¢ depends on the confidence
level, and is computed using the inverse of Student’s t cumulative distribution
function, and S is a vector of the diagonal elements from the estimated
covariance matrix of the coefficient estimates, (XTX)1s2. In a linear fit, X is
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the design matrix, while for a nonlinear fit X is the Jacobian of the fitted
values with respect to the coefficients. XT is the transpose of X, and s? is the
mean squared error.

The confidence bounds are displayed in the Results list box in the Fit Editor
using the following format.

pl = 1.275 (1.113, 1.437)

The fitted value for the coefficient p1 is 1.275, the lower bound is 1.113,

the upper bound is 1.437, and the interval width is 0.324. By default, the
confidence level for the bounds is 95%. You can change this level to any value
with the View > Confidence Level menu item in Curve Fitting Tool.

You can calculate confidence intervals at the command line with the confint
function.

Calculating and Displaying Prediction Bounds

As mentioned previously, you can calculate prediction bounds for a new
observation or for the fitted curve. In both cases, the prediction is based on
an existing fit to the data. Additionally, the bounds can be simultaneous
and measure the confidence for all predictor values, or they can be
nonsimultaneous and measure the confidence only for a single predetermined
predictor value. If you are predicting a new observation, nonsimultaneous
bounds measure the confidence that the new observation lies within the
interval given a single predictor value. Simultaneous bounds measure the
confidence that a new observation lies within the interval regardless of the
predictor value.

The nonsimultaneous prediction bounds for a new observation at the predictor
value x are given by

P,,=43% ta.l'sz +xSx’

where s? is the mean squared error, ¢t depends on the confidence level, and is
computed using the inverse of Student’s ¢ cumulative distribution function,
and S is the covariance matrix of the coefficient estimates, (XTX)1s2. Note



Residual Analysis

that x 1s defined as a row vector of the design matrix or Jacobian evaluated at
a specified predictor value.

The simultaneous prediction bounds for a new observation and for all
predictor values are given by

P,, = §tfds +xSx

where f depends on the confidence level, and is computed using the inverse of
the F cumulative distribution function.

The nonsimultaneous prediction bounds for the function at a single predictor
value x are given by

The simultaneous prediction bounds for the function and for all predictor
values are given by

You can graphically display prediction bounds two ways: using Curve
Fitting Tool or using the Analysis GUI. With Curve Fitting Tool, you can
display nonsimultaneous prediction bounds for new observations with
View > Prediction Bounds. By default, the confidence level for the bounds
1s 95%. You can change this level to any value with View > Confidence
Level. With the Analysis GUI, you can display nonsimultaneous prediction
bounds for the function or for new observations. Additionally, you can view
prediction bounds in the Results box of the Analysis GUI.

You can display numerical prediction bounds of any type at the command line
with the predint function.

To understand the quantities associated with each type of prediction interval,
recall that the data, fit, and residuals are related through the formula

data = fit + residuals
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where the fit and residuals terms are estimates of terms in the formula
data = model + random error

Suppose you plan to take a new observation at the predictor value x Call

the new observation y, ,,(x,,,) and the associated error ¢,,,. Then

n+l*

Yn1sr) = fX,00) + €,
where f(x,,,) is the true but unknown function you want to estimate at x,, .
The likely values for the new observation or for the estimated function are

provided by the nonsimultaneous prediction bounds.

If instead you want the likely value of the new observation to be associated
with any predictor value, the previous equation becomes

V(@) = flx) + &

The likely values for this new observation or for the estimated function are
provided by the simultaneous prediction bounds.

The types of prediction bounds are summarized below.

Types of Prediction Bounds

Simultaneous or

Type of Bound Non-simultaneous Associated Equation
Observation Non-simultaneous Vo1 (%40

Simultaneous Yo @), for all x
Function Non-simultaneous fx,.1)

Simultaneous f(x), for all x

The nonsimultaneous and simultaneous prediction bounds for a new
observation and the fitted function are shown below. Each graph contains
three curves: the fit, the lower confidence bounds, and the upper confidence
bounds. The fit is a single-term exponential to generated data and the bounds
reflect a 95% confidence level. Note that the intervals associated with a

new observation are wider than the fitted function intervals because of the
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additional uncertainty in predicting a new response value (the curve plus
random errors).

Monsimultaneous observation bounds Simultaneous observation bounds
3 3
+«  data - +  data
e _ -
L fitted curve LA fitted curve

X ¥
Monsimultaneous functional bounds Simultaneous functional bounds
25 25
\} . + data + +  data
2 fitted curve | * fitted curve (4
N 2

Example: Residual Analysis

This example fits several polynomial models to generated data and evaluates
how well those models fit the data and how precisely they can predict. The
data is generated from a cubic curve, and there is a large gap in the range of
the x variable where no data exist.

x
1l

[1:0.1:3 9:0.1:10]";
= [2.5 -0.5 1.3 -0.1];

(@]
|
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y = c(1) + c(2)*x + ¢c(3)*x."2 + ¢c(4)*x.”3 + (rand(size(x))-0.5);

After you import the data, fit it using a cubic polynomial and a fifth degree
polynomial. The data, fits, and residuals are shown below. You display the
residuals in Curve Fitting Tool with the View > Residuals menu item.

-} Curve Fitting Tool

=] 3
File | Wiew Tools ‘Window Help
JJ Prediction Baunds

Confidence Level

Residuals

More clude. .. | Flatting... Analysis... |

Scatker Plok
Lata and Fits

Clear Plot

Both fits appear fo
model the data well.

The residuals for both
—— fits appear to be
randomly distributed.

Both models appear to fit the data well, and the residuals appear to be
randomly distributed around zero. Therefore, a graphical evaluation of the
fits does not reveal any obvious differences between the two equations.
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The numerical fit results are shown below.

Results
Linear model Poly3:

£(x) = pl*x"3 + P2*x*Z + p3*x + p4
Coefficients (with 95% confidence bounds):

pl = -0.09837 (-0.1095, -0.08729)
pZ = 1.275 (1.113, 1.437)
Results
p3 = -0.4351 (-1.092, 0.2222)
pd = 2.56  (1.787, 3.332) Linear model Poly5:

pl
The quintic fit coefficients B2

p3
are not accurately known. i
ps
pa

0.001389
-0.03441
0.15934
0.2733
1.013
1.835

fix) = pl*x*5 4+ pZ*xtd + p3¥x*3 4+ pdPut2 + pStu
Coefficients (with 95% confidence bounds):
(-0,
L1601, 0.09125)
L9131, 1.3
LG56, 4.402)
.785, T.611)

167, 5.837) _l_vl
| »

The cubic fit coefficients are
accurately known.

-

003589, 0.006367)

As expected, the fit results for poly3 are reasonable because the generated
data follows a cubic curve. The 95% confidence bounds on the fitted coefficients
indicate that they are acceptably precise. However, the 95% confidence
bounds for poly5 indicate that the fitted coefficients are not known precisely.

The goodness-of-fit statistics are shown in the Table of Fits. By default, the
adjusted R-square and RMSE statistics are not displayed in the table. To
display these statistics, click the Table options button and select Adj R-sq

and RMSE, as shown below.

5-41



5 Curve Fitting Techniques

The statistics do not reveal a substantial difference between the two equations.

The 95% nonsimultaneous prediction bounds for new observations are
shown below. To display prediction bounds in Curve Fitting Tool, select

the View > Prediction Bounds menu item. Alternatively, you can view
prediction bounds for the function or for new observations using the Analysis

} Table Options

Check to view column in Table of Fits:

¥ [@ Status [ DFE
M Fit name W AdjR-3g
W Data set W RMSE

W Equation name [ # Coeff
v S5E ™ Type of fit

W R-square

Close

Help

GUL
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) Curve Fitting Tool -0l x|
File | view Tools Window Help

2

Residuals * | Fitting... | Exclude... Platting... Analysis... |
Clear Plat:
Data and Fits
30+
0+ O oywsox
— poly3
Pred bnds {paly3)
10 --= polys i
Pred bnds (paly)
1 1 1 1 1 1 1 1 1 1
1 2 3 4 3 5 7 g a 10
Residuals
1 T T
—— poly3
nsl — polyd ||

The prediction bounds for poly3 indicate that new observations can be
predicted with a small uncertainty throughout the entire data range. This is
not the case for poly5. It has wider prediction bounds in the area where no
data exist, apparently because the data does not contain enough information
to estimate the higher degree polynomial terms accurately. In other words, a
fifth-degree polynomial overfits the data. You can confirm this by using the
Analysis GUI to compute bounds for the functions themselves.

The 95% prediction bounds for the fitted function using poly5 are shown
below. As you can see, the uncertainty in predicting the function is large in
the center of the data. Therefore, you would conclude that more data must
be collected before you can make precise predictions using a fifth-degree
polynomial.
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In conclusion, you should examine all available goodness-of-fit measures
before deciding on the fit that is best for your purposes. A graphical
examination of the fit and residuals should always be your initial approach.
However, some fit characteristics are revealed only through numerical fit

results, statistics, and prediction bounds.
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Interpolants

Interpolation is a process for estimating values that lie between known data
points. The supported interpolant methods are shown below.

Interpolant Methods

Method Description

Linear Linear interpolation. This method fits a different
linear polynomial between each pair of data points.

Nearest neighbor Nearest neighbor interpolation. This method sets
the value of an interpolated point to the value of the
nearest data point. Therefore, this method does not
generate any new data points.

Cubic spline Cubic spline interpolation. This method fits a
different cubic polynomial between each pair of data
points.

Shape-preserving Piecewise cubic Hermite interpolation (PCHIP). This
method preserves monotonicity and the shape of the
data.

The type of interpolant you should use depends on the characteristics of the
data being fit, the required smoothness of the curve, speed considerations,
post-fit analysis requirements, and so on. The linear and nearest neighbor
methods are fast, but the resulting curves are not very smooth. The cubic
spline and shape-preserving methods are slower, but the resulting curves
are often very smooth.

For example, the nuclear reaction data from the file carbon12alpha.mat is
shown below with a nearest neighbor interpolant fit and a shape-preserving
(PCHIP) interpolant fit. Clearly, the nearest neighbor interpolant does not
follow the data as well as the shape-preserving interpolant. The difference
between these two fits can be important if you are interpolating. However,
if you want to integrate the data to get a sense of the total strength of the
reaction, then both fits provide nearly identical answers for reasonable
integration bin widths.
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Note Goodness-of-fit statistics, prediction bounds, and weights are not
defined for interpolants. Additionally, the fit residuals are always zero (within
computer precision) because interpolants pass through the data points.

Interpolants are defined as piecewise polynomials because the fitted curve is
constructed from many “pieces.” For cubic spline and PCHIP interpolation,
each piece is described by four coefficients, which are calculated using a cubic
(third-degree) polynomial. Refer to the spline function for more information
about cubic spline interpolation. Refer to the pchip function for more
information about shape-preserving interpolation, and for a comparison of
the two methods.

It is possible to fit a single “global” polynomial interpolant to data, with a
degree one less than the number of data points. However, such a fit can
have wildly erratic behavior between data points. In contrast, the piecewise
polynomials described here always produce a well-behaved fit, and thus they
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are more flexible than parametric polynomials and can be effectively used for
a wider range of data sets.
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Function Reference

Data Preprocessing (p. 6-2)
Data Fitting (p. 6-2)

Fit Type Methods (p. 6-2)
Curve Fit Methods (p. 6-3)
Surface Fit Methods (p. 6-5)
Fit Postprocessing (p. 6-6)
Information and Help (p. 6-7)

Preparing data for fitting
Creating data fits
Manipulating data models
Manipulating data fits
Manipulating surface fits
Evaluating data fits

Data and model summaries




6 Function Reference

Data Preprocessing

Data Fitting

cftool
excludedata

smooth

cftool

fit
fitoptions
fittype
get

set

sftool

Fit Type Methods

argnames

category

coeffnames

dependnames

Open Curve Fitting Tool
Exclude data from fit

Smooth response data

Open Curve Fitting Tool

Fit model to data

Create or modify fit options structure
Constructor for fittype object

Get fit options structure field names
and values

Assign values in fit options structure

Open Surface Fitting Tool

Input argument names of cfit,
sfit, or fittype object

Category of fit of cfit, sfit, or
fittype object

Coefficient names of cfit, sfit, or
fittype object

Dependent variable of cfit, sfit, or
fittype object



Curve Fit Methods

feval Evaluate cfit, sfit, or fittype
object

fittype Constructor for fittype object

formula Formula of cfit, sfit, or fittype
object

indepnames Independent variable of cfit, sfit,
or fittype object

islinear Determine if cfit, sfit, or fittype
object 1s linear

numargs Number of input arguments of cfit,
sfit, or fittype object

numcoeffs Number of coefficients of cfit, sfit,
or fittype object

probnames Problem-dependent parameter
names of cfit, sfit, or fittype
object

setoptions Set model fit options

type Name of cfit, sfit, or fittype
object

Curve Fit Methods

argnames Input argument names of cfit,
sfit, or fittype object

category Category of fit of cfit, sfit, or
fittype object

cfit Constructor for cfit object

coeffnames Coefficient names of cfit, sfit, or

fittype object

coeffvalues Coefficient values of cfit or sfit,
object
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confint

dependnames

differentiate

feval

formula

indepnames

integrate

islinear

numargs

numcoeffs

plot
predint

probnames

probvalues

setoptions

type

Confidence intervals for fit
coefficients of cfit or sfit object

Dependent variable of cfit, sfit, or
fittype object

Differentiate cfit or sfit object

Evaluate cfit, sfit, or fittype
object

Formula of cfit, sfit, or fittype
object

Independent variable of cfit, sfit,
or fittype object

Integrate cfit object

Determine if cfit, sfit, or fittype
object i1s linear

Number of input arguments of cfit,
sfit, or fittype object

Number of coefficients of cfit, sfit,
or fittype object

Plot cfit or sfit object

Prediction intervals for cfit or sfit
object

Problem-dependent parameter
names of cfit, sfit, or fittype
object

Problem-dependent parameter
values of cfit or sfit object

Set model fit options

Name of cfit, sfit, or fittype
object
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Surface Fit Methods

argnames
category
coeffnames
coeffvalues
confint
dependnames

differentiate

feval
formula
indepnames
islinear
numargs
numcoeffs

plot
predint

Input argument names of cfit,
sfit, or fittype object

Category of fit of cfit, sfit, or
fittype object

Coefficient names of cfit, sfit, or
fittype object

Coefficient values of cfit or sfit,
object

Confidence intervals for fit
coefficients of cfit or sfit object

Dependent variable of cfit, sfit, or
fittype object

Differentiate cfit or sfit object

Evaluate cfit, sfit, or fittype
object

Formula of cfit, sfit, or fittype
object

Independent variable of cfit, sfit,
or fittype object

Determine if cfit, sfit, or fittype
object is linear

Number of input arguments of cfit,
sfit, or fittype object

Number of coefficients of cfit, sfit,
or fittype object

Plot cfit or sfit object

Prediction intervals for cfit or sfit
object
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probnames

probvalues

quad2d
setoptions
sfit

type

Fit Postprocessing

6-6

cftool

coeffvalues

confint

differentiate

feval

integrate
plot
predint

probvalues

Problem-dependent parameter
names of cfit, sfit, or fittype
object

Problem-dependent parameter
values of cfit or sfit object

Numerically integrate sfit object
Set model fit options
Constructor for sfit object

Name of cfit, sfit, or fittype
object

Open Curve Fitting Tool

Coefficient values of cfit or sfit,
object

Confidence intervals for fit
coefficients of cfit or sfit object

Differentiate cfit or sfit object

Evaluate cfit, sfit, or fittype
object

Integrate cfit object
Plot cfit or sfit object

Prediction intervals for cfit or sfit

object

Problem-dependent parameter
values of cfit or sfit object



Information and Help

Information and Help

cflibhelp Information on library models

datastats Data statistics
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Purpose
Syntax

Description

Example

See Also

Input argument names of cfit, sfit, or fittype object

args = argnames(fun)

args argnames (fun) returns the input argument (variable and
coefficient) names of the cfit, sfit, or fittype object fun as an n-by-1
cell array of strings args, where n = numargs(fun).

f = fittype('a*x"2+b*exp(n*x)"');
nargs = numargs(f)
nargs =

args
args =

argnames (f)

fittype, formula, numargs



category

Purpose Category of fit of cfit, sfit, or fittype object
Syntax cname = category(fun)
Description cname = category(fun) returns the fit category cname of the

cfit, sfit, or fittype object fun, where cname is one of 'custom',
‘interpolant', 'library', or 'spline’.

Example f1 = fittype('a*x"2+b*exp(n*x)');
category(f1)
ans =
custom

f2 = fittype('pchipinterp');
category(f2)

ans =

interpolant

f3 = fittype('fourierd4');
category(f3)

ans =

library

f4 = fittype('smoothingspline');
category(f4)

ans =
spline

See Also fittype, type, cflibhelp
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Purpose
Syntax

Description

Example

See Also

7-4

Constructor for cfit object

cfun = cfit(ffun,coeff1,coeff2,...)

cfun cfit(ffun,coeff1,coeff2,...) constructs the cfit object
cfun using the model type specified by the fittype object ffun and the
coefficient values coeff1, coeff2, etc.

Note cfit is called by the fit function when fitting fittype objects to
data. To create a cfit object that is the result of a regression, use fit.

You should only call cfit directly if you want to assign values to
coefficients and problem parameters of a fittype object without
performing a fit.

f = fittype('a*x"2+b*exp(n*x)"')

General model:
f(a,b,n,x) = a*x"2+b*exp(n*x)
¢ = cfit(f,1,10.3,-1e2)

General model:
c(x) = a*x"2+b*exp(n*x)

Coefficients:
a = 1
b = 10.3
n = -100

fit, fittype, feval



cflibhelp

Purpose

Syntax

Description

Information on library models

cflibhelp
cflibhelp libtype
help cflibhelp

Enter cflibhelp to display the names, equations, and descriptions of
all models in the Curve Fitting Library. The Curve Fitting Library

is a library of models for data fitting with the fit function. You use
library names as input arguments in the fit, fitoptions, and fittype
functions. To find out what input arguments you can use, enter:

cflibhelp libtype
Where 1ibtype is a library type listed in the tables below.

cflibhelp libtype displays the names, equations, and descriptions for
the library models of the specified type, 1ibtype.

Enter help cflibhelp to display only the list of library types.

For Curves:

libtype Description
distribution Distribution models such as Weibull
exponential Exponential function and sum of two

exponential functions

fourier Up to eight terms of Fourier series

gaussian Sum of up to eight Gaussian models

power Power function and sum of two power functions
rational Rational equation models, up to 5th degree/5th

degree(i.e., up to degree 5 in both the numerator
and the denominator)

sin Sum of up to eight sin functions

spline Cubic spline and smoothing spline models
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For Curves:
libtype Description

interpolant Interpolating models, including linear, nearest
neighbor, cubic spline, and shape-preserving
cubic spline

polynomial Polynomial models, up to degree nine

For Surfaces:

libtype Description

interpolant Interpolating models, including linear, nearest
neighbor, cubic spline, and biharmonic
interpolation

polynomial Polynomial models, up to degree five

lowess Lowess smoothing models

For more information on library models, refer to the “Library Models”
on page 2-51 section of the User’s Guide.

Example To list only the model equations for a 1ibtype group, type cflibhelp
followed by the group name, for example:

cflibhelp polynomial

POLYNOMIAL MODELS

MODELNAME EQUATION
Curves:
poly1 Y = p1*x+p2
poly2 Y = p1*x"2+p2*x+p3
poly3 Y = p1*Xx"3+p2*x~2+...+p4
poly9 Y = p1*x°9+p2*x"8+...+p10
Surfaces:



cflibhelp
|

Model names for polynomial surfaces are 'polyij',
where i is the degree in x and j is the degree in y.
The maximum for both i and j is five. The degree of
the polynomial is the maximum of i and j. The degree
of x in each term will be less than or equal to i,
and the degree of y in each term will be less than or
equal to j. For example:

poly21 Z = p00 + pi10*x + pO1*y + p20*x~2 + p1i1*x*y
poly13 Z = p00 + p10*x + pO1*y + pli*x*y + p02*y~2
+ pl2*x*y~2 + p03*y"3
poly55 Z = p00 + pi10*x + pO1*y +...+ pld*x*y~4
+ p05*y~5

See Also fit, fittype
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Purpose

Syntax

Description

Remarks

Open Curve Fitting Tool

cftool
cftool(xdata,ydata)
cftool(xdata,ydata,w)

cftool opens Curve Fitting Tool, an interactive environment for fitting
curves to one-dimensional data.

cftool(xdata,ydata) opens Curve Fitting Tool with predictor data
xdata and response data ydata. xdata and ydata must be vectors of
the same size. Infs, NaNs, and imaginary parts of complex numbers are
ignored in the data.

cftool(xdata,ydata,w) also imports the weight vector w into Curve
Fitting Tool for weighting data in subsequent fits. w must be the same
length as xdata and ydata.

The Curve Fitting Tool is an interactive environment presented in the
form of a graphical user interface. It allows you to

® Import data from the MATLAB workspace

e Explore the data graphically

® Preprocess the data for fitting using exclusion rules and smoothing
® Fit a variety of library or custom models to the data

® Generate relevant regression statistics

® Post-process the fit through interpolation, extrapolation,
differentiation, and integration

e Export results back to the MATLAB workspace for further analysis
and visualization

The main Curve Fitting Tool interface is shown below.



cftool

] ) Curve Fitting Tool =] 3
1 File  Wiew Toolz Window  Help
8 ®a | @
Data... Fitting... Exclude... Platting... Anahysis...
Data and Fits
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Clicking the Data, Fitting, Exclude, Plotting, or Analysis buttons

opens associated GUIs, described below.

In the figure above, data was imported from the MAT-file census using

the Data GUI and fit with a quadratic polynomial using the Fitting
GUI. Residuals were displayed in the subplot by selecting View >

Residuals > Line Plot.

For a complete example that uses many of these GUIs, refer to
“Interactive Curve Fitting Example” on page 2-2.

The Data GUI
The Data GUI allows you to

® Import, name, preview, and delete data sets
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® Smooth data using a variety of methods

The Data GUI 1is shown below with the census data loaded.

- O]
Data Sets | Smggthl
Impart workspace vectars: [ Preview
*
X Data: chate 'I .
Y Data: nop hd +
Weights: (none) - +
*
Data set name: Ipop vs. cdate .
*
Create data set | *
*
*
*
Data sets: ot
*
eeet”
iR | Rename | Delete |
Close | Help |

Refer to “Preprocessing Data” on page 2-21 for more information about
the Data GUI.

The Fitting GUI
The Fitting GUI allows you to

* Fit your data using parametric or nonparametric models
¢ Set algorithm options for nonlinear fits

¢ Compare coefficients and goodness of fit statistics from different
models

e Keep track of all data sets and fits in the current session



cftool

The Fitting GUI is shown below with the results of fitting the census

data.

= |0 %

‘:J Exclusion nue: |¢tr£] ;i
=] F Center and scale x datm

2

]

™ Immedate sapply Cencel | Aoply |

Linear model Poly5:

Cosfficients (with

£5% confidence

bounds) :

-
F{x) = pl*x~5 + p2=x~4 + p3*x"3 + pd*x~2 + p5*x + pé
where ¥ iz notmalized by mean 1ES0 and =td &£2.05

Pl = 0D.5877 ({=Z.305, 3.48)

Pz = 0D.7047 ({-1.6B4, 3.0%4)

p3 = -0.5153 {-10.1%, B.356)

pd = 23.47 (17.42, 29.52)

P2 = T4.27  {gB.37, Bl.oT)

pg = 62.23 (5%9.51, G64.93) _:J
Table of Fits
S | Ftrams Data set Equastion riame S5E R-sguans
[] 6 vz, cdate Polys 1065.927557939... [0L.95913462847...
@ pokys pop vs. cdate Pohy4 145.568924373... |1.9589 156642 1.,
E pol3 ws, cdate Poly3 142768724181, [0.22878721213...
7] 2 i, cdate Foh2 155029299176, [0.9587 1256577.,

Delete it | Save toworkepace,. | Tabe cptors,. |

_Gose | e |
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The Exclude GUI

The Exclude GUI allows you to create exclusion rules for a data set. An
exclusion rule identifies data to be excluded while fitting. The excluded

data can be individual data points, or a section of predictor or response
data.

The Exclude GUI is shown below with the first two points of the census
data marked for exclusion.

et =lolx]

Exclusion rule name: |exc1 Existing exlusion rules:

Exclude Point:

Select data set: Ipop Vs, cdate - Exclude graphically |

Checkto exclude point:

Index % l
1 17490 39 -
2 1800 53
] 1810 T2 =l

~Exclude Section
Excludexlc -I Exclude X == = |
Exclude ¥ [== <] Exclude Y [== =] |

R

Capy YW, |

Create exclusion rule | Renarme | Delete |

o |

The Plotting GUI

The Plotting GUI allows you to determine the data sets and fits
displayed by Curve Fitting Tool.

The Plotting GUI is shown below with the census data and the fit
poly2 checked for display.



cftool

ST

Plot data sets Plot fits

I Data set I Fit Data set

[V|pop vs. cdate | naky2 pop v, cdate

[ poly3 pop vs. cate

[ paly4 pop vs. cdate

[ palys pop vs. cdate

| palys pop vs. cdate

expl pop vs. cdate

[~ Clear associated fits when clearing data sets.

o |

The Analysis GUI

The Analysis GUI allows you to

* Interpolate, extrapolate, differentiate, or integrate a fit

¢ Display the results of your analysis numerically or in a plot

The Analysis GUI is shown below with a numerical display of the

results of extrapolating the census data from the year 2000 to the year

2050 in 10-year increments.
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L anaivss L=
Fitto analyze: |poly2 (pop vs 'I i ]
Analyze atxi = [2000:10:2080 2000 274522
2010 301.824
. 2020 330.334
[+ Evaluate fit at i 2030 E0152
Frediction bounds: 2040 391.279
& Mone 2050 423714
" Forfunction
© For new ohseration
Level | 595 %
[ 15t derivative at Xi
[ 2nd derivative at i
[ Integrate to Xi
& Start from ming:i)
 Startfrom I
V! Plot results
[+ Plot data set: pop vs. cdate
Save to workspace... | Apply | Close |

Refer to “Analyzing the Fit” on page 2-15 for an example that uses the
Analysis GUI.
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Purpose
Syntax

Description

Example

See Also

Coefficient names of cfit, sfit, or fittype object

coeffs = coeffnames(fun)

coeffs = coeffnames(fun) returns the coefficient (parameter) names
of the cfit, sfit, or fittype object fun as an n-by-1 cell array of
strings coeffs, where n = numcoeffs(fun).

f = fittype('a*x"2+b*exp(n*x)"');

ncoeffs = numcoeffs(f)

ncoeffs
3

coeffs

coeffs
g
Y
N

coeffnames(f)

fittype, formula, numcoeffs, probnames, coeffvalues
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Purpose Coefficient values of cfit or sfit, object
Syntax coeffvals = coeffvalues(fun)
Description coeffvals = coeffvalues(fun) returns the values of the coefficients

(parameters) of the cfit object fun as a 1-by-n vector coeffvals, where
n = numcoeffs(fun).

Example load census

f = fittype('poly2');
coeffnames(f)

ans =
Ip1l
Ip2I
Ip3I
formula(f)
ans =

p1*x~2 + p2*x + p3

¢ = fit(cdate,pop,f);
coeffvalues(c)

ans =
1.0e+004 *
0.0000 -0.0024 2.1130
See Also coeffnames,confint, predint, probvalues
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Purpose

Syntax

Description

Remarks

Example

Confidence intervals for fit coefficients of cfit or sfit object

ci = confint(fitresult)
ci confint(fitresult,level)

ci confint(fitresult) returns 95% confidence bounds ci on

the coefficients associated with the cfit or sfit object fitresult.
fitresult must be an output from the fit function to contain

the necessary information for ci. ci is a 2-by-n array where n =
numcoeffs(fitresult). The top row of ci contains the lower bound for
each coefficient; the bottom row contains the upper bound.

ci = confint(fitresult,level) returns confidence bounds at the
confidence level specified by level. level must be between 0 and 1.
The default value of level is 0.95.

To calculate confidence bounds, confint uses R! (the inverse R factor
from @R decomposition of the Jacobian), the degrees of freedom

for error, and the root mean squared error. This information is
automatically returned by the fit function and contained within
fitresult.

If coefficients are bounded and one or more of the estimates are at
their bounds, those estimates are regarded as fixed and do not have
confidence bounds.

Note that you cannot calculate confidence bounds if
category(fitresult) is 'spline' or 'interpolant'.

load census

fitresult = fit(cdate,pop, 'poly2")
fitresult
Linear model Poly2:
fitresult(x) = p1*x"2 + p2*x + p3
Coefficients (with 95% confidence bounds):
p1 = 0.006541 (0.006124, 0.006958)
p2 = -23.51 (-25.09, -21.93)
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p3 = 2.113e+004 (1.964e+004, 2.262e+004)

ci = confint(fitresult,0.95)

ci =
0.0061242 -25.086 19641
0.0069581 -21.934 22618

Note that fit and confint display the confidence bounds in slightly
different formats.

See Also fit, predint
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Purpose Data statistics

Syntax xds = datastats(xdata)
[xds,yds] = datastats(xdata,ydata)

Description xds = datastats(xdata) returns statistics for the column vector
xdata to the structure xds. Fields in xds are listed in the table below.

Field Description

num The number of data values

max The maximum data value

min The minimum data value

mean The mean value of the data
median The median value of the data
range The range of the data

std The standard deviation of the data

[xds,yds] = datastats(xdata,ydata) returns statistics for the
column vectors xdata and ydata to the structures xds and yds,
respectively. xds and yds contain the fields listed in the table above.
xdata and ydata must be of the same size.

Remarks If xdata or ydata contains complex values, only the real parts are used
in computing the statistics. Data containing Inf or NaN are processed
using the usual MATLAB rules.

Example Compute statistics for the census data in census.mat:

load census
[xds,yds] = datastats(cdate,pop)
xds =

num: 21

max: 1990
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min:
mean:
median:
range:
std:

num:
max:
min:
mean:
median:
range:
std:

See Also

1790
1890
1890
200
62.048

21
248.7
3.9
85.729
62.9
244.8
78.601

excludedata, smooth
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Purpose Dependent variable of cfit, sfit, or fittype object
Syntax dep = dependnames(fun)
Description dep = dependnames(fun) returns the (single) dependent variable

name of the cfit, sfit, or fittype object fun as a 1-by-1 cell array
of strings dep.

Example f1 = fittype('a*x"2+b*exp(n*x)');
dep1t dependnames (1)
dep1

y

f2 = fittype('a*x"2+b*exp(n*x) "', 'dependent', 'power');
dep2 = dependnames(f2)
dep2

"power’

See Also indepnames, fittype, formula
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Purpose Differentiate cfit or sfit object

Syntax fx = differentiate(FO, X)
[fx, fxx] = differentiate(...)

[fx, fy] = differentiate(FO, X, Y)

[fx, fy] = differentiate(FO, [x, Vy])

[fx, fy, fxx, fxy, fyy] = differentiate(FO, ...)
Description For Curves

fx = differentiate(FO, X) differentiates the cfit object FO at the
points specified by the vector X and returns the result in fx.

[fx, fxx] = differentiate(...) also returns the second derivative
in fxx.

All return arguments are the same size and shape as X.
For Surfaces

[fx, fy] = differentiate(FO, X, Y) differentiates the surface FO
at the points specified by X and Y and returns the result in fx and fy.

FO is a surface fit (sfit) object generated by the fit function.

X and Y must be double-precision arrays and the same size and shape as
each other.

All return arguments are the same size and shape as X and Y.

If FO represents the surface z = f(x,y), then FX contains the derivatives
. . df . .. )
with respect to x, that is, Ix and FY contains the derivatives with
x

respect to y, that is, ?

[fx, fy] = differentiate(FO, [x, y]), where X and Y are column
vectors, allows you to specify the evaluation points as a single argument.

[fx, fy, fxx, fxy, fyy] = differentiate(FO, ...) computes the
first and second derivatives of the surface fit object FO.
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fxx contains the second derivatives with respect to x, that is, —=.

o%f
oxc2

O*f
oxdy

fxy contains the mixed second derivatives, that is,

2
fyy contains the second derivatives with respect to y, that is, g—g .
y
Remarks For library models with closed forms, the toolbox calculates derivatives
analytically. For all other models, the toolbox calculates the first
derivative using the centered difference quotient

%z flx+ Ax) — fx— Ax)
dx 2Ax

where x i1s the value at which the toolbox calculates the derivative, Ax

(x + Ax)

is a small number (on the order of the cube root of eps), f is fun

evaluated at X A% and fla—xA) is fun evaluated at * —Ax

The toolbox calculates the second derivative using the expression

d’f _ [+ Ax) + flx = Ax) + 2 (x)

dx? (Ax)?
The toolbox calculates the mixed derivative for surfaces using the
expression
a2f (x.y) = flx+Ax,y+Ay)—flx—Ax,y +Ay) — f(x + Ax,y — Ay) + f(x — Ax, y — Ay)
oxdy 4AxAy
Example For Curves

Create a baseline sinusoidal signal:
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xdata = (0:.1:2*pi)"';
y0 = sin(xdata);

Add noise to the signal:

noise = 2*y0.*randn(size(y0)); % Response-dependent
% Gaussian noise
ydata = y0 + noise;

Fit the noisy data with a custom sinusoidal model:

f = fittype('a*sin(b*x)"');
fit1 = fit(xdata,ydata,f, 'StartPoint',[1 1]);

Find the derivatives of the fit at the predictors:

[d1,d2] = differentiate(fitl,xdata);

Plot the data, the fit, and the derivatives:

subplot(3,1,1)

plot(fitl1,xdata,ydata) % cfit plot method
subplot(3,1,2)

plot(xdata,d1,'m') % double plot method
grid on

legend('1st derivative')

subplot(3,1,3)

plot(xdata,d2,'c') % double plot method
grid on

legend('2nd derivative')
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+  data
fitted curve

1 T T T T T T
! ! : : 2nd derivative
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You can also compute and plot derivatives directly with the cfit plot
method, as follows:

plot(fit1,xdata,ydata,{'fit', 'derivi', 'deriv2'})

The plot method, however, does not return data on the derivatives,
unlike the differentiate method.
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For Surfaces

You can use the differentiate method to compute the gradients of a
fit and then use the quiver function to plot these gradients as arrows.
The following example plots the gradients over the top of a contour plot.

X = [0.64;0.95;0.21;0.71;0.24;0.12;0.61;0.45;0.46; ...
0.66;0.77;0.35;0.66];

y = [0.42;0.84;0.83;0.26;0.61;0.58;0.54;0.87;0.26;...
0.32;0.12;0.94;0.65];

z = [0.49;0.051;0.27;0.59;0.35;0.41;0.3;0.084;0.6;...
0.58;0.37;0.19;0.191];

fo = fit( [x, yl, z, 'poly32', 'normalize', 'on' );
[xx, yy] = meshgrid( 0:0.04:1, 0:0.05:1 );

[fx, fy] = differentiate( fo, xx, yy );

plot( fo, 'Style’, 'Contour' );

hold on

h = quiver( xx, yy, fx, fy, 'r', 'LineWidth', 2 );
hold off

colormap( copper )
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0.2 0.3 0.4 0.5 0.6 0.7 0.8 0.9

If you want to use derivatives in an optimization, you can, for example,
implement an objective function for fmincon as follows.

function [z, g, H] = objectiveWithHessian( xy )

% The input xy represents a single evaluation point

z =Tf(xy);

if nargout > 1
[fx, fy, fxx, fxy, fyy]l = differentiate( f, xy );

g = [fx, fyl;
H o= [fxx, fxy; fxy, fyyl;

end
end

See Also fit, plot, integrate
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Purpose Exclude data from fit
Syntax outliers = excludedata(xdata,ydata,MethodName, ,MethodValue)
Descripl‘ion outliers = excludedata(xdata,ydata,MethodName ,MethodValue)

identifies data to be excluded from a fit using the specified MethodName
and MethodValue. outliers is a logical vector, with 1 marking
predictors (xdata) to exclude and 0 marking predictors to include.
Supported MethodName and MethodValue pairs are given in the table
below.

MethodName MethodValue

"box' A four-element vector specifying the edges of a closed
box in the xy-plane, outside of which data is to be
excluded from a fit. The vector has the form [xmin
xmax ymin ymax].

"domain' A two-element vector specifying the endpoints of a
closed interval on the x-axis, outside of which data is
to be excluded from a fit. The vector has the form
[xmin xmax].

'indices' A vector of indices specifying the data points to be
excluded.
'range’ A two-element vector specifying the endpoints of a

closed interval on the y-axis, outside of which data is
to be excluded from a fit. The vector has the form
[ymin ymax].

Remarks You can combine data exclusion rules using logical operators. For
example, to exclude data inside the box [-1 1 -1 1] or outside the
domain [-2 2], use:

outliers1i = excludedata(xdata,ydata,'box',[-1 1 -1 1]);
outliers2 = excludedata(xdata,ydata, 'domain',[-2 2]);
outliers = ~outlierst|outliers2;
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Example

You can visualize the combined exclusion rule using random data:

xdata -3 + 6*rand(1,1e4);

ydata = -3 + 6*rand(1,1e4);
plot(xdata(~outliers),ydata(~outliers),'.")
axis ([-3 3 -3 3])

axis square

32 0 1 2 3

Load the vote counts and county names for the state of Florida from
the 2000 U.S. presidential election:

load flvote2k

Use the vote counts for the two major party candidates, Bush and Gore,
as predictors for the vote counts for third-party candidate Buchanan,
and plot the scatters:

plot(bush,buchanan,'rs')
hold on
plot(gore,buchanan, 'bo")
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legend('Bush data', 'Gore data')
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Assume a model where a fixed proportion of Bush or Gore voters choose
to vote for Buchanan:

f
f =

fittype({'x'})

Linear model:
f(a,x) = a*x

Exclude the data from absentee voters, who did not use the controversial
“butterfly” ballot:

absentee = find(strcmp(counties, 'Absentee Ballots'));
nobutterfly = excludedata(bush,buchanan,...
'indices',absentee);

Perform a bisquare weights robust fit of the model to the two data sets,
excluding absentee voters:
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bushfit

fit(bush,buchanan,f,...

"Exclude’ ,nobutterfly, 'Robust','on');
gorefit = fit(gore,buchanan,f,...
"Exclude’ ,nobutterfly, 'Robust','on');

Robust fits give outliers a low weight, so large residuals from a robust
fit can be used to identify the outliers:

figure
plot(bushfit,bush,buchanan,'rs', 'residuals')
hold on
plot(gorefit,gore,buchanan, 'bo', 'residuals')
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The residuals in the plot above can be computed as follows:

bushres = buchanan - feval(bushfit,bush);
goreres = buchanan - feval(gorefit,gore);

Large residuals can be identified as those outside the range [ -500 500]:
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bushoutliers excludedata(bush,bushres,.

'range',[-500 500]);
goreoutliers = excludedata(gore,goreres,...
'range',[-500 500]);

The outliers for the two data sets correspond to the following counties:

counties(bushoutliers)
ans =

'‘Miami-Dade’

'Palm Beach'

counties(goreoutliers)
ans =
'‘Broward’
'‘Miami-Dade’
'Palm Beach'

Miami-Dade and Broward counties correspond to the largest predictor
values. Palm Beach county, the only county in the state to use the
“butterfly” ballot, corresponds to the largest residual values.

See Also fit, fitoptions
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Purpose

Syntax

Remark

Description

Evaluate cfit, sfit, or fittype object

y = feval(cfun,x)

z = feval(sfun,[x,y])

z = feval(sfun,x,y)

y = feval(ffun,coeffi,coeff2,...,x)

z = feval(ffun,coeff1,coeff2,...,x,y)

You can also treat fit objects as functions and call feval indirectly
using the following syntax:

y = cfun(x) % cfit objects;

z = sfun(x,y) % sfit objects

z = sfun([x, y]) % sfit objects

y = ffun(coefi1,coef2,...,x) % curve fittype objects;

z = ffun(coefl1,coef2,...,x,y) % surface fittype objects;

This simpler syntax is recommended to evaluate these objects, instead
of calling feval directly.

Use the feval method to evaluate the estimated function, either at your
original data points, or at new locations. The latter is often referred to
as interpolation or prediction, depending on the type of model. You can
also use feval to extrapolate the estimated function’s value at new
locations that are not within the range of the original data.

y = feval(cfun,x) evaluates the cfit object cfun at the predictor
values in the column vector x and returns the response values in the
column vector vy.

z = feval(sfun,[x,y]) evaluates the sfit object sfun at the predictor
values in the two column matrix [x,y] and returns the response values
in the column vector z.

z = feval(sfun,x,y) evaluates the sfit object sfun at the predictor
values in the matrices x and y that must be the same size. It
returns the response values in the matrix z that will be the same size
as x and y.
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Example

y = feval(ffun,coeff1,coeff2,...,x) assigns the coefficients
coeff1, coeff2, etc. to the fittype object ffun, evaluates it at the
predictor values in the column vector x, and returns the response values
in the column vector y. ffun cannot be a cfit object in this syntax. To
evaluate cfit objects, use the first syntax.

z = feval(ffun,coeffi,coeff2,...,x,y) achieves a similar result
for a fittype object for a surface.

fittype('a*x"2+b*exp(n*x)"');
cfit(f,1,10.3,-1e2);
rand(2)

f
C
X
X
0.0579 0.8132
0.3529 0.0099

y1 = feval(f,1,10.3,-1e2,X)
yi1 =

0.0349 0.6612
0.1245 3.8422
y1 = f(1,10.3,-1e2,X)
yi1 =

0.0349 0.6612
0.1245 3.8422

y2 feval(c,X)
0.0349
0.1245
0.6612
3.8422

y2 = c(X)

y2 =
0.0349
0.1245
0.6612
3.8422
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See Also fit, fittype, cfit
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Purpose

Syntax

Description

Fit model to data

cfun = fit(xdata,ydata,libname)

cfun = fit(...,PropName,PropVal,...)
cfun = fit(xdata,ydata,libname,options)
cfun = fit(xdata,ydata,ffun,...)

cfun = fit(..., 'problem',vals)

[cfun,gof] = fit(...)
[cfun,gof,output] = fit(...)

cfun = fit(xdata,ydata,libname) fits the data in the column vectors
xdata and ydata with the library model specified by 1ibname. xdata
and ydata cannot contain Inf or NaN. Only the real parts of complex
data are used in the fit. You can display library model names with the
cflibhelp function. The fit result is returned as a cfit object cfun.

cfun = fit(...,PropName,PropVval,...) fits the data using specified
property name/value pairs. You can display the supported property
names and values for specific library models with the fitoptions
function.

cfun = fit(xdata,ydata,libname,options) fits the data using the
options specified by the fit options structure options. Fit options
structures are created with the fitoptions function.

cfun = fit(xdata,ydata,ffun,...) fits the data with the fittype
object ffun. fittype objects are created with the fittype function.

cfun = fit(...,'problem',vals) assigns vals to the
problem-dependent parameters of the model before fitting. vals is a
scalar or a cell array with one element per parameter.

[cfun,gof] = fit(...) returns goodness-of-fit statistics to the
structure gof. The gof structure has the fields shown in the table below.

Field Value
sse Sum of squares due to error
rsquare Coefficient of determination
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Field Value
dfe Degrees of freedom
adjrsquare Degree-of-freedom adjusted coefficient of
determination
rmse Root mean squared error (standard error)
[cfun,gof,output] = fit(...) returns the structure output, which

contains information associated with the fitting algorithm. Fields
depend on the algorithm. For example, the output structure for
nonlinear least-squares algorithms has the fields shown in the table

below.

Field Value

numobs Number of observations (response values)

numparam Number of unknown parameters (coefficients)
to fit

residuals Vector of residuals

Jacobian Jacobian matrix

exitflag Describes the exit condition of the algorithm.
Positive flags indicate convergence, within
tolerances. Zero flags indicate that the
maximum number of function evaluations
or iterations was exceeded. Negative flags
indicate that the algorithm did not converge
to a solution.

iterations Number of iterations

funcCount Number of function evaluations

firstorderopt Measure of first-order optimality (absolute
maximum of gradient components)

algorithm Fitting algorithm employed
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Remarks

Example

For some nonlinear library models (rational and Weibull), and all
custom nonlinear models, default initial values for coefficients are
selected uniformly at random from the interval (0,1). As a result,
multiple fits using the same data and model may lead to different
fitted coefficients. To avoid this, initial values for coefficients can be
specified through a fitoptions structure or a vector value for the
StartPoint property. Alternatively, the initial state of the random
number generator rand can be set before fitting.

All other nonlinear library models automatically compute reasonable
initial values. These initial values depend on the data, and are based on
model-specific heuristics.

Load and plot the data in census.mat:

load census
plot(cdate,pop,'0o"')
hold on

250 . . . .

200} o
150 - o |
100} “ 1
50} o ]

0 [o0] o© © 1 1 1
1750 1500 1850 1900 1950 2000




fit

Create a fit options structure and a fittype object for the custom
nonlinear model y = a(x—b)", where a and b are coefficients and n is
a problem-dependent parameter:

s = fitoptions('Method', 'NonlinearLeastSquares',...
"Lower',[0,0],...
"Upper',[Inf,max(cdate)],...
'Startpoint’,[1 1]);

f = fittype('a*(x-b)"n', 'problem','n', 'options',s);

Fit the data using the fit options and a value of n = 2:

[c2,g0f2] = fit(cdate,pop,f, ' 'problem',2)

c2 =
General model:
c2(x) = a*(x-b)"n
Coefficients (with 95% confidence bounds):
a = 0.006092 (0.005743, 0.006441)
b = 1789 (1784, 1793)
Problem parameters:
n = 2
gof2 =
sse: 246.1543
rsquare: 0.9980
dfe: 19
adjrsquare: 0.9979
rmse: 3.5994

Fit the data using the fit options and a value of n = 3:

[c3,90f3] = fit(cdate,pop,f, 'problem',3)
c3 =
General model:
c3(x) = a*(x-b)"n
Coefficients (with 95% confidence bounds):
a = 1.359e-005 (1.245e-005, 1.474e-005)
b = 1725 (1718, 1731)
Problem parameters:
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n = 3

sse: 232.0058
rsquare: 0.9981
dfe: 19
adjrsquare: 0.9980

rmse: 3.4944

Plot the fit results with the data:

plot(c2,'m")
plot(c3,'c')
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See Also cflibhelp, fitoptions, fittype, feval, plot
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Purpose

Syntax

Description

Create or modify fit options structure

options = fitoptions

options = fitoptions(model)

options = fitoptions(model,fldi,vall,fld2,val2,...)
options = fitoptions('Method',method)

options =
fitoptions('Method',method,fld1,vall,fld2,val2,...)
newoptions = fitoptions(options,fldi,vall,fld2,val2,...)
newoptions fitoptions(optionsi,options2)

options = fitoptions creates the default fit options structure
options. Fields in the options structure, listed in the table below with
their default values, are supported by all fitting methods.

Field Name Values

Normalize Specifies whether the data is centered and scaled.
Values are 'off' or 'on'. The defaultis 'off'.

Exclude A logical vector indicating data points to exclude
from the fit. The excludedata function can be used
to create this vector. The default is empty.

Weights A vector of weights the same size as the response
data. The default is empty.

Method The fitting method. A complete list of supported
fitting methods is given below. The default is
‘None'.

options = fitoptions(model) creates the default fit options structure
for the library or custom model specified by the string model. You can
display library model names with the cflibhelp function.

options = fitoptions(model,fldi,vall,fld2,val2,...) creates a
fit options structure for the specified model with the fields specified by
the strings f1d17, f1d2, ... set to the values vali, val2, ..., respectively.
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options = fitoptions('Method',method) creates the default fit
options structure for the fitting method specified by the string method.
Supported fitting methods are listed in the table below.

method Description

'NearestInterpolant' Nearest neighbor interpolation
'LinearInterpolant' Linear interpolation
'"PchipInterpolant’ Piecewise cubic Hermite interpolation

(curves only)

'CubicSplineInterpolant’' | Cubic spline interpolation

'BiharmonicInterpolant' | Biharmonic surface interpolation
'SmoothingSpline’ Smoothing spline

'LowessFit' Lowess smoothing (surfaces only)
'LinearLeastSquares' Linear least squares

'NonlinearlLeastSquares' | Nonlinear least squares

options =
fitoptions('Method',method,fld1,vall,fld2,val2,...) creates
the default fit options structure for the fitting method specified by the
string method with the fields specified by the strings f1d7, f1d2, ... set
to the values vali, val2, ..., respectively.

newoptions = fitoptions(options,fldi,vall,fld2,val2,...)
modifies the existing fit options structure options by setting the fields
specified by the strings f1d1, f1d2, ... set to the values vali, val2, ...,
respectively. The new options structure is returned in newoptions.

newoptions = fitoptions(optionsi,options2) combines the input
fit options structures options1 and options2 to create the output fit
options structure newoptions. If the input structures have Method
fields set to the same value, the nonempty values for the fields in
options2 override the corresponding values in options1 in the output
structure. If the input structures have Method fields set to different
values, the output structure will have the same Method as optionsi,
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and only the values of the Normalize, Exclude, and Weights fields of
options2 will override the corresponding values in optionsi.

Remarks Field values in a fit options structure can be referenced with the get
method and assigned with the set method. For example:

options = fitoptions('fouriert');
get(options, '‘Method')
ans =
NonlinearlLeastSquares
get(options, 'MaxIter')
ans =

400
set(options, 'Maxiter',1e3);
get(options, 'MaxIter')
ans =

1000

Field values can also be referenced and assigned using the dot notation.
For example:

options.MaxIter
ans =
1000
options.MaxIter = 500;
options.MaxIter
ans =
500

Additional Fit Options

Some fitting methods have additional fields in the fit options structure,
beyond the default fields Normalize, Exclude, Weights, and Method.

There are no additional parameters if Method is:

® 'NearestInterpolant’

e 'LinearInterpolant’
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® 'PchipInterpolant’

® 'CubicSplineInterpolant’

® 'BiharmonicInterpolant'

If the Method is SmoothingSpline, the SmoothingParam field is

available to configure the smoothing parameter. Its value must be
between 0 and 1. The default value depends on the data set.

If the Method is LowessFit, then the Span field is available to configure
the proportion of data points to be used in local regressions. It must be
a scalar in [0,1], and the default is 0.25.

If the Method field has the value LinearLeastSquares, the additional
fields available in the fit options structure are listed in the table below.

Field Description

Robust Specifies the robust linear least-squares fitting
method to be used. Values are 'on', 'off', 'LAR',
or 'Bisquare'. The default is 'off'. 'LAR'
specifies the least absolute residual method and
'Bisquare' specifies the bisquare weights method.
‘on' 1s equivalent to 'Bisquare', the default
method.

Lower A vector of lower bounds on the coefficients to

be fitted. The default value is an empty vector,
indicating that the fit is unconstrained by lower
bounds. If bounds are specified, the vector length
must equal the number of coefficients. Individual
unconstrained lower bounds can be specified by
-Inf.

Upper A vector of upper bounds on the coefficients to
be fitted. The default value is an empty vector,
indicating that the fit is unconstrained by upper
bounds. If bounds are specified, the vector length
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Field Description

must equal the number of coefficients. Individual
unconstrained upper bounds can be specified by Inf.

If the Method field has the value NonlinearLeastSquares, the
additional fields available in the fit options structure are listed in the
table below.

Property Description

Robust Specifies the robust linear least-squares
fitting method to be used. Values are 'on’,
'off', 'LAR', or 'Bisquare'. The default

is 'off'. 'LAR' specifies the least absolute
residual method and 'Bisquare’' specifies the
bisquare weights method. 'on' is equivalent
to 'Bisquare’, the default method.

Lower A vector of lower bounds on the coefficients
to be fitted. The default value is an empty
vector, indicating that the fit is unconstrained
by lower bounds. If bounds are specified,

the vector length must equal the number of
coefficients. Individual unconstrained lower
bounds can be specified by -Inf.

Upper A vector of upper bounds on the coefficients
to be fitted. The default value is an empty
vector, indicating that the fit is unconstrained
by upper bounds. If bounds are specified,

the vector length must equal the number of
coefficients. Individual unconstrained upper
bounds can be specified by Inf.
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Property

Description

StartPoint

A vector of initial values for the coefficients.
The default value of StartPoint is an empty
vector. If the default value is passed to

the fit function, starting points for some
library models are determined heuristically.
For other models, the values are selected
uniformly at random on the interval (0,1).

Algorithm

The algorithm used for the fitting procedure.
Values are 'Levenberg-Marquardt',
'Gauss-Newton', or 'Trust-Region'. The
default is 'Trust-Region'.

DiffMaxChange

The maximum change in coefficients for finite
difference gradients. The default is 0.1.

DiffMinChange

The minimum change in coefficients for finite
difference gradients. The default is 10-5.

Display

Controls the display in the command window.
‘notify', the default, displays output only if
the fit does not converge. 'final' displays
only the final output. 'iter' displays output
at each iteration. 'off' displays no output.

MaxFunEvals

The maximum number of evaluations of the
model allowed. The default is 600.

MaxIter

The maximum number of iterations allowed
for the fit. The default is 400.

TolFun

The termination tolerance on the model value.
The default is 1076.

TolX

The termination tolerance on the coefficient
values. The default is 1075.
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Note For the fields Upper, Lower, and StartPoint, the order of the
entries in the vector value is the order of the coefficients returned by
the coeffnames method. For example, if

f = fittype('b*x"2+c*x+a');

coeffnames(T)
ans =

g

"y

o

then setting

options.StartPoint = [1 3 5];

assigns initial values to the coefficients as follows: a = 1, b = 3,¢c =
5. Note that this is not the order of the coefficients in the expression
used to create f with fittype.

Example Create the default fit options structure and set the option to center
and scale the data before fitting:

options = fitoptions;
options.Normal = 'on';
options
options =
Normalize: 'on'
Exclude: [1x0 double]
Weights: [1x0 double]
Method: 'None'

Modifying the default fit options structure is useful when you want to
set the Normalize, Exclude, or Weights fields, and then fit your data
using the same options with different fitting methods. For example:

load census
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1 fit(cdate,pop, 'poly3',options);
f2 = fit(cdate,pop, 'expl1',options);
3 fit(cdate,pop, 'cubicsp',options);

Data-dependent fit options are returned in the third output argument
of the fit function. For example:

[f,gof,out] = fit(cdate,pop, 'smooth');

smoothparam out.p

smoothparam
0.0089

The default smoothing parameter can be modified for a new fit:

options = fitoptions('Method', 'Smooth',...
‘SmoothingParam',0.0098);
[f,gof,out] = fit(cdate,pop, 'smooth',options);

Example Create a noisy sum of two Gaussian peaks—one with a small width,
and one with a large width:

al = 1; bt = -1; c¢1 = 0.05;

a2 = 1; b2 = 1; c2 = 50;

X = (-10:0.02:10) ';

gdata = at*exp(-((x-b1)/ct1)."2) + ...
a2*exp(-((x-b2)/c2).72) + ...
0.1*(rand(size(x))-.5);

plot(x,gdata)
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22

161

141

121

08

-10

Fit the data using the two-term Gaussian library model:

-5

0

f = fittype('gauss2');
fit(x,gdata,f)

gfit =
gfit =

General model Gauss2:

Coefficients (with 95% confidence bounds):

gfit(x) =

al
b1
cl
a2

b2 =

c2

al*exp(-((x-b1)/c1)"2) +

a2*exp(-((x-b2)/c2)"2)

-0.05388
-2.651
0.05373
1.012
0.6703
41.2

(

(
(
(
(
(

-0.136, 0.02826)
-2.718, -2.584)
-0.04106, 0.1485)
1.006, 1.018)
0.06681, 1.274)
36.54, 45.85)

10

The algorithm is having difficulty, as indicated by the wide confidence
intervals for some of the coefficients. To help the algorithm, we could
specify lower bounds for the nonnegative amplitudes a1, a2 and widths

c1, c2:
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options = fitoptions('gauss2');
options.Lower = [0 -Inf O O -Inf 0];

Recompute the fit with the bound constraints on the coefficients:

gfit = fit(x,gdata,ftype,options)
gfit =
General model Gauss2:
gfit(x) = at*exp(-((x-b1)/c1)"2) +
a2*exp(-((x-b2)/c2)"~2)
Coefficients (with 95% confidence bounds):

al = 1.003 (0.9641, 1.042)

b1 = -1 (-1.002, -0.9987)
cl = 0.04972 (0.04748, 0.05197)
a2 = 1.002 (0.999, 1.004)

b2 = 1.136 (0.725, 1.547)

c2 = 48.89 (45.32, 52.47)

This is a much better fit. The fit can be further improved by assigning
reasonable values to other fields in the fit options structure.

See Also cflibhelp, fit, get, set, setoptions
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Purpose

Syntax

Description

Constructor for fittype object

ffun = fittype(libname)

ffun = fittype(expr)

ffun = fittype({expri,...,exprn})

ffun = fittype(expr,PropName,PropVval,...)

ffun = fittype({expri,...,exprn},PropName,PropVval,...)

ffun = fittype(libname) constructs the fittype object ffun for the
library model specified by 1ibname. You can display library model
names with the cflibhelp function.

ffun = fittype(expr) constructs the fittype object ffun for the
custom nonlinear model specified by the expression in the string expr.
You can use expr to specify any MATLAB command and therefore any
M-file. By default, the independent variable is assumed to be x and the
dependent variable is assumed to be y. All other variables are assumed
to be coefficients. All coefficients must be scalars.

Note The following coefficient names are not allowed in the expression
string expr: i, j, pi, inf, nan, eps.

ffun = fittype({expri,...,exprn}) constructs the fittype object
ffun for the custom linear model with terms specified by the expressions
in the strings expri, expr2, ... , exprn. Coefficients are not included in
the expressions for the terms. If there is a constant term, use '1' as
the corresponding expression in the cell array.

Note islinear assumes that all models specified with the syntax
ffun = fittype(expr) are nonlinear models. To create a linear
model with fittype that will be recognized as linear by islinear
(and, importantly, by the algorithms of fit), use the syntax ffun =
fittype({expri,...,exprn}).
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ffun = fittype(expr,PropName,PropVal,...) or ffun =

fittype({expri,...,exprn},PropName,PropVval,...) constructs
the fittype object ffun using specified property name/value pairs.
Supported property names and values are given in the table below.

PropName PropVal

'coefficients' The coefficient names. Use a cell array if there
are multiple names. The following names are
not allowed: i, j, pi, inf, nan, eps.

'dependent' The dependent (response) variable name
‘independent' The independent (predictor) variable name
'options' The default fit options for the object
'problem' The problem-dependent (fixed) parameter

names. Use a cell array if there are multiple
names. The default is none.

To decide what are dependent and independent variables and
coefficients, consider this example equation:

y=fx)=a+®B*x)+(c*x>)

® yis the dependent variable
® xis the independent variable

® q, b, and c are the coefficients

The 'independent' variable is that variable that you control, the
'dependent' variable is the variable that you measure, i.e., it depends
on the independent variable. The 'coefficients' are the parameters
that the fitting algorithm will estimate.

For example, if you have census data, then the year is the independent
variable because it does not depend on anything. Population is the
dependent variable, because its value depends on the year in which the
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census is taken. If a parameter like growth rate is part of the model, if
the fitting algorithm estimates it, then it is one of the 'coefficients'.

The examples below demonstrate how to specify an independent
variable and coefficient names.

Example Construct a fittype object for the rat33 library model:

f
f =
General model Rat33:
f(p1,p2,p3,p4,01,02,93,x) =
(p1*x"3 + p2*x72 + p3*Xx + p4)/
(x*3 + q1*x"2 + g2*x + 3)

fittype('rat33"')

Construct a fittype object for a custom nonlinear model, designating n
as a problem-dependent parameter and u as the independent variable:

g = fittype('a*ut+b*exp(n*u)',...
'problem','n',...
"independent', 'u')

General model:
g(a,b,n,u) = a*u+b*exp(n*u)

Construct a fittype object for a custom linear model, specifying the
names of the coefficients:

h
h:

fittype({'cos(x)','1"'}, 'coefficients',{'al','a2'})

Linear model:
h(al,a2,x) = al*cos(x) + a2

The following example demonstrates how to fit a curve defined by an
M-file. First define a function in a M-file:

function y = piecewiselLine( x, a, b, ¢, d, k)

% PIECEWISELINE A line made of two pieces
% that is not continuous
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See Also

y = zeros( size( x ) );

% This example includes a for-loop and if statement
% purely for demonstration purposes.
for i = 1:1length( x )

if x(i) < Kk,
y(i) = a + b.* x(1);
else
y(i) = ¢ + d.* x(1);
end
end
end

Enter the following commands to define some data, create a fittype
specifying the M-file function piecewiselLine, create a fit with the
fittype, and plot the results:

[0.81;0.91;0.13;0.91;0.63;0.098;0.28;0.55;...
6;0.96;0.16;0.97;0.961];
= [0.17;0.12;0.16;0.0035;0.37;0.082;0.34;0.56;...
0.15;-0.046;0.17;-0.091;-0.071];
ft = fittype( 'piecewiseLine( x, a, b, ¢, d, k )' )
f = fit( x, y, ft, 'StartPoint', [1, O, 1, O, 0.5] )
plot( f, x, y )

I © 1
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Purpose Formula of cfit, sfit, or fittype object
Syntax formula(fun)
Description formula(fun) returns the formula of the cfit, sfit, or fittype object
fun as a character array.
Example f = fittype('weibull');
formula(f)
ans =

a*b*x” (b-1)*exp(-a*x"~h)
g = fittype('cubicspline');
formula(g)

ans =
piecewise polynomial

See Also fittype, coeffnames, numcoeffs, probnames, coeffvalues
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Purpose

Syntax

Description

Example

Get fit options structure field names and values

get(options)
s = get(options)
value = get(options,fld)

get(options) displays all field names and values of the fit options
structure options.

s = get(options) returns a copy of the fit options structure options
as the structure s.

value = get(options,fld) returns the value of the field f1d of the fit
options structure options. f1d can be a cell array of strings, in which
case value is also a cell array.

options = fitoptions('fouriert');
get(options, 'Method')
ans =
NonlinearlLeastSquares
get(options, 'MaxIter')
ans =

400
set(options, 'Maxiter',1e3);
get(options, 'MaxIter')
ans =

1000

Field values can also be referenced and assigned using the dot notation.
For example:

options.MaxIter
ans =
1000
options.MaxIter = 500;
options.MaxIter
ans =
500
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See Also fitoptions, set
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Purpose
Syntax

Description

Example

See Also

7-58

Independent variable of cfit, sfit, or fittype object
indep = indepnames(fun)

indep = indepnames(fun) returns the (single) independent variable
name of the cfit, sfit, or fittype object fun as a 1-by-1 cell array of
strings indep.

f1 = fittype('a*x"2+b*exp(n*x)"');
indep1 = indepnames(f1)
indep1 =

IXI
f2 = fittype('a*x"2+b*exp(n*x) "', 'independent’','n');
indep2 = indepnames(f2)
indep2 =

Inl

dependnames, fittype, formula
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Purpose
Syntax

Description

Example

Integrate cfit object

int = integrate(fun,x,x0)

int integrate(fun,x,x0) integrates the cfit object fun at the
points specified by the vector x, starting from x0, and returns the result
in int. int is a vector the same size as x. x0 is a scalar.

Create a baseline sinusoidal signal:

xdata = (0:.1:2*pi)"';
y0 = sin(xdata);

Add noise to the signal:

noise = 2*y0.*randn(size(y0)); % Response-dependent
% Gaussian noise

ydata y0 + noise;

Fit the noisy data with a custom sinusoidal model:

f = fittype('a*sin(b*x)"');
fit1 = fit(xdata,ydata,f, 'StartPoint',[1 1]);

Find the integral of the fit at the predictors:

int = integrate(fiti1,xdata,0);

Plot the data, the fit, and the integral:

subplot(2,1,1)

plot(fitl1,xdata,ydata) % cfit plot method
subplot(2,1,2)

plot(xdata,int,'m') % double plot method
grid on

legend('integral')
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+  data |
+ + + fited curve

0 1 2 3 4 5 5 7

Note that integrals can also be computed and plotted directly with the
cfit plot method, as follows:

plot(fiti1,xdata,ydata,{'fit', 'integral'})
The plot method, however, does not return data on the integral.

See Also fit, plot, differentiate
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Purpose
Syntax

Description

Example

Determine if cfit, sfit, or fittype object is linear
flag = islinear(fun)

flag = islinear(fun) returnsa flagof1ifthe cfit, sfit, or fittype
object fun represents a linear model, and a flag of 0 if it does not.

Note islinear assumes that all custom models specified by the
fittype function using the syntax ftype = fittype('expr')
are nonlinear models. To create a linear model with

fittype that will be recognized as linear by islinear (and,
importantly, by the algorithms of fit), use the syntax ftype =
fittype({'expri','expr2',...,"'exprn'}).

—+
1}

fittype('a*x+b')

General model:
f(a,b,x) = a*x+b

g = fittype({'x","1'})

Linear model:
g(a,b,x) = a*x + b

h = fittype('polyl')

h =
Linear model Polyt:
h(p1,p2,x) = p1*x + p2
islinear(f)
ans =
0
islinear(g)
ans =
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1
islinear(h)
ans =

1

See Also fittype
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Purpose Number of input arguments of cfit, sfit, or fittype object
Syntax nargs = numargs(fun)
Description nargs = numargs(fun) returns the number of input arguments nargs

of the cfit, sfit, or fittype object fun.

Example f = fittype('a*x"2+b*exp(n*x)');
nargs = numargs(f)
nargs =

args = argnames(f)
args =

See Also fittype, formula, argnames
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Purpose Number of coefficients of cfit, sfit, or fittype object
Syntax ncoeffs = numcoeffs(fun)

Description ncoeffs = numcoeffs(fun) returns the number of coefficients ncoeffs
of the cfit, sfit, or fittype object fun.

Example f = fittype('a*x"2+b*exp(n*x)');

ncoeffs = numcoeffs(f)

ncoeffs =
3

coeffs = coeffnames(T)

coeffs
g
Y
N

See Also fittype, formula, coeffnames
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Purpose

Syntax

Description

Plot cfit or sfit object

plot(sfit)
plot(sfit, [x, y], 2)
plot(sfit, [x, y], z, 'Exclude', ExcludeData)

H = plot(sfit, ..., 'Style', Style)

H = plot(sfit, ..., 'Level', Level)

H = plot(sfit, ..., 'XLim', XLIM)

H = plot(sfit, ..., 'YLim', YLIM)

H = plot(sfit, ...)

H = plot(sfit, ..., 'Parent', HAXES )
plot(cfit)

plot(cfit,xdata,ydata)
plot(cfit,xdata,ydata,DatalLineSpec)
plot(cfit,FitLineSpec,xdata,ydata,DatalLineSpec)
plot(cfit,xdata,ydata,outliers)
plot(cfit,xdata,ydata,outliers,QutlierLineSpec)
plot(...,ptype,...)

plot(...,ptype,level)

h = plot(...)

For surfaces:

® plot(sfit) plots the sfit object over the range of the current axes,
if any, or otherwise over the range stored in the fit.

® plot(sfit, [x, y], z) plots z versus x and y and plots sfit over
the range of x and y.

® plot(sfit, [x, y], z, 'Exclude', ExcludeData) plots the
excluded data in a different color. ExcludeData is a logical array
where true represents an outlier.

® H = plot(sfit, ..., 'Style', Style) selects which way to plot
the surface fit object sfit.

Style may be any of the following strings
= 'Surface' Plot the fit object as a surface (default)
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= 'PredFunc' Surface with prediction bounds for function

'"PredObs' Surface with prediction bounds for new observation
= 'Residuals' Plot the residuals (fit is the plane Z=0)
= 'Contour' Make a contour plot of the surface

® H = plot(sfit, ..., 'Level', Level) sets the confidence level to
be used in the plot. Level is a positive value less than 1, and has a
default of 0.95 (for 95% confidence). This option only applies to the
'PredFunc' and 'PredObs' plot styles.

® H = plot(sfit, ..., 'XLim', XLIM) andH = plot(sfit, ...,
'YLim', YLIM) sets the limits of the axes used for the plot. By
default the axes limits are taken from the data, XY. If no data is
given, then the limits are taken from the surface fit object, sfit.

® H = plot(sfit, ...) returns a vector of handles of the plotted
objects.
® H = plot(sfit, ..., 'Parent', HAXES ) plots the fit object sfit

in the axes with handle HAXES rather than the current axes. The
range is taken from these axes rather than from the fit or the data.

For curves:

® plot(cfit) plots the cfit object over the domain of the current axes,
if any. If there are no current axes, and fun is an output from the fit
function, the plot is over the domain of the fitted data.

® plot(cfit,xdata,ydata) plots cfit together with the predictor
data xdata and the response data ydata.

® plot(cfit,xdata,ydata,DataLineSpec) plots the predictor and
response data using the color, marker symbol, and line style specified
by the DataLineSpec formatting string. DatalLineSpec strings take
the same values as LineSpec strings used by the MATLAB plot
function.

® plot(cfit,FitLineSpec,xdata,ydata,DataLineSpec) plots fun
using the color, marker symbol, and line style specified by the
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FitLineSpec formatting string, and plots xdata and ydata using the
color, marker symbol, and line style specified by the DataLineSpec
formatting string. FitLineSpec and DatalLineSpec strings take the
same values as LineSpec strings used by the MATLAB plot function.

® plot(cfit,xdata,ydata,outliers) plots data indicated by
outliers in a different color. outliers is a logical array the same
size as xdata and ydata. outliers can be computed with the
excludedata function.

® plot(cfit,xdata,ydata,outliers,OutlierLineSpec) plots
outliers using the color, marker symbol, and line style specified
by the OutlierLineSpec. OutlierLineSpec strings take the same
values as LineSpec strings used by the MATLAB plot function.

plot(...,ptype,...) uses the plot type specified by ptype.
Supported plot types are:

= 'fit' — Data and fit (default)
= 'predfunc' — Data and fit with prediction bounds for the fit

= 'predobs' — Data and fit with prediction bounds for new
observations

= 'residuals' — Residuals

= 'stresiduals' — Standardized residuals (residuals divided by
their standard deviation).

= 'derivi1' — First derivative of the fit

= 'deriv2' — Second derivative of the fit

= ‘'integral' — Integral of the fit

® plot(...,ptype,level) plots prediction intervals with a confidence
level specified by level. level must be between 0 and 1. The default
value of level is 0.95.

For both curves and surfaces:
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Example

® Plot types can be single or multiple, with multiple plot types specified
as a cell array of strings. With a single plot type, plot draws to the
current axes and can be used with commands like hold and subplot.
With multiple plot types, plot creates subplots for each plot type.

® h = plot(...) returns a vector of handles to the plotted objects.

Create a baseline sinusoidal signal:

xdata = (0:0.1:2*pi)’;
y0 = sin(xdata);

Add noise to the signal with non-constant variance:

% Response-dependent Gaussian noise
gnoise = y0.*randn(size(y0));

% Salt-and-pepper noise

spnoise = zeros(size(y0));

p = randperm(length(y0));

sppoints = p(1:round(length(p)/5));
spnoise(sppoints) = 5*sign(y0(sppoints));

ydata = y0 + gnoise + spnoise;
Fit the noisy data with a baseline sinusoidal model:

f = fittype('a*sin(b*x)"');
fit1 = fit(xdata,ydata,f, 'StartPoint',[1 1]);

Identify “outliers” as points at a distance greater than 1.5 standard
deviations from the baseline model, and refit the data with the outliers
excluded:

fdata = feval(fiti1,xdata);
I = abs(fdata - ydata) > 1.5*std(ydata);
outliers = excludedata(xdata,ydata,'indices',I);

fit2 = fit(xdata,ydata,f,'StartPoint',[1 1],...
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"Exclude',outliers);

Compare the effect of excluding the outliers with the effect of giving
them lower bisquare weight in a robust fit:

fit3 = fit(xdata,ydata,f, 'StartPoint',[1 1], 'Robust','on');
Plot the data, the outliers, and the results of the fits:

plot(fit1,'r-',xdata,ydata, 'k."',outliers, 'm*")
hold on

plot(fit2,'c--")

plot(fit3,'b:")

x1im ([0 2*pi])

3 T . T T . T
#* +  data
6L * o N *  excluded data |
* #* fited curve
4l * fitted curve
--------- fitted curve

Plot the residuals for the two fits considering outliers:

figure
plot(fit2,xdata,ydata,'co', 'residuals"')
hold on
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plot(fit3,xdata,ydata, 'bx', 'residuals')
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N XL B g data
Zero ling
ol w = data |
Zeroling
2 % 1
#
><X ® b = * "
0 S * Ko s SRR R e i
3 5 0 e
® ® *
_2 o # .
at . 1
XX = X w
B 1 1 1 1 1 1
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X
See Also cftool, excludedata, fit, differentiate, integrate
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Purpose

Syntax

Description

Prediction intervals for cfit or sfit object

ci = predint(fitresult,x)

ci predint (fitresult,x,level)

ci predint (fitresult,x,level,intopt,simopt)
[ci,y] = predint(...)

ci = predint(fitresult,x) returns upper and lower 95% prediction
bounds for response values associated with the cfit object fitresult
at the new predictor values specified by the vector x. fitresult must
be an output from the fit function to contain the necessary information
for ci. ci is an n-by-2 array where n = length(x). The left column

of ci contains the lower bound for each coefficient; the right column
contains the upper bound.

ci = predint(fitresult,x,level) returns prediction bounds with
a confidence level specified by level. level must be between 0 and 1.
The default value of level is 0.95.

ci = predint(fitresult,x,level,intopt,simopt) specifies the type
of bounds to compute.

intopt is one of

e 'observation' — Bounds for a new observation (default)

e 'functional' — Bounds for the fitted curve
simopt is one of

e 'off' — Non-simultaneous bounds (default)

® 'on' — Simultaneous bounds

Observation bounds are wider than functional bounds because they
measure the uncertainty of predicting the fitted curve plus the random

variation in the new observation. Non-simultaneous bounds are for
individual elements of x; simultaneous bounds are for all elements of x.
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[ci,y] = predint(...) returns the response values y predicted by
fitresult at the predictors in x.

Example Generate data with an exponential trend:
x = (0:0.2:5)';
y = 2*exp(-0.2*x) + 0.5*randn(size(x));

Fit the data using a single-term exponential:
fitresult = fit(x,y, 'expl1');
Compute prediction intervals:

p11 = predint(fitresult,x,0.95, 'observation', 'off');

(
p12 = predint(fitresult,x,0.95, 'observation','on');
p21 = predint(fitresult,x,0.95, 'functional', 'off');
p22 = predint(fitresult,x,0.95, 'functional', 'on');

Plot the data, fit, and prediction intervals:

subplot(2,2,1)

plot(fitresult,x,y),hold on,plot(x,p11, 'm--"),x1lim([0 51])
title('Nonsimultaneous observation bounds', 'Color','m')
subplot(2,2,2)

plot(fitresult,x,y),hold on,plot(x,p12, 'm--"),xlim([0 51])
title('Simultaneous observation bounds', 'Color','m')
subplot(2,2,3)

plot(fitresult,x,y),hold on,plot(x,p21, 'm--"),xlim([0 51])
title('Nonsimultaneous functional bounds', 'Color','m')
subplot(2,2,4)

plot(fitresult,x,y),hold on,plot(x,p22, 'm--"'),xlim([0 51])
title('Simultaneous functional bounds','Color','m')
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Monsimultaneous observation bounds

Simultaneous observation bounds

*

data

fited curve

— .

data
fitted curve |

¥ X
Monsimultaneous functional bounds Simultaneous functional bounds
25 25
\ . +  data . + data
2 N fitted curve |4 21 fitted curve [{

See Also confint, fit, plot
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Purpose Problem-dependent parameter names of cfit, sfit, or fittype object
Syntax pnames = probnames(fun)
Description pnames = probnames(fun) returns the names of the problem-dependent

(fixed) parameters of the cfit, sfit, or fittype object fun as a cell
array of strings.

Example f = fittype('(x-a)"n + b','problem',{'a','b'});
coeffnames(f)
ans =
N
probnames (f)
ans =
g
Y

load census

¢ = fit(cdate,pop,f, 'problem',{cdate(1),pop(1)},...
‘StartPoint',2);

coeffvalues(c)
ans =

0.9877
probvalues(c)
ans =

1.0e+003 *
1.7900 0.0039

See Also fittype, coeffnames, probvalues
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Purpose Problem-dependent parameter values of cfit or sfit object
Syntax pvals = probvalues(fun)

Description pvals = probvalues(fun) returns the values of the problem-dependent
(fixed) parameters of the cfit object fun as a row vector.

Example f = fittype('(x-a)"n + b','problem',{'a','b'});
coeffnames(f)
ans =
N
probnames (f)
ans =
g
Y

load census

c = fit(cdate,pop,f, 'problem', {cdate(1),pop(1)},...
‘StartPoint',2);

coeffvalues(c)
ans =

0.9877
probvalues(c)
ans =

1.0e+003 *
1.7900 0.0039

See Also fit, fittype, probnames
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Purpose

Syntax

Description

See Also

Numerically integrate sfit object

Q = quad2d(FO, a, b, c, d)
[Q,ERRBND] = quad2d(...)
[Q,ERRBND] = QUAD2D(FO,a,b,c,d,PARAM1,VAL1,PARAM2,VAL2,...)

Q = quad2d(FO, a, b, c, d) approximates the integral of the surface

fit object FO over the planar region @ <X < b and clx) <y < d(x) . The

bounds ¢ and d can each be a scalar, a function handle, or a curve fit
(cfit) object.

[Q,ERRBND] = quad2d(...) also returns an approximate upper bound
on the absolute error, ERRBND.

[Q,ERRBND] = QUAD2D(FO,a,b,c,d,PARAM1,VAL1,PARANM2,VAL2, . ..)
performs the integration with specified values of optional parameters.

See the MATLAB function quad2d for details of the upper bound and
the optional parameters.

quad2d, fit, sfit, cfit
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Purpose

Syntax

Description

Example

Assign values in fit options structure

set(options)

s = set(options)
set(options,fldi,vall,fld2,val2,...)
set(options,flds,vals)

set(options) displays all field names of the fit options structure
options. If a field has a finite list of possible string values, these values
are also displayed.

s = set(options) returns a structure s with the same field names as
options. If a field has a finite list of possible string values, the value of
the field in s is a cell array containing the possible string values. If a
field does not have a finite list of possible string values, the value of the
field in s is an empty cell array.

set(options,fldi,vall,fld2,val2,...) sets the fields specified by
the strings f1d7, f1d2, ... to the values val1i, val2, ..., respectively.

set(options,flds,vals) sets the fields specified by the cell array of
strings f1ds to the corresponding values in the cell array vals.

Create a custom nonlinear model, and create a default fit options
structure for the model:

f = fittype('a*x"2+b*exp(n*c*x)', 'problem','n');
options = fitoptions(f);

Set the Robust and Normalize fields of the fit options structure using
field name/value pairs:

set(options, 'Robust', 'LAR', 'Normalize', 'On')

Set the Display, Lower, and Algorithm fields of the fit options structure
using cell arrays of field names/values:

set(opts,{'Disp', 'Low','Alg'},...
{'Final',[0 O 0], 'Levenberg'})

7-77



set

See Also fitoptions, get
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Purpose Set model fit options
Syntax FT = setoptions(FT, options)
Description FT = setoptions(FT, options) sets the fit options of FT to options,

where FT is a fittype, cfit, or sfit object. The FT output argument
must match the FT input argument.

See Also fitoptions, fit, fittype
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Purpose
Syntax

Description

Constructor for sfit object
surfacefit = sfit(fittype,coeffi,coeff2,...)

An sfit object encapsulates the result of fitting a surface to data. They
are normally constructed by calling the fit function, or interactively by
exporting a fit from the Surface Fitting Tool to the workspace. You can
get and set coefficient properties of the sfit object.

You can treat an sfit object as a function to make predictions or
evaluate the surface at values of X and Y.

Like the cfit class, sfit inherits all fittype methods.

surfacefit = sfit(fittype,coeffi,coeff2,...) constructs the
sfit object surfacefit using the model type specified by the fittype
object and the coefficient values coeff1, coeff2, etc.

Note sfit is called by the fit function when fitting fittype objects to
data. To create a sfit object that is the result of a regression, use fit.

You should only call sfit directly if you want to assign values to
coefficients and problem parameters of a fittype object without
performing a fit.

Methods of sfit objects:

argnames Input argument names of cfit,
sfit, or fittype object

category Category of fit of cfit, sfit, or
fittype object

coeffnames Coefficient names of cfit, sfit,
or fittype object
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coeffvalues

confint

dependnames

differentiate

feval

formula

indepnames

islinear

numargs

numcoeffs

plot
predint

probnames

probvalues

quad2d

setoptions

Coefficient values of cfit or sfit,
object

Confidence intervals for fit
coefficients of cfit or sfit object

Dependent variable of cfit, sfit,
or fittype object

Differentiate cfit or sfit object

Evaluate cfit, sfit, or fittype
object

Formula of cfit, sfit, or
fittype object

Independent variable of cfit,
sfit, or fittype object

Determine if cfit, sfit, or
fittype object is linear

Number of input arguments of
cfit, sfit, or fittype object

Number of coefficients of cfit,
sfit, or fittype object

Plot cfit or sfit object

Prediction intervals for cfit or
sfit object

Problem-dependent parameter
names of cfit, sfit, or fittype
object

Problem-dependent parameter
values of cfit or sfit object

Numerically integrate sfit object

Set model fit options
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sfit Constructor for sfit object
type Name of cfit, sfit, or fittype
object
Example You can treat an sfit object as a function to make predictions or

evaluate the surface at values of X and Y, e.g.,

X =3 -6 * rand( 49, 1 );
y =3 -6 * rand( 49, 1 );

z = peaks( x, y );

sf = fit( [x, yl, z, 'poly32' );
zhat = sf( mean( x ), mean( y ) )

See Also fit, fittype, feval, cfit
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Purpose

Syntax

Description

Open Surface Fitting Tool

sftool
sftool(x,y,z)
sftool(x,y,z,w)
sftool(filename)

sftool opens Surface Fitting Tool or brings focus to the Tool if it is
already open. Surface Fitting Tool is an interactive environment for
fitting surfaces to data.

sftool(x,y,z) creates a fit to x and y inputs (or predictor data) and
z output (or response data). x, y, and z must be double vectors of the
same length, with two or more elements. sftool opens Surface Fitting
Tool if necessary.

sftool(x,y,z,w) creates a fit with weights w. w must be a vector of the
same length as x, y, and z.

sftool(filename) loads the surface fitting session in filename into
Surface Fitting Tool. The filename should have the extension .sfit.

Infs, NaNs, and imaginary parts of complex numbers are ignored in
the data.

Surface Fitting Tool provides a flexible and intuitive graphical user
interface where you can interactively fit surfaces to data and view
plots. You can:

¢ Create, plot, and compare multiple surface fits

e Use linear or nonlinear regression, interpolation, local smoothing
regression, or custom equations

® View goodness-of-fit statistics, display confidence intervals and
residuals, remove outliers and assess fits with validation data

® Automatically generate M-code for fitting and plotting surfaces, or
export fits to workspace for further analysis

For instructions, see Chapter 3, “Interactive Surface Fitting”.
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Purpose

Syntax

Description

Smooth response data

yy =
yy =
yy =
yy =
yy =
yy =
yy =

yy =
movin

smooth(y)

smooth(y,span)
smooth(y,method)
smooth(y,span,method)
smooth(y, 'sgolay’',degree)
smooth(y,span, 'sgolay',degree)
smooth(X,y,...)

smooth(y) smooths the data in the column vector y using a
g average filter. Results are returned in the column vector yy.

The default span for the moving average is 5.

The first few elements of yy are given by

yy(1) = y(1)

yy(2) = (y(1) + y(2) +y(3))/3

yy(3) = (y(1) +y(2) + y(3) +y(4) +y(5))/5
4) = (y(2) + y(3) +y(4) +y(5) +y(6))/5

Becau
result

yy =

se of the way endpoints are handled, the result differs from the
returned by the filter function.

smooth(y,span) sets the span of the moving average to span.

span must be odd.

yy =

smooth(y,method) smooths the data in y using the method

method and the default span. Supported values for method are listed

in the table below.
method Description
'moving' Moving average (default). A lowpass filter with

filter coefficients equal to the reciprocal of the
span.
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method Description

'lowess' Local regression using weighted linear least
squares and a 1st degree polynomial model

'loess' Local regression using weighted linear least
squares and a 2nd degree polynomial model

‘sgolay’ Savitzky-Golay filter. A generalized moving
average with filter coefficients determined by an
unweighted linear least-squares regression and a
polynomial model of specified degree (default is
2). The method can accept nonuniform predictor
data.

A robust version of 'lowess' that assigns lower
weight to outliers in the regression. The method
assigns zero weight to data outside six mean
absolute deviations.

'rlowess

'rloess' A robust version of 'loess' that assigns lower
weight to outliers in the regression. The method
assigns zero weight to data outside six mean
absolute deviations.

yy = smooth(y,span,method) sets the span of method to span. For
the loess and lowess methods, span is a percentage of the total
number of data points, less than or equal to 1. For the moving average
and Savitzky-Golay methods, span must be odd (an even span is
automatically reduced by 1).

yy = smooth(y, 'sgolay',degree) uses the Savitzky-Golay method
with polynomial degree specified by degree.

yy = smooth(y,span, 'sgolay',degree) uses the number of data
points specified by span in the Savitzky-Golay calculation. span must
be odd and degree must be less than span.

yy = smooth(x,y,...) additionally specifies x data. If x is not
provided, methods that require x data assume x = 1:1length(y).
You should specify x data when it is not uniformly spaced or sorted.

7-85



smooth

7-86

Remarks

Example

If x is not uniform and you do not specify method, lowess is used.
If the smoothing method requires x to be sorted, the sorting occurs
automatically.

Another way to generate smoothed data is to fit it with a smoothing
spline. Refer to the fit function for more information.

Load the data in count.dat:

load count.dat

The 24-by-3 array count contains traffic counts at three intersections
for each hour of the day.

First, use a moving average filter with a 5-hour span to smooth all of
the data at once (by linear index) :

c = smOOth(COUﬂt(:));
C1 = reshape(c,24,3);

Plot the original data and the smoothed data:

subplot(3,1,1)
plot(count,':");

hold on

plot(C1,'-");

title('Smooth C1 (All Data)')

Second, use the same filter to smooth each column of the data
separately:

C2 = zeros(24,3);
for I = 1:3,

C2(:,I) = smooth(count(:,I));
end

Again, plot the original data and the smoothed data:

subplot(3,1,2)



smooth

plot(count,':");

hold on

plot(C2,"-");

title('Smooth C2 (Each Column)')

Plot the difference between the two smoothed data sets:
subplot(3,1,3)

plot(C2 - C1,'0-")
title('Difference C2 - C1')

Smogth 1 (Al Data)

400 . T T .
200+ B .
_,_..-'-f"'—n“'\-.\_ E _\‘ e
O -.-" s | e
0 5 10 15 20 25
Smooth C2 {(Each Columny)
400 . T T .
2001 .
O = = = e = S —
0 5 10 15 20 25
Difference 2 - C1
10 . r : .
0 —@yﬁ“ﬁ %ﬁzfg_
10 1 1 1 1
0 5 10 15 20 25

Note the additional end effects from the 3-column smooth.

Example Create noisy data with outliers:

X 15*rand(150,1);
y sin(x) + 0.5*(rand(size(x))-0.5);
y(ceil(length(x)*rand(2,1))) = 3;
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Smooth the data using the loess and rloess methods with a span

of 10%:
yy1l = smooth(x,y,0.1,'loess');
yy2 = 0.1,'rloess');

y
smooth(x,y,
d

Plot original data and the smoothed data.

[xx,ind] = sort(x);

subplot(2,1,1)

plot(xx,y(ind), 'b."',xx,yy1(ind),"'r-")
set(gca, 'YLim',[-1.5 3.5])

legend('Original Data', 'Smoothed Data Using '‘'loess''',...

‘Location', 'NW")
subplot(2,1,2)
plot(xx,y(ind), 'b."',xx,yy2(ind), " 'r-")
set(gca, 'YLim',[-1.5 3.5])

legend('Original Data', 'Smoothed Data Using '‘'rloess''’',...

‘Location', 'NW")

+  Original Data *

3

2 = Smoothed Data Using 'loess' .
.1 - =

1]

3 +  Original Data *

2 Fl— Smoothed Data Using 'flogss' 7
1 ¥ :

0

Note that the outliers have less influence on the robust method.
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See Also fit, sort

7-89



type

Purpose Name of cfit, sfit, or fittype object

Syntax name = type(fun)

Description name = type(fun) returns the custom or library name name of the
cfit, sfit, or fittype object fun as a character array.

Example f = fittype('a*x"2+b*exp(n*x)');
category(f)
ans =
custom
type(f)
ans =
customnonlinear

g = fittype('fourierd');
category(g)

ans =

library

type(9)

ans =

fourier4

See Also fittype, category, cflibhelp
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